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Trademarks

® Adobe, Acrobat, and Reader are trademarks or registered trademarks of Adobe Inc. in the United States
and/or other countries.

® Arm® and CMSIS are registered trademarks of Arm Limited.

® CentOS, Red Hat® Enterprise Linux®, and Fedora® are trademarks or registered trademarks of Red
Hat, Inc. or its subsidiaries in the United States and other countries.

® Firefoxis aregistered trademark or trademark of the Mozilla Foundation in the United States and other
countries.

® The FIDO®, FIDO ALLIANCE, FIDO AUTHENTICATION, FIDO CERTIFIED and FIDO2 trademarks and

logos are trademarks of FIDO Alliance.

GitHub® is a registered trademark of GitHub, Inc.

Google Chrome™ and Gmail™ are trademarks of Google LLC.

Linux® is a registered trademark of Linus Torvalds in the United States and other countries.

Mac, macOS, Safari, and Xcode are trademarks of Apple Inc., registered in the United States and other

countries and regions.

Microsoft Edge, Visual Studio, and Windows are trademarks or registered trademarks of Microsoft
Corporation in the United States and/or other countries.

Opera is a trademark or registered trademark of Opera Software ASA.

RSA® is a registered trademark of RSA Security LLC.

SHALO is a trademark or registered trademark of Axell Corporation.

Ubuntu is a trademark or registered trademark of Canonical Ltd.

Information on software used with this product

Software owned by a third-party and licensed to Axell Corporation

Software (SHALO AUTH dedicated software) and data for the firmware updater that can be downloaded
from “auth.shalo.jp”, and the firmware of SHALO AUTH dongle include Open Source Software (0SS).
Open Source Software contained in this product and the respective Open Source Software licenses can

be confirmed by using the following:

Launch GUI Tool, click [Help] > [About] > [Acknowledgements].

Contact information

If you need support for this product or have any inquiries about it, please email us at shalo@axell.co.jp.
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Conventions used in this manual

Styles and formats

In addition to regular styles, this manual uses the following styles for special purposes:

Bold Indicates important information in running text and character strings provided by the user
at the terminal.
[talic Indicates information that varies depending on the user's environment.

mono Indicates command names and command options.

The format below indicates the name and content of a file. You can see a line number at the left end of
each line.
file.txt

1 This is a message.

The following format shows a single command line:

command -p environment-specific-string

The following format shows input and output in the terminal command prompt:

$ commandd
Message

Special characters used in the above prompt have the following meanings:

> Indicates the PowerShell prompt.
$ Indicates the Bash prompt. It is used in Cygwin, Git for Windows, Linux, and macOS 10.14

Mojave or earlier.

3¢

Indicates the Zsh prompt. It is used in macOS 10.15 Catalina or later.

Indicates pressing the Enter key.

Symbols used in this manual

Indicates reference or supplemental information.

A Indicates an important note.
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How this manual is organized and how to read it

This manual contains 12 chapters. The following is an overview of each chapter:

Chapter 1

Chapter 2
Chapter 3

Chapter 4

Chapter 5

Chapter 6
Chapter 7
Chapter 8
Chapter 9
Chapter 10

Chapter 11
Chapter 12

Provides a brief introduction to SHALO AUTH. It also covers the operating environment
and general specifications.

Explains information you need to be familiar with before using SHALO AUTH.

Explains how to get started with SHALO AUTH and install dedicated software in each of
the operating systems of Windows, macOS, and Linux.

Explains how to use the SHALO Keyring key tool, one of the SHALO AUTH dedicated
tools.

Explains how to use the SHALO Smith administration tool, one of the SHALO AUTH'
dedicated tools.

Explains how to use SHALO AUTH for passkey authentication in Web services.

Explains how to use SHALO AUTH to secure PDF files.

Explains how to authenticate users with SHALO AUTH through SSH authentication.
Explains how to use SHALO AUTH through SSH authentication in GitHub.

Provides convenient ways to make use of SHALO AUTH, such as how to enable a remote
PC to use SHALO AUTH connected to your local PC.

Contains frequently asked questions and solutions to them when SHALO AUTH is used.
Provides developers with various specifications of the PKCS #11 module for SHALO
AUTH.

You may not need to read all the chapters in this manual, depending on your purpose of using SHALO

AUTH. To help you effectively learn how to use SHALO AUTH, the following shows how you should read

this manual for different purposes.

Users who use SHALO AUTH for FIDO2 and passkeys

Read from Chapter 1 up to Section 2.2, and only if you use Linux, read Section 3.5.1. Then read

Chapter 6, which explains how to configure passkeys in Web services.

Users who use SHALO AUTH with PDF files

Read from Chapter 1 to Chapter 4, except for Section 2.2. Then, read Chapter 7.

Users who use SHALO AUTH for SSH authentication

Read from Chapter 1 to Chapter 4, except for Section 2.2. Then, read Chapter 8.

Users who use SHALO AUTH for SSH authentication in Git

Read from Chapter 1 to Chapter 4, except for Section 2.2. Then, read Chapters 8 and 9.
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Introduction to SHALO AUTH 9

Chapter 1

Introduction to SHALO AUTH

This chapter provides a brief introduction to SHALO AUTH.
Topics in this chapter

What is SHALO AUTH?
Applications
Operating environment

General specifications

ok w N

Usage notes
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Introduction to SHALO AUTH ‘ 10

1.1 What is SHALO AUTH?

SHALO AUTH (Figure 1) is a security key that can be connected via USB. It supports Windows,

macOS, and Linux, and is available with OS-standard device drivers.

Figure 1 Appearance of SHALO AUTH

SHALO AUTH has the following two main features:

® FIDO2 security key

® General security key

FIDO2 security key
SHALO AUTH supports FIDO2 (CTAP2.1, CTAP2.0, and

[
CTAP1/U2F) and has been certified by FIDO as an af1do

CERTIFIED

authenticator of Authenticator Certification Level 2 (L2)
for FIDO2 certification. SHALO AUTH can create and

store passkeys that can be used for authentication in major Web browsers, such as Google

Chrome, Safari, Microsoft Edge, and Firefox.

General security key

SHALO AUTH supports RSA and ECDSA public key cryptography as a general security key, and
is available for managing keys securely and managing certificates; encrypting and decrypting;

and issuing and verifying digital signatures.

RSA ECDSA

Curves: P-192/P-224/P-256/P-384/

Key length: 1,024 to 4,096 bits
P-521/secpl192kl/secp224kl/secp256kl

List 1: Supported public key cryptography
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Introduction to SHALO AUTH 11

The features of the general security key are available through the PKCS #11 API, the
Cryptographic Token Interface industrial standards. With the support of the PKCS #11 AP,

developers can use SHALO AUTH to build their own hardware authentication solutions.

An example includes PDF file security in Adobe® Acrobat® and Adobe® Acrobat® Reader®.
These software systems support the PKCS #11 API, enabling you to use PDF files in ways such

as:

® Encrypting PDF files and allowing users to browse them only with SHALO AUTH
® Signing PDF files electronically using SHALO AUTH

SHALO AUTH can also be applied for user authentication via SSH or for Git access, which
many developers are familiar with. SSH is used to communicate securely with remote PCs and
with virtual machines on cloud environments. By using SHALO AUTH for user authentication
via SSH, you will have secure access without storing keys locally. As SSH is used as a secure
communication infrastructure in the Git version control system and other systems, you can
also take advantage of SHALO AUTH in these systems.
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1.2 Applications

SHALO AUTH can be used mainly for:

Passkey authentication for Google, GitHub, and other Web services
Viewing encrypted PDF files
SSH authentication in Git platforms, such as GitHub

User authentication or a digital signature using PKCS #11-compliant software

Passkey authentication in Web services

When using SHALO AUTH for passkey authentication, the user can be authenticated by simply
pressing the button on SHALO AUTH after entering the FIDO2 PIN set in SHALO AUTH. The
user also does not need to enter your user ID and password either.

Online authentication Passkey

@ request @ authentication @

.
Enter FIDO2 PIN Press the button

Figure 2 Passkey authentication procedure

Viewing encrypted PDF files

With the security features of Adobe® Acrobat®, you can create a PDF file that can be viewed
only in an environment with a particular SHALO AUTH device. This PDF file is encrypted for
SHALO AUTH, which is responsible for decrypting the file when the user tries to view it in
Adobe® Acrobat® or Adobe® Acrobat® Reader®.

Decryption request

Enter user PIN

Figure 3 Procedure for viewing an encrypted PDF file
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SSH authentication

When using SHALO AUTH for SSH authentication, the user is authenticated by entering a user
PIN set in the SHALO AUTH, not the remote PC password.

This user PIN is intended to cause SHALO AUTH to generate a digital signature for

authentication. The digital signature will be generated only when the user who has SHALO

AUTH enters the correct user PIN.
e A

Figure 4 Procedure for PKCS #11 authentication via SSH

SSH authentication

foo

. J
Enter user ID and user PIN

User authentication or digital signature using PKCS #11-compliant software

When using PKCS #11-compliant software, the user is authenticated or signs something
digitally through SHALO AUTH by entering a SHALO AUTH user PIN in the software.

The operation will be processed only when a user who has SHALO AUTH enters the correct

user PIN.
e A

Figure 5 Procedure for user authentication or digital signature

Device authentication

®

. J
Enter user PIN
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1.3 Operating environment

Axell has checked that SHALO AUTH and SHALO AUTH dedicated software work on PCs with

a USB port that run one of the operating systems listed in the following table.

Operating system Version

Windows Windows 10 for x86-based processors
Windows 10 for x64-based processors
Windows 11 for x64-based processors
Windows 11 for Arm-based processors
macO0S macOS High Sierra (10.13) or later

Intended for Intel processors and Apple Silicon processors

Linux Red Hat Enterprise Linux 7 or later
CentOS 7 or later
Ubuntu 18.04 LTS or later

Fedora 33 or later

* All of the above are intended for x64-based processors only.

SHALO AUTH can be used as a FIDO2 or FIDO U2F security key in Web browsers listed in the

following table.

Web browser Version

Google Chrome Version 41 or later
Firefox Version 67 or later
Microsoft Edge Version 79 or later (only for Chromium-based versions)
Safari Version 13 or later

AH52126-UMO1E_04 SHALO AUTH User's Manual



1.4 General specifications

Hardware specifications

Introduction to SHALO AUTH ‘ 15

Item Description
Interface USB 2.0
Compatible connector USB Type-A

Power supply

USB bus powered +5V £5%

Dimensions

68.6 x 16 x 8 mm (including the cover)

Guaranteed operating
environment

Temperature: -20 to 70°C, Humidity: 20 to 80% (non-

condensing)

Weight

g

Certification

VCCI (Class B) , FIDO2 Level 2 Authenticator (Certificate No.
FID020020250213001), FIDO U2F Level 2 Authenticator
(Certificate No. U2F100020250213001)

FIDO CTAP1/U2F features

Feature
Compliant with

Description
CTAP1/U2F v1.2

Authentication algorithm

ECDSA P-256 with SHA-256

Upper limit of FIDO
authentication keys to be
generated

1,000,000 keys

Whether the user is present is
verified by

Pressing the button on the device

FIDO2 features

Feature

Description

Compliant with

CTAP2.1, CTAP2.1 Preview features, CTAP2.0

Authentication algorithm

ECDSA P-256 with SHA-256

Credentials

Up to 25 EC P-256 discoverable credentials stored in hardware
Up to 1,000,000 EC P-256 non-discoverable credentials that

are wrapped with hardware key and stored at replying parties

PIN/UV auth protocol

Version 1 and 2 are supported

Client PIN

UTF-8 string of 4 to 63 bytes in length
With a protection feature that will lock the PIN in the event of 8

consecutive authentication failures

Other supported features

Credential Management
Credential Management Preview
Credential Protection

HMAC Secret Extension

Whether the user is present is
verified by

Pressing the button on the device
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PKCS #11 features

Feature Description

Compliant with PKCS #11 v2.40

SO PIN (Security Officer PIN) UTF-8 string of 4 to 256 bytes in length
With a protection feature that will lock the PIN in the event of 5
consecutive authentication failures

User PIN UTF-8 string of 4 to 256 bytes in length
With a protection feature that will lock the PIN in the event of 5
consecutive authentication failures

Cryptographic processing RSA: Encryption, decryption, signature, verification; ECDSA:
Signature, verification, random number generation, message
digest generation

Data management Maximum of 12 data sets of approximately 8 Kbytes can be
stored per device.
RSA private key, RSA public key, ECDSA private key, ECDSA
public key, and X.509 certificate-based data are supported.

Read-protected private keys are supported.

Message digest SHA-1, SHA-256, SHA-384, and SHA-512
Random number generator NIST SP 800-90A-compliant CTR-DRBG (AES-256 based)
RSA RSA cryptography based on PKCS #1
Key lengths of 1,024 to 4,096 bits are supported.
ECDSA The following FIPS 186-4-compliant elliptic curve signatures:

secpl92kl, secpl192rl (P-192), secp224kl, secp224rl (P-224),
secp256kl, secp256rl (P-256), secp384rl (P-384), and
secpb21rl (P-521)
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1.5 Usage notes

If your PC does not recognize SHALO AUTH, disconnect SHALO AUTH from the PC once and

then reconnect the device to it.
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Chapter 2

Preparing SHALO AUTH for use

This chapter contains topics you should read before using SHALO AUTH.
Topics in this chapter

1. Appearance and features of SHALO AUTH

2. Understanding FIDO2 and passkeys

3.  Understanding PKCS #11

4. Introduction to SHALO AUTH dedicated software
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2.1 Appearance and features of SHALO AUTH

SHALO AUTH has one LED on the front and one button on the side. A cover protects its USB
plug. To use SHALO AUTH, uncover it and connect it to a USB port.

White LED

Button

Cover

Figure 6 Appearance of SHALO AUTH

White LED

The white LED is usually off. It turns on to let the user know its state. The following table lists

and describes the lighting patterns of the white LED and their meanings.

Timing Lighting pattern Description
After connectiontoa | On The device is doing a self-test.
PC 1 to 3 flashes per second An error was detected during the self-test.
on Data is being written to the device.

Do not disconnect it from the PC.

If SHALO Keyring or SHALO Smith is running,
Working with indicates that they are selected or working on
software the device.

5 flashes per second ) ) o
Otherwise, SHALO AUTH is waiting for user

approval during the FIDO2 operations. Press

the button for approval.

Pressing and holding The device is now ready to be restored to the

button for about 30 10 flashes per second factory settings without the SO PIN.

seconds The device keeps flashing for 10 seconds.
Button

The button is used mainly when the user approves a SHALO AUTH operation. This is explained

in the next section.
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2.2 Understanding FIDO2 and passkeys

2.2.1 What are FIDO2 and Passkeys?

FIDO2 is a mechanism that makes it easy for users to authenticate themselves to online
services. A passkey is a FIDO2's cryptographic authentication credential, that allows a user to
sign in to apps and websites. Passkeys are tied to a user account on a website or application,
which can be stored in SHALO AUTH, FIDO2 security keys and other FIDO2 devices (such as
PCs or smartphones). With passkeys, users no longer need to enter usernames and passwords
or additional factors. Instead, a user approves a sign-in with entering their device PIN
(personal identification numbers). In SHALO AUTH, the PIN for FIDO2 is referred to as a
FIDO2 PIN.

A user grants FIDO2 security key for the creation of the passkey and the authentication with
the passkey by the physical action of the user. In case of SHALO AUTH, it flashes it's LED light
to ask user’s permission, the user grants SHALO AUTH by pressing it's button.

Do not press the button if you will not allow the use of SHALO AUTH. If the LED
flashes without any user interaction, malicious software may be attempting to
secretly make use of SHALO AUTH.

2.2.2 Procedure for using passkeys
If you want to use passkeys for identity verification in FIDO2-compliant Web services, you need
to have a Web browser that supports FIDO2 and a PC with a USB port.
Passkeys are used in the following three scenes:

1. Registering a passkey
2. Verifying identity with passkeys

3. Deregistering a passkey

Deregistering a passkey associated with a Web service user account prevents the
new owner of the security key from impersonating you after you dispose of or

transfer the security key.

This section explains these scenes in turn.
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How to register a passkey

Tie the passkey in a Web service's user settings. This registration process is quick and easy to

do through a Web browser. Specifically, take the following four steps:

Step 1 Enter the FIDO2 PIN set in SHALO AUTH to unlock SHALO AUTH.

Step 2 SHALO AUTH flashes it's LED to ask for permission to create a passkey.

Step 3 When you press the button on SHALO AUTH to authorize, SHALO AUTH then
generates a passkey specific to this Web service user account and stores it
internally.

Step 4 Register the Credential ID of the newly created passkey and other information

with the Web service.

Passkey creation request (BB
® UserlID

Xl
— w ® User information

Web service A

LED flashes.

SHALO AUTH creates a passkey and

stores it internally.

Press the button.
@ Credential ID and User ID

[ ]
Public key = ® User information
— wm ® Security key name
® Credential ID
I N
® Public key

Web service A

Figure 7 Registering a passkey
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How to verify identity with passkeys

Take the following four steps:

Step 1 Enter the FIDO2 PIN set in SHALO AUTH to unlock SHALO AUTH.

Step 2 SHALO AUTH flashes it's LED to ask for permission to authenticate using
passkeys.

Step 3 When you press the button on SHALO AUTH to authorize, SHALO AUTH
generates a digital signature with the passkey specific to this Web service user
account.

Step 4 The digital signature is sent to the Web service. The Web service verifies the

identity by validating the digital signature with the public key you registered.

Passkey authentication
request

|

Web service A

LED flashes

Generate a digital signature

with passkey

User ID

User information
Security key name
Credential ID
Public key

Validate the digital
signature with the public

Press the button.
@ /\ key to verify the identity
Digital signature

signed with passkey [eoe ]
X

) o

Web service A

Figure 8 Identity verification with passkeys
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How to deregister a passkey
You can delete a passkey tied to a Web service user account in the Web service's user settings.

This operation deletes the passkey in SHALO AUTH and removes the corresponding
information that is maintained by the Web service user account. Different Web service user
accounts create different passkeys, and therefore deregistering a passkey from one Web

service user account does not affect the others.

SHALO AUTH can disable all passkeys and the FIDO authentication keys that have been
generated so far, in case it is disposed of or transferred. As such, it is possible to remove the
information used for FIDO2 from SHALO AUTH and have the device recognized as a new one.
This can prevent the next SHALO AUTH owner from spoofing the previous owner even if the

previous owner neglected to deregister through the Web service.

PIN authentication

As described in the previous section, you must enter the FIDO2 PIN to unlock SHALO AUTH
when using passkeys. This is similar to unlocking a smartphone with PIN or fingerprint. See
Chapter 6 to set and change the FIDO2 PIN.

The FIDO2 PIN allows a Unicode string of at least 4 characters. The maximum number of

characters is 63 bytes in UTF-8 encoding.
Locking PIN

The FIDO2 PIN is locked after 8 consecutive failures. If the FIDO2 PIN is locked, SHALO AUTH
must be reset using one of the following methods. Either method will result in the loss of all

passkeys and FIDO authentication keys.

® Restoring SHALO AUTH to the factory settings (Section 5.3)
® Resetting FIDO2 security key (Sections 6.1.3 and 6.2.3)

To prevent accidents, if PIN authentication fails three times, PIN authentication
will not be performed unless SHALO AUTH is re-inserted.
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2.3 Understanding PKCS #11

2.3.1 What is PKCS #117?

PKCS #11 is the API to manipulate cryptographic tokens in software, and is widely used by

applications that provide digital signatures or user authentication with those tokens.

Application

Cryptographic token

HSM

PKCS #11 module

H Smart card

</> =

Figure 9 Where PKCS #11 is used

A cryptographic token refers to a cryptographic device, such as hardware security modules

(HSMs) and smart cards. An HSM is a device that stores cryptographic keys securely and uses

them to provide cryptographic processing functionality. A smart card refers to an IC card with

a built-in IC chip, and its role is the same as that of an HSM. Common examples you may be

familiar with are the following cards with personal identification numbers (PINs):

® Credit card

® ATM card
® |D card
PKCS #11 features

PKCS #11 provides three main features with the cryptographic token. They are shown in the

following table.
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Feature Description

PIN The following users can be distinguished from each other through authentication
authentication | with a personal identification number (PIN):

® Security Officer (SO)

® General user (User)

® Public user (Public)

A certain number of incorrect PIN entries can lock the PIN, thus protecting the

cryptographic token.

Data Cryptographic keys and certificates can be securely stored and managed in the
management cryptographic token.

This data is used for cryptographic processing.

The feature can restrict the use of each data set to its owner and permanently

prohibit it from being loaded from the cryptographic token.

Cryptographic | Stored keys can be used to encrypt or decrypt data and create and verify digital
processing signatures.

Message digests and high-security random numbers can be generated.

2.3.2 PIN authentication

In PKCS #11, entering PINs enables you to authenticate the following two types of roles:

Security Officer Isresponsible forissuing cryptographic tokens and managing the PINs.
User Performs cryptographic processing by using secret information in the

cryptographic token.

The User owns the cryptographic token. PIN authentication is not required for using public
information in the cryptographic token. In SHALO AUTH, the PIN for the Security Officer is
referred to as a SO PIN and that of the User is as a user PIN. Both PINs can accept 4 to 256

alphanumeric characters and symbols.

When someone purchases SHALO AUTH as an individual, the purchaser has the
roles of both the Security Officer and User. Both roles can have the same pin.
Relationships between features and the PINs

The following table summarizes the relationships between a feature and which PIN is required

to operate it:
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Feature Required PIN

Management | Initially configuring the cryptographic token SO PIN (not required initially)
Changing the SO PIN SO PIN
Configuring and unlocking the user PIN SO PIN

Normal use Changing the user PIN User PIN
Creating, reading, or removing data protected by User PIN

the cryptographic token

Providing cryptographic processing with the key for User PIN
data protected by the cryptographic token

Creating, reading, or removing public data by the Not required
cryptographic token

Providing cryptographic processing with the public Not required
data key of the cryptographic token

Providing cryptographic processing that does not Not required

use data of the cryptographic token

Locking the PINs

During PIN authentication, five consecutive failures locks the PIN. PIN authentication is then
prohibited until the PIN is unlocked. The following table shows how to unlock a PIN.

Type of PIN How to unlock

User PIN Reset the user PIN as the Security Officer.

SO PIN Restore the cryptographic token to the factory settings.
All the information and FIDO authentication keys are removed.

FIDO authentication keys are not removed even if you initially configure SHALO
AUTH for PKCS #11. Restoring the device to the factory settings will remove
all the FIDO authentication keys.

Data management

Data capacity

SHALO AUTH can store up to 12 sets of the following three types of data defined by PKCS
#11:

® Private key for public key cryptography (RSA or ECDSA)
® Public key for public key cryptography (RSA or ECDSA)
® X.509 certificate

The SHALO AUTH dedicated software stores these three types of keys as a set when storing
a key in SHALO AUTH. This software enables you to store four sets of keys.
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As an X.509 certificate contains public key information, SHALO AUTH will be able
0 to handle up to six sets of key pairs if you use only one of either X.509 certificates

or public keys.

In this case, use a different PKCS #11 application for data management.

Data set identification

In PKCS #11, information called an CKA_ID attribute is added to data to distinguish the
relations among multiple data sets. Data items with the same CKA_ID attribute are considered

to belong to the same set.

CKA_ID attribute. An X.509 certificate that is issued for the public key also has the
same CKA_ID attribute.

0 Both a private key and a public key that form a certain key pair have the same

Data protection
In SHALO AUTH, you can protect data by:

Prohibiting any change to it
Prohibiting any removal of it

Requiring user PIN authentication prior to use of or access to the data

Prohibiting export of the data (for the private key only)

When data is saved with the SHALO AUTH dedicated software, it is managed as shown in the
table below. If you want to manage data under conditions that are not in the table, use a
different PKCS #11 application.

Data type Removal User PIN authentication Export
protection

Private key for public key Possible = Possible Required Not possible

cryptography

Public key for public key Possible | Possible Not required Possible

cryptography

X.509 certificate Possible = Possible Not required Possible
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Introduction to SHALO AUTH dedicated software

SHALO AUTH offers the following two software programs for the general security key:

SHALO Keyring  Software program, used to store key data in SHALO AUTH
SHALO Smith Software program, used to manage SHALO AUTH

SHALO Smith is also used to disable all the FIDO authentication keys when you
dispose of or transfer SHALO AUTH.

SHALO Keyring

SHALO Keyring is a software program for storing cryptographic keys handled by the general
security key functionality in SHALO AUTH.

s ECDSA sample key

AUTH ECDSA / 256bit / P-256 Until 2025-09-28
B roosToken v RSA sample key
RSA / 4096bit Until 2025-08-01

@ Random
generator

[ﬁ Change the PIN
ot set yet @ Setup the key

Q Delete
everything

Foo Bar

RSA / 4096bit Until 2031-02-20
@ Help
Figure 10 SHALO Keyring window

SHALO Keyring provides the features listed below. The PKCS #11 SO PIN is not required for

these purposes.

Setting up SHALO AUTH
Adding or removing cryptographic keys
Changing the user PIN

Generating passwords or random number sequences

Chapter 4 explains how to use SHALO Keyring.
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SHALO Smith

SHALO Smith is a software program for managing SHALO AUTH.

= X

(@ The corresponding device can be identified by its blinking LED

Device
administration

tool E Foo's Token (\_/:' Already setup

Figure 11 SHALO Smith window

SHALO Smith provides the features listed below. You need a SO PIN to operate them.

® Setting up SHALO AUTH

® Changing the SO PIN

® Resetting and unlocking the user PIN
°

Restoring the device to the factory settings removing all FIDO authentication keys

Chapter 5 explains how to use SHALO Smith.
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Chapter 3

Installation

This chapter explains how to install and uninstall the SHALO AUTH dedicated software.
The software runs on the following OSs:

® \Windows
® macOS
® Linux

Topics in this chapter

Installation in Windows
Uninstallation in Windows

Installation in macOS

1

2

3

4. Uninstallation in macOS
5. Installation in Linux

6

Uninstallation in Linux
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3.1 Installing software in Windows

SHALO AUTH works with standard drivers that come with Windows. Connecting SHALO AUTH
to a USB port of your PC for the first time will start the setup process automatically. When the
setup process finishes, you will see a notification on your desktop as shown in the following

figure.

1¥ Settings

Device is ready
'SHALO AUTH' is set up and ready to go.

= 219 PM
AT G D) o B
Figure 12 Setup completion notification from SHALO AUTH

If you use SHALO AUTH as a FIDO2 security key only, you do not have to read the rest of this

section.

3.1.1 Installing SHALO Keyring

SHALO Keyring for Windows can be downloaded from https://auth.shalo.jp.

To install it, run the shalo_keyring x.y.z windows.exe file you downloaded (where x.y.z

indicates the version number). The installation process contains three steps.

First, select an installation option in the first screen. If you do not have administrator privileges,

select [Only for me].

& SHALO Keyring Setup - *
Choose Installation Options

Who should this application be installed for? 5

Please select whether you wish to make this software available to all users or just yourself

() Anyone who uses this computer (all users)

(®) Cnly for me (username)

Fresh install for current user only,

SHALD Keyring 1.0.0

Figure 13 SHALO Keyring installation options
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Next, specify where to install the program. If the correct location is specified, click [Install].

5 SHALQ Keyring Setup — *
Choose Install Location

Choose the folder in which to install SHALO Keyring. 5

Setup will install SHALO Keyring in the following folder. To install in a different folder, dick
Browse and select another folder. Click Install to start the installation.

Destination Folder

C:¥Users¥username¥ AppData¥l ocal¥Programs¥SHALO Keyring Browse...

SHALD Kewyring 1.0.0

< Back Install Cancel

Figure 14 Specifying where to install SHALO Keyring

When the installation process is complete, you will see the screen below. Click [Finish] to exit.

& SHALQ Keyring Setup —

Completing SHALO Keyring Setup

SHALO Keyring has been installed on your computer,

Click Finish to close Setup.

RUR SHALO Keyring

< Back Cancel

Figure 15 SHALO Keyring installation is complete

You can start SHALO Keyring with a shortcut created on your desktop or in the Start menu.
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3.1.2 Installing SHALO Smith

SHALO Smith for Windows can be downloaded from https://auth.shalo.jp.

To install it, run the shalo_smith_x.y.z windows.exe file you downloaded (where x.y.z indicates

the version number). The installation process contains three steps.

First, select an installation option in the first screen. If you do not have administrator privileges,

select [Only for me].

SHALO Smith Setup — x
Choose Installation Options
Who should this application be installed for?

Please select whether you wish to make this software available to all users or just yourself

() Anyone who uses this computer (all users)

(®) Only for me (username)

Fresh install for current user only,

Figure 16 SHALO Smith installation options

Next, specify where to install the program. If the correct location is specified, click [Install].

SHALQO Smith Setup - %

Choose Install Location

Choose the folder in which to install SHALO Smith.

Setup will install SHALO Smith in the following folder. To install in a different folder, dick
Browse and select another folder. Click Install to start the installation.

Destination Folder

¥Uszers¥username¥ AppData¥l ocal¥Programs¥SHALO Smith Browse...

< Back Install Cancel

Figure 17 Specifying where to install SHALO Smith
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When the installation process is complete, you will see the screen below. Click [Finish] to exit.

B SHALO Smith Setup -

Completing SHALO Smith Setup

SHALO Smith has been installed on your computer,

Click Finish to dose Setup.

Run SHALO Smith

< Back Cancel

Figure 18 SHALO Smith installation is complete

You can start SHALO Smith with a shortcut created on your desktop or in the Start menu.
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3.1.3 Installing the PKCS #11 module

The PKCS #11 module for Windows can be downloaded from https://auth.shalo.jp.

To install the PKCS #11 module, extract the downloaded ZIP file into a folder named

shalo_pkcs11 in the home directory. Use the following procedure:

1. In File Explorer, go to the home directory.
You can go there by typing “%HOMEPATH%" in the address bar of File Explorer and

then pressing the Enter key, as shown below.

= N = | This PC
Computer View

<« v 4 |EH StHOMEPATH: v | o O Sea

Create a folder with the name of “shalo_pkcs11”.
3. Right-click the shalo_pkcsll x.y.z windows.zip file you downloaded (where x.y.z
indicates the version number), and in the menu, select [Extract All...].

4. Specify the folder created in step 2 as the folder into which the file is extracted.

The shalo_pkcs11 folder after the installation will appear as shown below.

I 4 = | shalo_pkes11 - O d
Home Share View 0
« S <« username » shalo_pkes1l » v O £ Search shalo_pkes...
@ OneDrive ~ %64
&=/ Pictures 186

#P Saved Games
2 Searches
> shale_pkes11

2 iterns 1= &=

Figure 19 shalo_pkcsl1 folder in the home directory

The following table lists the paths to the installed PKCS #11 module by application.

Module usage Mode Relative path from the home directory
Windows application Intel 32 bit shalo_pkcs11\x86\slpkcsil-vc.dll

Intel 64bit shalo_pkcs11\x64\slpkcsll-vc.dll

Arm 64 bit shalo_pkcs11i\armé64\slpkcsil-vc.dll
Application ported to Windows Intel 32 bit shalo_pkcs11\x86\slpkcsll-mingw32.d11
(MinGW, Cygwin, Git) Intel 64 bit shalo_pkcs11\x64\slpkcsll-mingw64.d11

Arm 64 bit shalo_pkcsll\armé4\slpkcsll-mingw64.d1ll
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If your system drive is C:, the absolute path to the shalo_pkcs11 folder you created is as shown

below. username must be read as your own Windows username.

C:\Users\username\shalo_pkcsill
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3.2 Uninstalling software in Windows

3.2.1 Uninstalling SHALO Keyring

You can uninstall SHALO Keyring by using the following procedure:

1. Right-click on Start, then select [Apps and Features].

2.  Select “SHALO Keyring” from the apps list, and then click [Uninstall]. SHALO Keyring
Uninstall window will appear.
Click [Next] on the uninstall window.

4.  Click [Finish] to close the uninstall window.

3.2.2 Uninstalling SHALO Smith

You can uninstall SHALO Smith by using the following procedure:

1. Right-click on Start, then select [Apps and Features].

2. Select “SHALO Smith” in the apps list, and then click [Uninstall]. SHALO Smith
Uninstall window will appear.
Click [Next] on the uninstall window.
Click [Finish] to close the uninstall window.

3.23 Uninstalling the PKCS #11 module

To uninstall the PKCS #11 module, delete the folder containing the module using File Explorer.

The procedure is shown below:

1. Exit software that uses the module. Unregister the module from the software, if needed.
2. In File Explorer, go to the home directory.
3. Delete the shalo_pkcsl1 folder.

If the PKCS #11 module is registered in Acrobat®, deregister the module from
Acrobat® according to Section 7.2.2.
If the authentication agent is configured to start automatically, remove SHALO

AUTH from the authentication agent.

AH52126-UMO1E_04 SHALO AUTH User's Manual



Installation ‘ 38

3.3 Installing software in macOS
SHALO AUTH works with standard drivers that come with macOS. If you use SHALO AUTH as
a FIDO2 security key only, you do not have to read this section.

3.3.1 Installing SHALO Keyring

SHALO Keyring for macOS can be downloaded from https://auth.shalo.jp.

To install it, double-click the shalo_keyring x.y.z macos.dmg file you downloaded (where x.y.z

indicates the version number) to open it.

In the window that appears as shown in the following figure, drag and drop the SHALO Keyring

icon on the left into the Applications folder on the right to complete the installation.

-

SHALO Keyring

-y

& SHALO Keyring 1.0.0

Applications

Figure 20 SHALO Keyring installation

You can start SHALO Keyring from Launchpad or the Applications folder.
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3.3.2 Installing SHALO Smith

SHALO Smith for macOS can be downloaded from https://auth.shalo.jp.

To install it, double-click the shalo_smith x.y.z macos.dmg file you downloaded (where x.y.z

indicates the version number) to open it.

In the window that appears as shown in the following figure, drag and drop the SHALO Smith

icon on the left into the Applications folder on the right to complete the installation.

| NN ) B SHALO Smith 1.0.0

SHALO Smith Applications

Figure 21 SHALO Smith installation

You can start SHALO Smith from Launchpad or the Applications folder.
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3.3.3 Installing the PKCS #11 module

The PKCS #11 module for macOS can be downloaded from https://auth.shalo.jp.

When you double-click the shalo_pkcsll x.y.z macos.zip file you downloaded (where x.y.z
indicates the version number) in Finder, the ZIP file is extracted to create the libslpkcs11.dylib
file of the PKCS #11 module.

To install the module, as the root user, copy this libslpkcs11.dylib file to /usr/local/lib.

0 /usr/local/lib is the default whitelist for ssh-agent.

If you extracted the ZIP file in the Downloads folder, open the Terminal and run the following

command:

% sudo cp ~/Downloads/libslpkcsll.dylib /usr/local/lib/4

0 If you extracted the ZIP file in a different folder, change ~/Downloads to the path
to that folder.

The following message may appear, depending on your macOS environment:

cp: directory /usr/local/lib does not exist

If this happens, run the following commands to create a directory as the root user, and then

copy the file:

% sudo mkdir -p /usr/local/libd
% sudo cp ~/Downloads/libslpkcs11l.dylib /usr/local/lib/A
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3.4 Uninstalling software in macOS

34.1 Uninstalling SHALO Keyring

You can uninstall SHALO Keyring by using the following procedure:

1. Go to Application folder in Finder.
2. Drag “SHALO Keyring” to the Trash in the Dock or select it then press Command-
Delete.

3.  Open the Terminal and run the following command:

% rm -r ~/Library/Application\ Support/shalo-keyring-

3.4.2 Uninstalling SHALO Smith

You can uninstall SHALO Smith by using the following procedure:

1. Go to Application folder in Finder.
2. Drag “SHALO Smith” to the Trash in the Dock or select it then press Command-Delete.

3. Open the Terminal and run the following command:

% rm -r ~/Library/Application\ Support/shalo-smitha

3.4.3 Uninstalling the PKCS #11 module

To uninstall the PKCS #11 module, as the root user, delete the libslpkcs11.dylib file from

/usr/local/lib. Open the Terminal and run the following command:

% sudo rm /usr/local/lib/1libslpkcsil.dylibd

If the PKCS #11 module is registered in Acrobat®, deregister the module from
0 Acrobat® according to Section 7.2.2.
If the authentication agent is configured to start automatically, remove SHALO
AUTH from the authentication agent.
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3.5 Installing software in Linux

SHALO AUTH works with standard drivers that come with Linux. However, you need the
operations in Section 3.5.1 if you want to use the device without root privileges. This is also
the case if you use SHALO AUTH as a FIDOZ2 security key.

3.5.1 Installing an udev rules file

An udev rules file for SHALO AUTH must be installed before a non-root user can use SHALO
AUTH.

The following download software for Linux contains the udev rules file for SHALO AUTH with

the file name 60-usb-shalo-auth.rules:

® SHALO Keyring
® SHALO Smith
® PKCS #11 module

To install it, as the root user, copy 60-usb-shalo-auth.rules in the downloaded file to

/etc/udev/rules.d, and run the udevadm command to apply the new rules immediately.

To do this, open the terminal and run the following commands:

$ tar xvzf file-you-downloadedA
$ sudo cp 60-usb-shalo-auth.rules /etc/udev/rules.d/<
$ sudo udevadm control --reload-rulesd

The udev rules are not applied to SHALO AUTH that has already been connected
at the time of rules installation. If you want to reapply them, reconnect SHALO
AUTH.

3.5.2 Installing a prerequisite

libfuse?2 must be installed before you can successfully run SHALO Keyring or SHALO Smith. If
you are using Ubuntu 22.04 LTS or later, you can install it by running the following commands

on the terminal:

$ sudo apt updated
$ sudo apt -y install libfuse2d

Ubuntu prior to 22.04 LTS or other Linux distribution generally include libfuse2, so
the above is not necessary.
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Installing SHALO Keyring

SHALO Keyring for Linux can be downloaded from https://auth.shalo.jp.

To extract the shalo_keyring x.y.z linux.tar.gz file you downloaded (where x.y.z indicates the

version number), run the following command on the terminal:

$ tar xvzf shalo_keyring_x.y.z_linux.tar.gzd
shaloKeyring.appimage
60-usb-shalo-auth.rules

This command causes the following files to be created:

shaloKeyring.appimage SHALO Keyring for Linux
60-usb-shalo-auth.rules udev rules file for SHALO AUTH

If the udev rules file (60-usb-shalo-auth.rules) has not been installed yet, see
Section 3.5.1 to install it.

shaloKeyring.appimage has no predetermined installation location. You can install it anywhere

convenient for your management. To start SHALO Keyring, run shaloKeyring.appimage.

Installing SHALO Smith

SHALO Smith for Linux can be downloaded from https://auth.shalo.jp.

To extract the shalo_smith_x.y.z linux.tar.gz file you downloaded (where x.y.z indicates the

version number), run the following command on the terminal:

$ tar xvzf shalo_smith_x.y.z linux.tar.gzd
shaloSmith.appimage
60-usb-shalo-auth.rules

This command causes the following files to be created:

shaloSmith.appimage SHALO Smith for Linux
60-usb-shalo-auth.rules udev rules file for SHALO AUTH

If the udev rules file (60-usb-shalo-auth.rules) has not been installed yet, see
Section 3.5.1 to install it.

shaloSmith.appimage has no predetermined installation location. You can install it anywhere

convenient for your management. To start SHALO Smith, run shaloSmith.appimage.
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3.5.5 Installing the PKCS #11 module

The PKCS #11 module for Linux can be downloaded from https://auth.shalo.jp.

To extract the shalo_pkesll x.y.z linux.tar.gz file you downloaded (where x.y.z indicates the

version number), run the following command on the terminal:

$ tar xvzf shalo_pkcsll x.y.z_ linux.tar.gzd
libslpkcsli.so
60-usb-shalo-auth.rules

This command causes the following files to be created:

libslpkcsll.so PKCS #11 module for Linux
60-usb-shalo-auth.rules udev rules file for SHALO AUTH

If the udev rules file (60-usb-shalo-auth.rules) has not been installed yet, see
Section 3.5.1 to install it.

To install the module, as the root user, copy the libslpkcs11l.so PKCS #11 module to /usr/1ib.

Open the terminal and run the following command:

$ sudo cp libslpkcsil.so /usr/lib/d

/usr/lib and /usr/local/lib are the directories that are on the whitelist for
0 ssh-agent.
Many Linux distributions for desktop automatically run ssh-agent when the user
logs in to the GUI. ssh-agent is started at this time, but it is not easy to add a
whitelist to the agent.
In this manual, you avoid modifying the startup option by adding the PKCS #11

module to /usr/1ib, one of the default whitelists.
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3.6 Uninstalling software in Linux

3.6.1 Uninstalling the udev rules file

To uninstall the udev rules file, as the root user, delete 60-usb-shalo-auth.rules from

/etc/udev/rules.d. Open the Terminal and run the following command:

$ sudo rm /etc/udev/rules.d/60-usb-shalo-auth.rulesd

3.6.2 Uninstalling SHALO Keyring

To uninstall SHALO Keyring, delete the extracted shaloKeyring.appimage file. Then, run the

following command in the Terminal to erase the configuration files.

$ rm -r ~/.config/shalo-keyringd

3.6.3 Uninstalling SHALO Smith

To uninstall SHALO Smith, delete the extracted shaloSmith.appimage file. Then, run the

following command in the Terminal to erase the configuration files.

$ rm -r ~/.config/shalo-smithd

3.6.4 Uninstalling the PKCS #11 module

To uninstall the PKCS #11 module, as the root user, delete the libslpkcsll.so file from

/usr/1lib. Open the Terminal and run the following command:

$ sudo rm /usr/lib/libslpkcsll.so

If the authentication agent is configured to start automatically, remove SHALO
AUTH from the authentication agent.

AH52126-UMO1E_04 SHALO AUTH User's Manual



Using the SHALO Keyring key tool 46

Chapter 4

Using the SHALO Keyring key tool

This chapter explains the key tool, SHALO Keyring. SHALO Keyring is a software program for
configuring cryptographic keys in SHALO AUTH for the general security key functionality.

If you use SHALO AUTH as a FIDO2 security key only, you do not have to read this chapter.
Topics in this chapter

Setting up SHALO AUTH

Viewing the state of SHALO AUTH

Generating a new key

Importing an existing key

Removing a key

Obtaining a public key

Changing the user PIN

Generating a password or random number sequence
CKA_ID attribute of key data

© X N e o E WD e
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41  Setting up SHALO AUTH

SHALO Keyring displays the window shown in Figure 22 when detecting a new SHALO AUTH
device. You can start the setup process by clicking [Start the setup] in this window.

A new SHALO AUTH device has been connected.

You don't need to do any setup if you plan to use it only az 3 FIDO device.

=» Start the setup

@ Help

Figure 22 SHALO AUTH setup by SHALO Keyring

During the setup process, the tool initializes the data area for general security key functionality

and configures the following management information:

Device label An individual name used to identify multiple SHALO AUTH.

User PIN The password for when the user uses the device. It allows the use of
protected cryptographic keys.

SO PIN The password for management. It is used to reset the user PIN or to
restore SHALO AUTH to the factory settings.

This setup process does not affect any FIDO2 security key functionality.
If you have registered SHALO AUTH as a FIDO2 security key in a Web service
before the above setup process, you can still continue to use the device in that

service.

If you have previously set up a SHALO AUTH device and want to set it up again,
you must use SHALO Smith to restore the device to its factory settings. When the
device is restored to its factory settings, the FIDO2 security key information in it

is also removed.

During the SHALO AUTH setup process, configure the device label, user PIN, and SO PIN in
this order.
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Specifying the device label

The device label can include alphanumeric characters and symbols as well as character strings
in Japanese and other languages. The maximum number of characters in the label depends on

the types of characters. If the label is too long, you will see a warning.

Set the label to identify this device.

Figure 23 Specifying the device label

Specifying the user PIN

The user PIN can include alphanumeric characters and symbols. Specify a user PIN between

4 and 256 characters long. Enter the user PIN twice for confirmation.

Set the user PIN code for this device

Figure 24 Specifying the user PIN
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Specifying the SO PIN

The SO PIN can include alphanumeric characters and symbols. Specify a SO PIN between 4
and 256 characters long. Enter the SO PIN twice for confirmation.

Set the SO PIN code for this device

Figure 25 Specifying the SO PIN

When the setup process is complete, you will see the window below. Finally, click [Start the
application].

Figure 26 SHALO Keyring window after the completed setup process
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4.2 Viewing the state of SHALO AUTH

SHALO Keyring has different window layouts depending on the state of SHALO AUTH. When
SHALO AUTH has just been set up, one window shown in Figure 27 appears, but when SHALO

AUTH has one or more keys configured, another window shown in Figure 28 will appear.

E Foo's Token This device is already initialized.
You can now create or import a key.

@ Random
generator

Add a key to the device using an existing file.
[g'] Change the PIN

a mport the key
Q Delete
everything

or

Create a new key and add it to the device.

B Create a key

@ Help

Figure 27 When you connect SHALO AUTH to the PC immediately after the setup

= ped

Key slot 1
5 ECDSA sample key‘

AUTH ECDSA / 256bit / P-256 Until 2025-09-28

Device label
( Key slot 2

B roosToken v RSA sample key

RSA / 4096bit Until 2025-08-01

@ Random
generator
Key slot 3

[g'] Change the PIN
@ Setup the key

=

& Delete
everything

Key slot 4

3 T4 43

Foo Bar

RSA / 4096bit Until 2031-02-20

@ Help

Figure 28 When you connect SHALO AUTH with added keys to a PC
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Device label

This area displays the device label of SHALO AUTH you are viewing the information in and

working with.

B FoosToken v RSA sa

FOr WOork

Foo's Token

2] L nange me Fin

Clicking the label displays the list of SHALO AUTH devices connected to the PC. When you
select a device label from the list, the information of the selected SHALO AUTH device now
appears in the window. In addition, actions such as [Change the PIN] and [Delete everything]
are applied to the selected SHALO AUTH device.

SHALO Keyring can work with up to eight SHALO AUTH devices at once.

The LED of the selected SHALO AUTH device flashes. If multiple SHALO AUTH
0 devices are connected to the PC, you can distinguish the device you are

manipulating from others by looking at whether the LEDs are flashing.

State of the device

If the device is in an abnormal state, a warning is displayed in red at the top of the window.

When you hover the mouse cursor over the warning, the solution appears in the tool tip.

To unlock, please use the Smith application,
to reset the user PIN.
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Key slot

SHALO Keyring can store four sets of key data in SHALO AUTH. A storage area for the data is
called a key slot, and the information of key slots 1 to 4 is arranged vertically for display.

When a key slot has no key, the slot is displayed as shown in the following figure.

When a key slot does have a key, the following three sets of information are displayed.

1. Key name
2. Cryptographic algorithm and key length
3. Lifetime of the key

This information is displayed as shown in the following figure.

- b4
Key name Key operations
ECDSA sample key
Cryptographic algorithm and Lifetime of the key

key length

When the key has expired, the lifetime is displayed in red as follows:

Old Key

You can perform actions on the key from the menu shown in the following figure, which is
displayed by clicking [+].
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4.3 Generating a new key

SHALO Keyring has the capability to create keys, which can be stored in SHALO AUTH in
combination with the X.509 certificate. To do this, in SHALO Keyring, click [Create a key].

E Foo's Token This device is already initialized.
You can now create or import a key.

@ Random
generator

Add a key to the device using an existing file.
@] Change the PIN

a mport the key
Q Delete
everything

or

Create a new key and add it to the device.

B Create a key
@ Help

Figure 29 Creating a key in SHALO AUTH immediately after the setup

If SHALO Keyring looks as shown in the following figure, click [Setup the key] and then
[Create a new key] in an undefined slot field.

s Git key

AUTH ECDSA / 521bit / P-521 Until 2026-04-13

Foo's Token ™
E ? o @ Setup the key

Random
@ generator B Import a key

B Create a new key

@] Change the PIN

@ Setup the key

Q Delete
everything

@ Setup the key
@ Help

Figure 30 Creating a key with a storage location specified for it
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Specify information for the key you create in the key generation window shown in the figure
below. Then, click [Create], and enter your user PIN when prompted. The key is created if the
user PIN is successfully authenticated.

April 2026 ~ ™ J

Su Mo Tu We Th Fr Sa

20 30

[
=]
w
.

o Create the key

26 27 28 28 30 2
Expiration date 4 [
1026-04 (m} Today
ECDSA P-521 [recommended for SSH) v
ecommended for 55H)
A 4096bit (supported for PD
DSA P (recommended for S5H
Cancel e
D54 p-324

Figure 31 The key generation window

Key name

The name for identifying the key you create. It is displayed in SHALO Keyring and is also used

in the X.509 certificate as the subject field, which is the name to which the certificate belongs.

Key lifetime

Specify the lifetime of the key. You can either enter a year, month, and day in YYYY-MM-DD

format, or click the icon on the right and select the date in the calendar that appears.

This lifetime is used as an expiry date for the X.509 certificate in the public key.
The lifetime of the key takes effect only in applications that support X.509

certificates.

Key type

Specify a cryptographic algorithm of the key to be create. In general, select ECDSA P-521. In
the ECDSA, the security strength decreases in the order of P-521, P-384, and P-256.

Select RSA for keys that encrypt or sign PDF files or that are used in an environment where
the ECDSA is unavailable.
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4.4 Importing an existing key

SHALO Keyring can load a key from a file and import it to SHALO AUTH. When doing so, the
tool creates the X.509 certificate for the key and stores the certificate in SHALO AUTH together
with the key.

SHALO Keyring supports the three types of key data formats listed in the following table.

Data format Extension Description

PEM .pem For an RSA key:
It is text that begins with “----- BEGIN RSA PRIVATE KEY----- " and
ends with “----- END RSA PRIVATE KEY-----
For an ECDSA key:
It is text that begins with “----- BEGIN EC PRIVATE KEY----- " and
ends with “----- END EC PRIVATE KEY-----

OpenSSH .pem It is text that begins with “----- BEGIN OPENSSH PRIVATE KEY----- ”
and ends with “----- END OPENSSH PRIVATE KEY----- "

PuTTY .ppk Itis a key file generated with puttygen, which comes with PuTTY.

If you want to import a key file other than what is listed in the above table, see
Section 11.3 and convert it into the PEM format.

To import a key from a file into SHALO AUTH, click [Import the key] in SHALO Keyring.

E Foo's Token This device is already initialized.
You can now create or import a key.

e Random
generator

Add a key to the device using an existing file.

@ Change the PIN
[ B mport the key ]

Q Delete
everything

or

Create a new key and add it to the device.

B Create a key

@ Help

Figure 32 Importing a key into SHALO AUTH immediately after the setup
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If SHALO Keyring appears as shown in the following figure, in an undefined slot field, click
[Setup the key] and then [Import a key].

5 Git key

>
<
-
T
[}
=]
1
C
r
C
T
I

E'I Foo's Token Vv ® <o .
®
ﬁ Change the
& 5

@ se e ke
@ relp

Figure 33 Importing a key with a storage location specified for it

Either way, the window shown in the figure below will appear. Drop a key file into the box, or

click [Open a file] to select the key file.

o Import a key from a file.

Supported formats: OpenSSH, PuTTY, PEM

Open 3 file
Upen a Tile

Cance

Figure 34 Importing a key file

When the specified key file is encrypted with a passphrase, you will be prompted
to enter the passphrase.
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In the window shown in the figure below, specify the information to add when the key is
imported into SHALO AUTH. After specifying it, click [Import] and enter your user PIN to import
the key into SHALO AUTH.

April 2026 ~ ™ J

o®  Import the key from a file
Su Mo Tu We Th Fr Sa

Name of the key 20 30 31 1 2 3 4

19 20 21 22 23 24 25

26 27 28 29 30 1 2

.
1
ca

Today

Figure 35 Additional information of the key to be imported

Key name

The name to identify the key you will import. It is displayed in SHALO Keyring and is also used

in the X.509 certificate as the subject field, which is the name to which the certificate belongs.

Key lifetime

Specify the lifetime of the key. You can either enter a year, month, and day in YYYY-MM-DD

format, or click the icon on the right and select the date in the calendar that appears.

This lifetime is used as an expiry date for the X.509 certificate in the public key.
The lifetime of the key takes effect only in applications that support X.509

certificates.
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4.5 Removing a key

In SHALO Keyring, there are two ways to remove a key, including:

® Specifying a key slot and removing the key
® Frasing all data

Specifying a key slot and removing the key

In the key slot you want to empty, click [+++], and in the menu,

T Copy the SSH public key
select [Delete]. Enter your user PIN when prompted. The key Py the 55H public key
Export the X.509 certificate

'm’ Delete

Until 2023-08-01

is removed if the user PIN is successfully authenticated.

Erasing all data

On the left side of the window, click [Delete everything]. This action will also remove PKCS
#11 objects saved by applications other than SHALO Keyring.

s ECDSA sample key

AUTH ECDSA / 256hit / P-256 Until 2025-09-28
B roosToken v RS54 sample key
RSA / 4096bit Until 2025-08-01

® Random
generator

El Change the PIN
ot set yet @ Setup the key

Q Delete
everything

Foo Bar

RSA / 4096bit Until 2031-02-20
@ Help

Figure 36 Performing [Delete everything]

0 The actions above do not affect the labels, SO PIN, user PIN, FIDO2 PIN or
FIDO2 authenticate keys.
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Read the warning below, and if you are sure you want to erase the keys, click [Delete all the

keys]. Enter your user PIN when prompted. All the keys are erased if the user PIN is
successfully authenticated.

Q Are you sure to want to delete all the contents of this device?

This will delete from the device "Foo's Token * all the keys, certificates

as well as all other objects not managed by SHALO AUTH.

The labels, the SO PIN, the user PIN, and the keys used with FIDO U2F will be
presenved.

To reinihialize the device, use the factory reset available in the Smith application.

Cancel Delete all the keys

Figure 37 Warning before [Delete everything]
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4.6 Obtaining a public key

SHALO Keyring provides the capability to obtain public keys in the following two ways:

® Public key in a data format used by SSH
® X.509 certificate

0 An SSH public key can be obtained only when the cryptographic algorithm for the
key is RSA or one of P-521, P-384, and P-256

In any case, click [+++] for the key slot to open the menu shown in the following figure.

Copy the S5H public key
B Export the X.509 certificate

ﬁ Delete

Until 2025-08-01

SSH public key

An SSH public key contains text data that starts with one of the following:

ssh-rsa
rsa-sha2-256
rsa-sha2-512
ecdsa-sha2-nistp256
ecdsa-sha2-nistp384
ecdsa-sha2-nistp521

From the menu, select [Copy the SSH public key] to copy the SSH public key to the clipboard.

You can then use it by pasting it to other software.

X.509 certificate
An X.509 certificate can be saved to a file in PEM format.

In the menu, click [Export the X.509 certificate], specify the name of the target file, and save

the certificate to the file.

0 The certificate is a text-formatted file that begins with
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4.7 Changing the user PIN

To change the user PIN, on the left side of the window, click [Change the PIN].

E Foo's Token This device is already initialized.
You can now create or import a key.

@ Random
generator

Add a key to the device using an existing file.
@] Change the PIN

B mport the key
Q Delete
everything

or

Create a new key and add it to the device.

B Create a key

@ Help

Figure 38 Performing [Change the PIN]

In the window shown in the following figure, enter the current user PIN and a new user PIN,

and then click [Change].

[g] Change of the user PIN

Current user PIN

Mew user PIN

| |

Mew user PIN verification

| |
| Cance | Change

Figure 39 Change of the user PIN window

When locked, the user PIN cannot be unlocked in the Change of the user PIN
window. Use SHALO Smith to reset the user PIN (Section 5.4).
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4.8 Generating a password or random number sequence

SHALO Keyring can generate a password or random number sequence by using SHALO
AUTH's hardware random number generator. The following table shows random number

generation and output conditions by use.

Used for Specifiable conditions Generated quantities Delimiter

Password 1 to 64 characters long Up to 8 passwords Newline
Whether to allow uppercase characters,
lowercase characters, numbers, and

symbols, respectively.

Integer value | Minimum value: -32768 to +32767 Up to 32 rows and 32 No delimiter
Maximum value: -32768 to +32767 columns in tabular Comma
format Space

Tab character

Hexadecimal | Bit length: 1 to 64 bits Up to 16 rows and 16 No delimiter
string Whether the string is prefixed with "0x" | columns in tabular Comma
format Space

Tab character

available:

0 When symbols are enabled for the password, the following characters become
~l@#$ % &* () _+-={F[IN]|:3""<>, .2/

Method

To generate a random number, on the left of the window, click [Random generator].

S

AUTH

E Foo'sToken Vv This device is already initialized.
You can now create or import a key.

@ Random

generator

Add a key to the device using an existing file.
@] Change the PIN
B mport the key

Q Delete

everything

or
Create a new key and add it to the device.
B Create a key

@ Help

Figure 40 Performing [Random generator]
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In the window shown in Figure 41, specify the purpose of the random number and the

generation conditions. Clicking [Generate] generates and shows a random number in the

window. Clicking [Copy] copies the whole random number being displayed to the clipboard.

at! 13 Ox ._> ail 3 Ox
Password Integer HEX | Password Integer HEX
{ ]
Character type -
| Length 16 | Add "0x" as prefix Delimiter | comma ~ |
Upper case Lower cage
Qua 8 A| | bit length 32 A| | g A| | 4 Columns A|
Mumeral Symbal " R : - - ° - " -
0x4016ae2f, Oxbfc79a99, 0x1828952d, 0x503dcfia, =
0x884cD16e, @x40beffOc, 0x9aabdbbc, 0xcB23b254,
Oxbe256e2], Qx62684467, 0xbad7762f, 0x9ca5664,
Mx92c9pc?3  RxAATesRA  AxQ1d3hd1a  Axe3T2T169 e
Chze | | Copy | l Generate Close ‘ | Copy ‘ l Generate
el
ai! 123 0x ail 23 Ox
Password Integer HEX Password Integer HEX
Character type - i
| Length 16 | | 0 | Delimiter | comma hd |
Upper case Lower case
Quar 8 A| | Vi 99 A| | 4 F A| | & Columns A|
Mumeral Symbal i R - " -
3, "NCTZINI"bD: = 9, 68, 56, 5, @, 4, 18, 93, =
aPIL=HH">W3o:*Tf 8, 78, 53, 89, 2, 753, 7@, 99,
AXBTOt*6C:12ZcYm 7@, 78, 13, 71, 6@, 27, 87, 18,
1 "f¥MA- =RRVIQA e 9@ 84 11 1R 43 51 AR5 TR e
| Close | | Copy | l Generate | Close ‘ | Copy ‘ l Generate

Figure 41 Random number generation window and examples of generating a random number
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4.9 CKA_ID attribute of key data

SHALO Keyring reserves four CKA_ID attributes shown below for the key slots. When storing
a private key, public key, or X.509 certificate in SHALO AUTH, SHALO Keyring assigns a
CKA_ID attribute that corresponds to the destination key slot.

Key slot CKA_ID attribute (hexadecimal number) CKA_ID attribute (string)
Key slot 1 41 58 54 4F 4F 4C 4B 4559 23 31 AXTOOLKEY#1
Key slot 2 4158 54 4F 4F AC 4B 4559 23 32 AXTOOLKEY#2
Key slot 3 4158 54 4F 4F AC 4B 4559 23 33 AXTOOLKEY#3
Key slot 4 41 58 54 4F 4F 4C 4B 455923 34 AXTOOLKEY#4

If you separately manage data with other PKCS #11-compliant software, do not
A use these reserved CKA_ID attributes.
If you use the reserved CKA_ID attribute, the data may be manipulated by
SHALO Keyring, or the data may not be manipulated correctly by SHALO

Keyring.
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Chapter 5

Using the SHALO Smith

administration tool

This chapter explains the administration tool, SHALO Smith. SHALO Smith is a software
program dedicated to issuance and management tasks for SHALO AUTH.

Before transferring or disposing of SHALO AUTH, you must use SHALO Smith to restore the
device to the factory settings.

Topics in this chapter

Viewing the state of SHALO AUTH

Setting up SHALO AUTH

Restoring SHALO AUTH to the factory settings
Resetting the user PIN

Changing the SO PIN

ok b=
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5.1 Viewing the state of SHALO AUTH

SHALO Smith can show and manage up to eight SHALO AUTH devices connected to a PC.

Figure 42 shows a SHALO Smith window. In this example, one new SHALO AUTH device and
the three others you have previously set up are connected to the PC.

= x

G} The corresponding device can be identified by its blinking LED

S

AUTH E| new device | Setup | |:|

Device

administration

fool B Forprivate 2] UserPIN lock e
B rorwork B 50PN lack |_|
B} Foo's Token (¥) Already setup |_|
@ Help

Figure 42 Four SHALO AUTH devices displayed by SHALO Smith

Each of the vertically aligned white boxes indicates a single SHALO AUTH device. You can see

the device label on the left side in the box and the state of the device on the right, as shown
in the following figure.

/— Device label

E Foo's Token @ Already setup ||

State of SHALO AUTH

Action button
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Identifying SHALO AUTH

When you click a box with the mouse, the box now appears in a light color as shown in the
following figure, and the LED for the corresponding SHALO AUTH device flashes.

E| test @ Already setup

E Foo's Token @ Already setup

State of SHALO AUTH

The following table shows the states that SHALO AUTH can take.

State indicated Description

[Setup] button The device is not set up. You can set it up by clicking the button (Section 5.2).
[Already setup] The device is set up and in the normal state.
[User PIN lock] The device is set up, but the user PIN is locked.
To unlock it, you need to reset the user PIN (Section 5.4).
[SO PIN lock] The device is set up, but the SO PIN is locked.

Restoring it to the factory settings (Section 5.3) is the only way to unlock it.

Actions for SHALO AUTH
You can set up a new SHALO AUTH device by clicking [Setup].

When you click [+*+] on the far right, the menu appears as shown
in the figure to the right, enabling you to perform actions related
to administration of SHALO AUTH. Alres I Change the SO PIN

£% Factory reset

ﬁ Reset the user PIN
a

The only action you can perform on a new SHALO AUTH device is restoring it to
the factory settings.

Doing so will remove the FIDO2 PIN and all FIDO authentication keys used for
FIDO2.
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5.2 Setting up SHALO AUTH

During the setup process, the tool initializes the data area for general security key functionality

and configures the following management information. SHALO Keyring can also be used for

setup.
Device label An individual name used to identify multiple SHALO AUTH.
User PIN The password for when the user uses the device. It allows the use of
protected private keys.
SO PIN The password for management. It is used to reset the user PIN or to
restore SHALO AUTH to the factory settings.
This setup process does not affect any FIDO2 security key functionality.
If you have registered SHALO AUTH as a FIDO2 security key in a Web service
before the above setup process, you can still continue to use the device in that
service.
If you have previously used a SHALO AUTH device and want to set it up again, you
must restore the device to the factory settings. When the device is restored to its
factory settings, the FIDO2 security key information in it is also removed.
Procedure

Click [Setup] to start the SHALO AUTH setup process. During the setup process, configure
the device label, user PIN, and SO PIN in this order.

Specifying the device label

The device label can include alphanumeric characters and symbols as well as character strings
in Japanese and other languages. The maximum number of characters in the label depends on

the types of characters. If the label is too long, you will see a warning.
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Label setup >  User PIN code setup > 50 PIN code sstup

Set the label to identify this device.

Label

l Ex: "Work", "For Git", "my device

Cance Next

@ Help

Figure 43 Specifying the device label

Specifying the user PIN

The user PIN can include alphanumeric characters and symbols. Specify a user PIN between

4 and 256 characters long. Enter the user PIN twice for confirmation.

Set the user PIN code for this device

You will need it when using the key or when adding or

remaving a key to the device,

User PIN code

S

. Verification of the user PIN code

Cance Back Mext

Figure 44 Specifying the user PIN
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Specifying the SO PIN
The SO PIN can include alphanumeric characters and symbols. Specify a SO PIN between 4

and 256 characters long. Enter the SO PIN twice for confirmation.

Set the SO PIN code for this device.

You will need this to reset the user PIN code if it was
ten or in order to lift a PIN lock

Cance

Figure 45 Specifying the SO PIN
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5.3 Restoring SHALO AUTH to the factory settings

When you restore SHALO AUTH to the factory settings, all the following information is

removed:

SO PIN

User PIN

Device label

All PKCS #11 data

FIDO2 PIN

All FIDO authentication keys including passkeys

Restoring a device to the factory settings also removes FIDO2 PIN and all the FIDO
authentication keys used for FIDOZ in it. Therefore, the device is recognized as an
unregistered one even by Web services for which the device was previously on
their list.

We strongly recommend that you restore SHALO AUTH to the factory settings
0 before transferring or disposing of the device. Doing so can prevent a malicious
user from being authenticated through the transferred SHALO AUTH device in any
Web services where the device is registered as the two-factor authentication

device.

Procedure
1. Click [+*+] on the right side of the target device. Already setup |_|
2. From the menu, select [Factory reset]. o
3. In the window shown in Figure 46, click [Perform a E) Reset the user PIN
factory reset]. res B Change the SOPIN
4. Input the SO PIN and click [Authenticate]. €% Factory reset

t’:; Are you sure to want to perform a factory reset?

The device "For private " will return to the state it was
when shipped from the factory (in a state without any settings)
and all keys and setting will be deleted.

= Ifyou forgat your 50 PIN

Figure 46 Factory reset window
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Troubleshooting when you forgot the SO PIN
You can restore the device's factory settings without the SO PIN via the following procedure:

1. In the window shown in Figure 46, click [If you forgot your SO PIN].

2. After the window shown in Figure 47 appears, press and hold the button on the side of
the SHALO AUTH device until its LED starts flashing rapidly. This takes about 30
seconds.

3. While the LED is flashing, click [Reset].

Factory reset using the physical button

To perform a factory reset without the SO PIN
press 30 seconds the button on the side of the device,

When the LED starts blinking rapidly, press on the 'Reset’ button.

Cance Rezet

Figure 47 Restoring the factory settings without the SO PIN

This is how you can restore the SHALO AUTH's factory settings even if the SO PIN

is locked.

If you click [Reset] when the LED is not flashing, the number of possible PIN
authentication attempts decreases by one because the software considers it an
authentication failure with the SO PIN. Repeating this action will lock the SO PIN.

-
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5.4 Resetting the user PIN

When you reset the user PIN:

® The user PIN is changed to a new one.
® The user PIN is unlocked.
® The number of possible authentication attempts before the PIN is locked is reset to

five.

When resetting the user PIN, you have to enter the current SO PIN, not the current user PIN.

Procedure

Click [++-] on the right side of the target device. Already setup |

From the menu, select [Reset the user PIN]. B Reset the user PIN

In the windows shown in Figure 48, input both PINs and

Change the SO PIN
then click [Reset]. & Crenge

Alrea

% Factory reset

@'1 Reset of the user PIN

Current SO PIN

|

Mew user PIN

Mew user PIN verification

Figure 48 Resetting the user PIN
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5.5 Changing the SO PIN

To change the SO PIN, use the following procedure:

Already setup | |

1. Click [+*+] on the right side of the target device. —
From the menu, select [Change the SO PIN]. (E) Reset the user PIN
Enter the current SO PIN and a new SO PIN, and then

click [Change].

- B Change the 5O PIN

:':3 Factory reset

B Change of the 50 PIN

Current SO FIN

| |

MNew S0 PIN

Mew SO PIN verification

| Cance | Change

Figure 49 Changing the SO PIN

AH52126-UMO1E_04 SHALO AUTH User's Manual



Using Passkeys in Web services 75

Chapter 6

Using Passkeys in Web services

This chapter explains how to use passkeys created by SHALO AUTH in Web services.

Passkeys held in SHALO AUTH cannot be backed up to other media. We strongly recommend
that you have additional login methods in case of loss or damage. This chapter therefore
assumes that the two-step verification process has been enabled in advance for each Web

service's account.
For an overview of FIDO2 and passkeys, see Section 2.2.
Topics in this chapter

1. Management of FIDO2 security keys (Windows)

2. Management of FIDO2 security keys (macOS/Linux)
3. Passkey settings for Google

4. Passkey settings for GitHub
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6.1 Management of FIDO2 security keys (Windows)

6.1.1 Management by the Settings app

In Windows, the FIDO2 security key can be managed using the window shown below in the

Settings app.

Windows Hello setup

ces g
+2+ Security Key PIN
.
Creating a PIN for your security key helps keep you secure

Add

Reset Security Key

Remove everything from this security key and reset to
‘ factory settings

Reset

Close

Figure 50 Settings app management window

To open this window, launch the Settings app and click [Settings] > [Accounts] > [Sign-in
options] > [Security key] > [Manage].

< Settings N o 3
® Accounts
- Local Account
o= Yourinfo 3
o=
X X Profile photo
Find a setting Q
~ p Sign-in options N
7 Home Windows Hello, security key, password, dynamic lack
B System
B Email & accounts 3
g i elemis & dEriass Accounts used by email, calendar, and contacts
W Network & internet Family
@ Manage your family group, edit account types and device >
/ Personalization permissions
B Apps
. Windows backup
- r®@ Back up your files, apps, preferences to restore them across >
| w» Accounts e
‘L, Time & language
fal Other user:
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< settings N a &
o Accounts > Sign-in options
- Local Account
Ways to sign in
nclalsething 2 Facial recognition (Windows Hello) -
This option Is currently unavailable
4% Home |
== Fingerprint recognition (Windows Hello)
2
B System I@ This option is currently unavailable d
a Bluetooth & devices
PIN (Windows Hella) -
¥  Network & internet This option is currently unavailable
#  Personalization G Security key .
Sign in with a physical security key
B Apps
| : Accounts p Password o
Sign in with your account's password
P Time & language

This option is currently unavailable

E] Security key ~

Sign in with a physical security key

Sign in to apps with a physical security

Mana
key nage

~  Password

When the following figure appears, follow the on-screen instructions to connect SHALO AUTH
to the PC, and then press the button on SHALO AUTH.

Windows Hello setup P Windows Hello setup
® DL L]
° ®
®
® ®
L]
® L]
Insert your security key into the USB port. Touch your security key.
Close Close
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6.1.2 Set/Change PIN

To set the FIDO2 PIN, click [Add] or [Change] under [Security Key PIN] in the window below.
The [Add] button is displayed if the FIDO2 PIN has already been set, otherwise the [Change]
button is displayed.

Windows Hello setup

:i% Security Key PIN
* Creating.a PIN far your security key helps keep you secure

Add

Reset Security Key

Remove everything from this security key and reset to
factory settings

Reset

Close

When the [Add] button is clicked, the following window appears. Enter a new PIN, and then
click [OK].

Windows Hello setup

Set up a security key PIN

Confirm security key PIN

Cancel
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When the [Change] button is clicked, the following window appears. Enter the existing PIN
and a new PIN, and then click [OK].

Windows Hello setup

Change your security key PIN

New security key PIN

Confirm security key PIN

Cancel
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6.1.3 Resetting FIDO2 security key

To reset a FIDO2 security key, click [Reset] under [Reset Security Key] in the window below.

Windows Hello setup

e .
+2+ Security Key PIN
.
Creating a PIN for your security key helps keep you secure

Add

Reset Security Key

Remove everything from this security key and reset to

facton: sattinas,

Reset

Close

Resetting a FIDO2 security key deletes the FIDO2 PIN and all FIDO authentication
keys, include passkeys. It does not delete PKCS#11 related information.
See Section 5.3 to remove all information in SHALO AUTH.

To reset, the following steps are required.

1. Click [Proceed] when a warning message appears.
2. Remove SHALO AUTH from the PC and reinsert it.
3. Press the SHALO AUTH button twice within 10 seconds.

First, click [Proceed] in the window below.

Windows Hello setup

Reset Security Key

The security key will be reset to factory settings. All data and
credentials on this key will be cleared.

Praceed Cancel
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Remove SHALO AUTH from the PC, and then insert it.

Windows Hello setup

—
Reinsert your security key.

Learn more

Cancel

Within 10 seconds of the insertion, press the button on SHALO AUTH twice.

Windows Hello setup

Touch your security key twice within 10 seconds

Learn more

Cancel
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6.2 Management of FIDO2 security keys (macOS/Linux)

6.2.1 Management by Chrome

In macOS and Linux, the FIDO2 security key can be managed using Chrome.

[ oW ] 1 Settings - Manage security k- x ar v
« > C & Chrome chrome:f/settings/securityKeys ¥ - i
e Settings Q, search settings
G Youand Google € Manage security keys
@ Autofill and passwords
. . Manage phones N
e Privacy and security Control which phones you use as security keys
) Performance
Create a PIN N
Protect your security key with a PIN (Personal |dentification Number)
»  Appearance
Q_  Search engine Sign-in data N
Manage sign-in data stored on your security key
[ Default browser
Fingerprints N
[U] On startup Add and delete fingerprints saved on your security key
Reset your security key
3
YA Languages This will delete all data on the security key, including its PIN
L . P

Figure 51 Management page of Google Chrome

To open this page in Chrome, enter chrome://settings/securityKeys in the address bar, or click

[Settings] > [Privacy and security] > [Security] > [Manage Security keys].
This operation is described here with screenshots.

Click [ : ] at the top right of Chrome to open the menu, and then click [Settings] on the menu.
Click [Privacy and security] and scroll down as shown in the following figure, and then click

[Security].
[ NN ] £ Settings - Privacy and secur X o v
& 5 ¢ @ chrome chrome://settings/privacy e &
e Settings Q_ search settings
Third-party cookies T
(&) »
G You and Google Third-party cookies are blocked in Incognito mode
@a  Autofill and passwords @ Ad privacy R
" Customize the info used by sites to show you ads
@  Privacy and security
[?] Seeurity .
(& Performance Safe Browsing (protection from dangerous sites) and other security settings
Appearance
@ PP o= Sitesettings .
- n - . .
Q Search engine Controls what information sites can use and show (location, camera, pop-ups, and more)
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Then, on [Security] page, scroll down and click [Manage security keys].

[ JoN ] £ Settings - Security x o+ ~
« ¢ & Chrome chrome://settings/security Y 2
G Settings Q, Search settings
G You and Google Select DNS provider 05 default (when available) -
@a  Autofill and passwords Manage V8 security N
Turn on additional protection in Chrome’s JavaScript and WebAssembly engine
@  Privacy and security
Manage security keys
(% Performance . ’
Reset security keys and create PINs
Appearance
@ PR Manage certificates @
Q Search engine Manage HTTPS/SSL certificates and settings

6.2.2 Set/Change PIN

To set the FIDO2 PIN, click [Create a PIN] on the [Manage security keys] page as shown in

the following figure.

[ BON ] £ Settings - Manage security b X + -
<« C @ Chrome chrome://settings/securityKeys ¥ a i
G Settings Q_ Search settings
& You and Google € Manage security keys
@a  Autofill and passwords
. ) Manage phones N
e Privacy and security Control which phones you use as security keys
(& Performance
Create a PIN N
Protect your security key with a PIN (Personal Identification Number)
P Appearance
Q. search engine Sign-in data ,
Manage sign-in data stored on your security key
[ Default browser
Fingerprints ,
[0} On startup Add and delete fingerprints saved on your security key
Reset your security key
3
?A Languages This will delete all data on the security key, including its PIN
] g

When the following window appears, insert SHALO AUTH into the PC, and then press the
button on SHALO AUTH.

Create a PIN

To continue, insert and touch your security key

~

Cancel Save
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If the FIDO2 PIN has not been set in SHALO AUTH, the following window appears. Enter a PIN
and click [Save].

Create a PIN

Enter your new PIN. A PIN must be at least 4 characters long and can contain
letters, numbers, and other characters.

PIN Confirm PIN

If the FIDO2 PIN is set in SHALO AUTH, the following window appears. Enter the existing PIN
and a new PIN, and then click [Save].

Change a PIN

Enter your current PIN to change it. If you don't know your PIN, you'll need to
reset the security key, then create a new PIN.

Current PIN

Enter your new PIN. A PIN must be at least 4 characters long and can contain
letters, numbers, and other characters.

PIN Confirm PIN
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6.2.3 Resetting FIDO2 security key

To reset a FIDO2 security key, click [Reset your security key] on the [Manage security keys]
page as shown in the following figure.

[ BN ] £ Settings - Manage security kb X + 4
&« &} & Chrome chrome://settings/securityKeys ¥ a
@ Settings Q_ search settings
&  Youand Google € Manage security keys
@a  Autofill and passwords
. ) Manage phones N
e Privacy and security Control which phones you use as security keys
(y  Performance
Create a PIN N
Protect your security key with a PIN (Personal Identification Number)
P Appearance
Q_  search engine Sign-in data .
Manage sign-in data stored on your security key
3 Default browser
Fingerprints N
[0} On startup Add and delete fingerprints saved on your security key
Reset your security key
»
YA Languages This will delete all data on the security key, including its PIN
L A

Resetting a FIDO2 security key deletes the FIDO2 PIN and all FIDO authentication
keys, including passkeys. It does not delete PKCS#11 related information.
See Section 5.3 to remove all information in SHALO AUTH.

To reset, first remove SHALO AUTH from the PC, and then reinsert it.

Reset your security key

To continue, remove your security key from your device, then reinsert and
touch it

™

Cancel

The following figure appears when SHALO AUTH is inserted. Press the button on SHALO AUTH
within 10 seconds of the insertion.

Touch to confirm reset

Touch your security key again to confirm reset. All information stored on the
security key, including its PIN, will be deleted.

Cancel
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6.3 Passkey settings for Google

6.3.1 Registering SHALO AUTH

If the two-step verification process has already been turned on, you can add SHALO AUTH to
your Google account by following the procedure below. Make sure that SHALO AUTH is

disconnected from the PC.

1.  Open https://myaccount.google.com/ in a Web browser and log in.

Select [Security].

w

If [Passkeys and security keys] appears in [How you sign in to Google], click it.
Otherwise, click [2-Step Verification], and then click [Passkeys and security keys].
Click [Create a passkey].

Click [Security Key] under [Choose where to save this passkey].

Connect SHALO AUTH to the PC.

If SHALO AUTH does not have a FIDO2 PIN, enter a new PIN.

Otherwise, enter the PIN.

Wait until SHALO AUTH's LED flashes, and then press the button.

Log out, and check that you can log in with SHALO AUTH.

N ok

®©

The following explains the procedure together with screenshots.

The explanations in this subsection are based on the information correct at the
0 time of writing this manual.

Note that the website screenshots may differ from those in the manual.
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Steps 1to 3

If [Passkeys and security keys] is displayed in [How you sign in to Google] as shown in the
following figure, click it.

Otherwise, click [2-Step Verification].

v G Security X + = (] X

<« > C %% myaccount.google.com/security?gar=Wzld&hl=en&utm_source=0G... ¥ @
Go gleAccount Q, Search Google Account @ = o

Personal info Data & privacy Security People & sharing Payments &

How you sign in to Google

Make sure you can always access your Google Account by keeping this information up to date

@ 2-Step Verification @ Onsince May 18, 2021 >

& Passkeys and security keys 1 passkey >

As shown in the following figure, scroll down and click [Passkeys and security keys] under
[Second steps].

r |

v G 2-Step Verification X + = O x

&« - c 25 myaccount.google.com/signinoptions,/twesviauthuser=08&rapt=AEjH... b @

Google Account ® = o

& 2-Step Verification

Second steps

Make sure you can access your Google Account by keeping this information up to date and
adding more sign-in options

:? Passkeys and security keys o Add a security key >

D Google prompt >
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Step 4

As shown in the following figure, click [Create a passkey].

v & NewTsb X G Passkeys and security keys X ar = O x

aen

« - C 25 myaccount.google.com/signinoptions/passkeys?utm_source=google... ¥¢ @

Google Account ® = @

& Passkeys and security keys

With passkeys, you can securely sign in to your Google Account using just
your fingerprint, face, screen lock, or security key. Passkeys and security
keys can also be used as a second step when signing in with your password.

Be sure to keep your screen locks private and security keys safe, so only
you can use them.

Passkeys can be created on your devices or on security keys. Learn more @

<+ Create a passkey >

You may see the following screen. If so, click [Use another device].

v~ G Passkeys and security keys X ar (]

<« - C 2 myaccount.google.com/signinoptions/passkeys?opendialog=addsk&... Y @

I

A passkey can't be created on this device

P
X

/

Use another device
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Step 5
The following window appears. Click [Security Key] and then click [Next].

. . X
| == Windows Security

Choose where to save this passkey

0O iPhone, iPad, or Android device
®

More choices

I =48l iPhone, iPad, or Android device

| Security key

Next Cancel

The following window appears. It notices that a web service (google.com) and a browser (in
this case, chrome) are asking Windows for access to the security key. Click [OK] if there are

no problems.

. N X
== Windows Security

| Security key setup

Set up your security key to sign in to google.com as

This request comes from the app "chrome.exe” by “Google LLC".

| [ OK Cancel

. N X
== Windows Security

Continue setup

| This will let google.com see the make and model of your security
key.

google.com wants to create a credential on your security key.
This lets you sign in without having to type your username.

Mote: A record of your visit to this site will be kept on your
security key.
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Step 6
Connect SHALO AUTH to the PC as instructed on the screen.

. . X
== Windows Security

Continue setup

B

Insert your security key into the USB port.

(o )

Step 7

If SHALO AUTH does not have a FIDOZ2 PIN, the following window appears. Enter a new FIDO2
PIN, and then click [OK].

. . X
== Windows Security

Continue setup

® Mew Security Key PIN
W new Security Key PIN

Confirm Security Key PIN

Confirm Security Key PIN

If SHALO AUTH has a FIDO2 PIN, the following window appears. Enter the FIDO2 PIN, and
then click [OK].

== Windows Security

Continue setup

® Security Key PIN
- f}e:: urity Key PIN
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Step 8

Wait until SHALO AUTH's LED flashes, and press its button.

. . X
== Windows Security

Continue setup

B

Touch your security key.

Cancel

The following window appears when a passkey is successfully created by SHALO AUTH.

. . X
== Windows Security

Passkey saved

You can now use your security key to sign in to "google.com”.

Finally, after successfully registering the created passkey with the Google account, the

following figure will appear.

v G 2-Step Verification X ar = [m] x

« - C 2% myaccount.google.com/signinoptions/passkeys?opendialog=addsk&... ¥r @

Passkey created on your security key

L

Step 9

Log out and then log in again to check that you can log in successfully. Follow the on-screen
instructions to enter the FIDO2 PIN, wait until SHALO AUTH’s LED flashes, and then press the
button.
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6.3.2 Deregistering SHALO AUTH

You can deregister SHALO AUTH from your Google account by using the following procedure:

Open https://myaccount.google.com/ in a Web browser and log in.

1
2. Select [Security].

3. In[How you sign in to Google], click [Passkeys and security keys].
4. Click the cross icon next to the security key you want to deregister.

The following explains the procedure together with screenshots.

Steps 1to 3

As shown in the following figure, click [Passkeys and security keys].

" G Security X + — O b'e

< &) 25 myaccount.google.com/security?gar=WzJd&hl=en&utm_source=0G... V¢ 0

Go g|e Account Q, Search Google Account @ o
Personal info Data & privacy Security People & sharing Payments &

How you sign in to Google

Make sure you can always access your Google Account by keeping this information up to date

@ 2-Step Verification @ Onsince May 18, 2021 >

& Passkeys and security keys 1 passkey >
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Step 4

As shown in the following figure, click the edit icon next to the security key you want to remove.

i G Passkeys and security keys X + — ] b'e
< &) 2% myaccount.google.com/signinoptions/passkeys?rapt=AEJHL4P7rVRo... ¥ @
Google Account ® = o

& Passkeys and security keys

[+ cCreate apasskey |

Passkeys
Create passkeys on your devices, or you can create a passkey on your security key.

Learn more ®

YOUR SECURITY KEYS

@ FIDO2 security key V4 %

Created: Just now
Last used: Mot yet used
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6.4 Passkey settings for GitHub

6.4.1 Registering SHALO AUTH

Configure the TOTP mobile app or SMS in advance to enable two-factor authentication. Make

sure that you store the recovery code you will receive at this time in a safe location.

You can register a passkey of SHALO AUTH for your GitHub account by using the procedure
below. Make sure that SHALO AUTH is disconnected from the PC.

N ok W e

8.
9.

Open https://www.github.com in a Web browser and log in.

Click the profile image in the upper-right corner, and then click [Settings].
In [Access], click [Password and authentication].

In [Passkeys], click [Add a passkey].

Confirm the notification of access to the security key and click [OK].
Connect SHALO AUTH to the PC.

If SHALO AUTH does not have a FIDO2 PIN, enter a new PIN.

Otherwise, enter the PIN.

Wait until SHALO AUTH's LED flashes, and then press the button.

Input the nickname for the passkey and click [Done].

10. Sign out, and check that you can sign in with SHALO AUTH.

The following explains the procedure together with screenshots.

The explanations in this subsection are based on the information available at the
time of writing this manual.
Note that the website screenshots may differ from those in the manual.
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Steps 1to 2

Log in to GitHub, click the profile image in the upper-right corner, and click [Settings].

v ) GitHub X+ — O X

<« N & 23 github.com B & @ i

= o Dashboard E 2 X

Your organizations

Top Repositories @ Your enterprises

) Your sponsars

Create your first project

+ Create new
Ready to start building? Create a repository for a new idea o
contributing to it.

X, Try Enterprise

Create repository Tyl =eleETs gy & Feature preview New

[ 88 Settings ]

Home [0 GitHub Docs

A GitHub Support
<> Start writina code hd

Step 3

In [Access], click [Password and authentication].

v~ ) Your profile X + = (] X
“ > 23 github.com/settings/profile = B & @ i
f Accessibility “

L\ MNotifications

Access
E5 Billing and plans v

B9 Emails

() Password and authentication

1) Sessions
42 SSH and GPG keys

Organizations
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Step 4

Scroll down and click [Add a passkey] under [Passkeys].

v €) Account security x r = [m] X
“« - & 23 github.com/settings/security e X Bg @ H
Passkeys -

¥ 1

Passwordless sign-in with passkeys

Passkeys are webauthn credentials that validate your identity using touch,
facial recognition, a device password, or a PIN. They can be used as a
password replacement or as a 2FA method. Passkeys can be used for sign-
in as a simple and secure alternative to your password and two-factor
credentials.

This browser or device is reporting partial passkey support, but you may be able to
use a passkey from a nearby device.

Add a passkey

When the following screen appears, click [Add passkey].

v ) Configure passwordless auther X r = O x

“« - & %% github.com/sessions/trusted-device?return_to=%2Fsettin... % B ¥ @ H

Configure passwordless authentication

b 13

Add a passkey

Your device supports passkeys, a
password replacement that validates
your identity using touch, facial
recognition, a device password, or a
PIN.

Passkeys can be used for sign-in as a
simple and secure alternative to your
password and two-factor credentials.

Add passkey

Cancel
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Step 5

The following window appears. It notices that a web service (github.com) and a browser (in
this case, chrome) are asking Windows for access to the security key. Click [OK] if there are

no problems.

. . X
== Windows Security

Security key setup

Set up your security key to sign in to github.com as axelltane.

This request comes from the app "chrome.exe” by "Google LLC".

OK Cancel

. . X
== Windows Security

Continue setup

github.com wants to create a credential on your security key. This
lets you sign in without having to type your username.

Note: A record of your visit to this site will be kept on your
security key.

[ OK Cancel

Step 6
Connect SHALO AUTH to the PC as instructed on the screen.

. . X
== Windows Security

Continue setup

B

Insert your security key into the USB port.

(o)
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Step 7

If SHALO AUTH does not have a FIDOZ2 PIN, the following window appears. Enter a new FIDO2
PIN, and then click [OK].

== Windows Security

Continue setup

® New Security Key PIN
W pew Security Key PIN

Confirm Security Key PIN

Confirm Security Key PIN

“ Cance'

If SHALO AUTH has a FIDO2 PIN, the following window appears. Enter the FIDO2 PIN, and
then click [OK].

== Windows Security

Continue setup

® Security Key PIN
W fecurity Key PIN

“ Ca nce'

Step 8

Wait until SHALO AUTH's LED flashes, and press its button.

. . x
w Windows Security

Continue setup

8

Touch your security key.

Cancel

The following window appears when a passkey is successfully created by SHALO AUTH.

. N hed
w Windows Security

Passkey saved

You can now use your security key to sign in to "github.com”.

e ]
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Step 9

Input the nickname for the passkey and click [Done].

v O Configure passwordless authe x + —

<« [&] °% github.com/sessions/trusted-device?retumn_to=%2Fsettin... % Bg ¢ @

O

Configure passwordless authentication

Successfully added a passkey

From now on, you can use this passkey
to sign-in to GitHub.

Passkey nickname

| ( J
| [ oo

Step 10

99

Sign out and then sign in again to check that you can sign in successfully. Click [Sign in with

a passkey]. Follow the on-screen instructions to enter the FIDO2 PIN, wait until SHALO

AUTH's LED flashes, and then press its button.

v ) signin to GitHub - GitHub X  + _

€« c 25 github.com/login e [ Bg @

O

Sign in to GitHub

i Username or email address

Password Forgot password?

|

| =]
| Or

! A\ This browser or device is

| reporting partial passkey
| support.

B¢ Sign in with a passkey
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6.4.2 Deregistering SHALO AUTH

You can deregister SHALO AUTH from your GitHub account by using the following procedure:

Open https://www.github.com in a Web browser and log in.

1

2. Click the profile image in the upper-right corner, and then click [Settings].
3. In[Access], click [Password and authentication].
4

In [Passkeys], click on the trashcan under the passkey nickname you want to remove.

The following explains the procedure together with screenshots.

Steps 1to 2
Log in to GitHub, click the profile image in the upper-right corner, and click [Settings].

v ) GitHub X+ — O X

&« c 23 github.com C B % 0
= o Dashboard ﬂ 2 X

Your organizations
Top Repositories @ Your enterprises

) Your sponsors

Create your first project
+ Create new

Ready to start building? Create a repository for a new idea o
contributing to it. A, Try Enterprise
- s ™y
Create repository S e 8, Feature preview ((New )
8 Settings
Home 00 GitHub Docs

A GitHub Support

<> Start writina code
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Step 3

In [Access], click [Password and authentication].

v ) Your profile x r

« c 25 github.com/settings/profile

f Accessibility

L\ Notifications

Access
E5 Billing and plans

B9 Emails

(1) Password and authentication
(i) Sessions
&2 SSH and GPG keys

Organizations

Step 4

Using Passkeys in Web services 101

g x O

In [Passkeys], click on the trashcan under the passkey nickname you want to remove.

v ) Account security x  +
« c 23 github.com/settings/security
Passkeys

2FA.

- [} X

e kA O

Passkeys are webauthn credentials that validate your identity using touch, facial recognition, a device
password, or a PIN. They can be used as a password replacement or as a 2FA method. Learn more
about passkeys. Passkeys are convenient, but the best account security comes from also enabling

L\ This browser or device is reporting partial passkey support, but you may be able to use a

passkey from a nearby device.

Your passkeys

‘? SHALO AUTH ' Seen from this browser
Addedanblay 19, 2024 | Last used less than an hour ago

Z| G

Add a passkey
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Chapter 7

Using SHALO AUTH in PDF files

Adobe® Acrobat® and Adobe® Acrobat® Reader® for Windows or macOS can use SHALO AUTH
through the PKCS #11 module. They can also use the keys stored in SHALO AUTH as digital
IDs for Acrobat®.

This chapter explains how to use SHALO AUTH to secure PDF files.
Topics in this chapter

Understanding PDF file security

Registering the PKCS #11 module with Acrobat®
Importing a digital ID from SHALO AUTH

Giving the certificate of the digital ID to other people
Encrypting a PDF file with a digital ID

Viewing an encrypted PDF file

N o s w N

Signing a PDF file electronically with a digital ID
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Using SHALO AUTH in PDF files

7.1 Understanding PDF file security

Adobe® Acrobat® and Adobe® Acrobat® Reader® for Windows or macOS (hereafter called

Acrobat®) can use SHALO AUTH through the PKCS #11 module.
Combining the security for PDF files with SHALO AUTH enables:

® Certain SHALO AUTH owners to view the PDF files by encrypting them.
® The PDF files to be signed electronically using SHALO AUTH.

These operations employ the personal identification information called a digital ID in Acrobat®.
This section explains the digital ID, followed by PDF encryption and electronic signing. The

subsequent sections explain how to use SHALO AUTH in Acrobat®.

Digital ID

A digital ID is information used to identify an individual, and consists of the following two

components:

® Private key for public key cryptography
® Certificate (public key for public key cryptography and personal information)

These are the same as the SHALO AUTH-managed data described in Section 2.3.3. Acrobat®
supports the PKCS #11 APl and thus can use keys stored in SHALO AUTH as the digital IDs.

Use RSA keys as the digital IDs.
This is because Acrobat® cannot use ECDSA keys through PKCS #11.

Encrypting PDF files

By encrypting PDF files, you can prevent them from being viewed by the general public. You

can encrypt PDF files by:

® Protecting them with a password

® Protecting them through a certificate

Password protection is a method of encrypting files so that only users who know the
password can view them. The user who creates the files and those who view them use the

same password.

The password is *****

‘ Encrypted PDF

ol | il
PDF file creator PDF file viewer

Figure 52 Providing a password-protected PDF file
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In contrast, certificate protection is a method of encrypting files so that only the users who
have been certified with a certificate can view them. This method is used to encrypt the PDF

files, and employs a public key contained in the certificate of the digital ID provided by the viewer.
A digital ID is required to view the files.

Viewer's certificate

=

Encrypted PDF file

g e &
%a Digital ID
PDF file creator — PDF file viewer

Figure 53 Providing an encrypted PDF file intended for the viewer's digital ID

This is my digital ID certificate.

[y

The creator must prepare the digital ID for viewing to prevent the ID from being duplicated.
The viewer is then given the SHALO AUTH device with the digital ID stored in it.

In this way, the creator does not have to create a digital ID for each PDF file. By managing the
digital ID certificate, the creator can use the certificate and encrypt other PDF files for the

same viewer.

Here is the dongle for viewing PDF files

that is exclusively yours.

Certificate for the viewer ‘ Digital ID Encrypted PDF file

< AN .
= o ¢ = A
PDF file creator — PDF file viewer

Figure 54 Providing an encrypted PDF file together with the dongle for viewing prepared by the creator

Electronic signature

A viewer can know the facts below based on the electronic signature assigned to a PDF file

with a digital ID. The creator's digital ID certificate is required for this purpose.

® \Whether the file was actually created by the creator.

® Confirmation that the file has not been tampered with.

Signed PDF file

N Creator's certificate

-

PDF file viewer

|
O

& an

Digital ID

|«

PDF file creator

Figure 55 Validating the PDF file with the electronic signature
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1.2 Configuring Acrobat®

7.2.1 Registering the PKCS #11 module with Acrobat®

105

Before using SHALO AUTH in Acrobat®, register SHALO AUTH's PKCS #11 module with

Acrobat®.

Notes for when using SHALO AUTH in Acrobat®

You can use SHALO AUTH even if you connect SHALO AUTH to the PC while

Acrobat® is running.

When you enter the user PIN for SHALO AUTH in Acrobat®, you do not have to

enter the PIN again until you log out explicitly or exit Acrobat®.

If you want to use SHALO AUTH in Acrobat® for Windows, you must disable the

protected mode.

Acrobat® may start using the general security key functionality of a SHALO AUTH
device connected to a PC arbitrarily, and from that point, other software cannot

use the functionality. If this happens, exit Acrobat®.

Do not disconnect SHALO AUTH while Acrobat® is running. This prevents you from
performing operations through SHALO AUTH even when you reconnect it.
If you see the "PKCS #11 error" in Acrobat® after disconnecting SHALO AUTH,

then exit Acrobat®.

PP Ooe

Registration procedure
To register the PKCS #11 module with Acrobat®, use the following procedure:

1. Windows: In the menu, click [Edit] > [Preferences...].
macOS: In the menu, click [Acrobat Reader] > [Preferences...] or [Acrobat Pro DC]
> [Preferences...].

2. Windows only: Click [Security (Enhanced)], and in the [Sandbox Protections] section,
clear the [Enable Protected Mode at startup] check box and restart Acrobat®.

3. Click [Signatures], and in the [ldentities & Trusted Certificates] section, click
[More...].

4.  Select [PKCS#11 Modules and Tokens] and click [Attach Module].
Select SHALO AUTH's PKCS #11 module file.

The following explains the procedure together with screenshots.
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Step 1
In Windows: In the menu, click [Edit] > [Preferences...].

In macOS: In the menu, click [Acrobat Reader] > [Preferences...] or [Acrobat Pro
DC] > [Preferences...].
The details of the first menu items depend on the application types.

Step 2 (Windows only)

Under Categories, click [Security (Enhanced)], and in the [Sandbox Protections] section,
check that the [Enable Protected Mode at startup] check box is cleared.

Preferences x

Categories: Sandbox Protections

Commenting ~ [J Enable Protected Mode at startup (Preview) Run in AppCentainer [ Create Protected Mode log file View log
Documents
Full Screen Protected View (@) Off
General

(O Files from potentially unsafe locations
Page Display

O Allfiles
Accessibility
Action Wizard Enhanced Security
Adobe Online Servi

oo Lnine Senvices [Z Enable Enhanced Securi [ Cross domain log file View
Catalog v e
Color Management
Content Editing Privileged Locations
Convert From PDF If your workflows are negatively impacted by security settings, use Privileged Locations to
Convert To PDF selectively trust files, folders, and hosts to bypass those security setting restrictions.
Email Accounts Privileged Locations allows you to werk securely while granting trust to items in your

Forms workflow.

Identity [] Automatically trust documents with valid certification
Internet
JavaScript [ Automatically trust sites from my Win OS security zones View Windows Trusted Sites
Language
Measuring (2D)
Measuring (D)
Measuring (Geo)
Multimedia & 2D
Multimedia (legacy)

Muktimedia Trust (legacy)
Reading

Reviewing

Search

Security

Security (Enhanced)
Signatures

Spelling

Tracker Add File Add Folder Path Add Host Remove
Trust Manager
Units & Guides

Updater v

What is Protected View? ~What is Enhanced Security? ~ What are Privileged Locations?

If the check box is selected, clear it. At this time, the window below will appear. Click [Yes],

exit and start Acrobat® again, and then perform step 1.

Adobe Acrobat

Disabling Protected Mode also disables Protected View and
! AppContainer. For changes to take effect, you need to
manually restart the application.

Are you sure you want to continue?

tes
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Step 3

Under Categories, click [Signatures], and in the [ldentities & Trusted Certificates] section,
click [More...].

Preferences X
Categories:
Digital Signatures

Documents ~
Full Screen Creation & Appearance
General Control ontions for sianat .

: - Control options for signature creation T
Page Displey - Set the appearance of signatures within a document
Accessibility
Action Wizard Verification
Adobe Online Services
Catalog « Control how and when signatures are verified o
Color Management
Content Editing
Convert From PDF Identities & Trusted Certificates
Convert To PDF
Email Accounts « Create and manage identities for signing r—

- Manage credentials used to trust documents

Forms
Identity
Internet Document Timestamping
JavaScript
Language - Configure timestamp server settings T

Measuring (2D)
Measuring (30)
Measuring (Geo)
Multimedia & 30
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

Security

Security (Enhanced)

.

Step 4

In the window shown in the following figure, select [PKCS#11 Modules and Tokens] and click
[Attach Module].

ﬁ Digital ID and Trusted Certificate Settings X
~ Incitalline: Attach Module | Detach Module (¥ Refresh

Roaming ID Accounts Module Manufacturer 10 Library Path

Digital ID Files

Windows Digital IDs

PPKCS#11 Modules and Tokens

Trusted Certificates

Manage PKCS#11 Modules

This is a list of loaded PKCS#11 modules. You can load addirional modules 1o
gain access to new cryptographic devices
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Step 5
Select SHALO AUTH's PKCS #11 module. Depending on your environment, select the following

file:

Windows (Acrobat 32-bit) C:\Users\user-name\shalo pkcs11\x86\slpkcsll-vc.dll
Windows (Acrobat 64-bit) C:\Users\user-name\shalo_pkcs11\x64\slpkcsll-vc.dll
macOS /usr/local/lib/libslpkcs11.dylib

When the file is loaded successfully, the module is registered with the list of modules as shown

in the following figure.

ﬁ Digital ID and Trusted Certificate Settings *
~ Digital IDs Attach Module  Detach Module ¥ Refresh
Roaming ID Accounts Medule Manufacturer ID Library Path
. § AXELL CORPORATION ChUsersiusernameshalo_pkes11'w86\slpkes11-vedll
Digital ID Files

Windows Digital IDs

Manage PKCS#11 Modules

This 1s a list of loaded PKCS#11 modules. You can load additional modules to
gain access to new cryptographic devices

[AXELL PKCS#11 library] is added to the level under [PKCS#11 Modules and Tokens].

ﬁ Digital ID and Trusted Certificate Settings x
v Digital IDs Change Password login logout e Refresh
Roaming ID Accounts Token Label Status
- § Foo's Token Logged out
Digital ID Files

Windows Digital IDs
~ PKC5#11 Modules and Tokens
> BELL PRCSE11T library;
Tusted Certficates Token Label: Foo's Token
Module Manufacturer ID: AXELL CORPORATION
Model: SHALO AUTH

Serial Number:

0 The level under [AXELL PKCS#11 library] displays device labels of SHALO
AUTH devices connected to the PC.
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71.2.2 Deregistering the PKCS #11 module from Acrobat®

To deregister the PKCS #11 module from Acrobat®, use the following procedure:

1.  Windows: In the menu, click [Edit] > [Preferences...].

macOS: In the menu, click [Acrobat Reader] > [Preferences...] or [Acrobat Pro DC]

> [Preferences...].

2. Click [Signatures], and in the [ldentities & Trusted Certificates] section, click
[More...].

3. Select [PKCS#11 Modules and Tokens] and select the module of SHALO AUTH from
the list.

4. Click [Detach Module].

The following explains the procedure together with screenshots.

Step 1
In Windows: In the menu, click [Edit] > [Preferences...].
In macOS: In the menu, click [Acrobat Reader] > [Preferences...] or [Acrobat Pro
DC] > [Preferences...].
The details of the first menu items depend on the application types.
Step 2
Under Categories, click [Signatures], and in the [ldentities & Trusted Certificates] section,
click [More...].
Preferences X

- Set the appearance of signatures within a document

Verification

- Cantrol how and when signatures are verified More.

Catalog

Color Management
Content Editing
Convert From PDF Identities & Trusted Certificates
Convert To PDF
Email Accounts « Create and manage identities for signin

- Manage credentials used to trust documents

More...

Internet Document Timestamping
JavaSeript
Language - Configure timestamp server settings More.
Mezsuring (2D)
Measuring (30)
Measuring (Gea)
Multimedia & 30
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

Security

Security (Enhanced)

EXTE—
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Step 3

In the window shown in the following figure, select [PKCS#11 Modules and Tokens], and
select the module of SHALO AUTH.

ﬁ Digital ID and Trusted Certificate Settings ot
~  Digital IDs Attach Module %> Refresh
Roaming ID Accounts Mrclule Manyfacturer 1D LihrangDath
. ) AXELL CORPORATION C\Users\username'shalo_pkes11\x88\slpkes11-ve.dil
Digital ID Files

Windows Digital IDs

B
Manage PKCS#11 Modules

This is a list of loaded PKCS#11 modules. You can load additional modules to
gain access to new cryptographic devices

Step 4

Click [Detach Module].

AH52126-UMO1E_04 SHALO AUTH User's Manual



Using SHALO AUTH in PDF files 111

1.3 Importing a digital ID from SHALO AUTH

Import a certificate in SHALO AUTH as a digital ID before using SHALO AUTH in Acrobat® for
the first time, or when changing a key in SHALO AUTH.

To do this, connect SHALO AUTH to the PC and use the following procedure in Acrobat®:

1. Windows: In the menu, click [Edit] > [Preferences...].
macOS: In the menu, click [Acrobat Reader] > [Preferences...] or [Acrobat Pro DC]
> [Preferences...].

2. Click [Signatures], and in the [ldentities & Trusted Certificates] section, click
[More...].
Click [Digital IDs] and check that the key information in SHALO AUTH has been loaded.
(If the key information has not been loaded) Click [PKCS#11 Modules and Tokens] >
[AXELL PKCS#11 library], and from the list of token labels, select the device label of
SHALO AUTH you use, and click [Login]. Then, enter the user PIN as a password.

The following explains the procedure together with screenshots.

Steps 1to 2
In Windows: In the menu, click [Edit] > [Preferences...].
In macOS: In the menu, click [Acrobat Reader] > [Preferences...] or [Acrobat Pro

DC] > [Preferences...].
The details of the first menu items depend on the application types.

In the Preferences window that appears, under Categories, click [Signatures], and in the

[Identities & Trusted Certificates] section, click [More...] as shown in the following figure.

Preferences X

Categories
Digital Signatures

Documents ~
Full Screen Creation & Appearance
General

Page Display - Control options for signature creation More.

- Set the appearance of signatures within a document

Accessibility
Action Wizard Verification
Adobe Online Services
Catalog - Control how and when signatures are verified Vo
Color Management
Content Editing

Convert From PDF Identities & Trusted Certificates
Convert To PDF
Email Accounts = Create and manage identities for signing

- Manage credentials used to trust documents

More...
Forms
Identity
Internet Document Timestamping
JavaScript
Language - Configure timestamp server settings More
Messuring (20)
Messuring (30)
Measuring (Gea)
Multimedia & 30
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

Security

Security (Enhanced)

Signatures
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Step 3

Click [Digital IDs] and check that the key information in SHALO AUTH has been loaded. The
certificates from SHALO AUTH are displayed as “PKCS#11 Cryptographic Token” in the
Storage Mechanism column.

ﬁ Digital ID and Trusted Certificate Settings x
e . al 7 S &2 Refresh @
Roaming ID Accounts MName lssuer Storage Mechanism Expires
X . localhost localhost Windows Certificate Store 2021.07.07 07:20:43 Z
Digital ID' Files
ECDSA sample key  ECDSAsample key  PKCS#11 Cryptographic Token  2025.09.27 15:19:00 2
Windows Digital [Ds RSA sample key R5A sample key PKCS#11 Cryptographic Token  2025.08.01 12:00:00 2
. Foo Bar Foo Bar PKCS#11 Cryptographic Token  2031.02.20 12:13:00 Z
b PKCS#11 Modules and Tokens
< >
~ AXELL PKCS#11 library
Foo's Token Manage My Digital IDs ~

Trusted Certificates This is a list of the digital IDs that are available for your use on this computer.

Digital IDs are private and should not be shared. They are used when vou create a
digital signature or when you decrvpt documents that are encrvpted for vou using
Ceartificate Security.

FEanh diqital TTY har Aisner maihls atifimata va-hint M icl £t

Step 4 (if the certificate has not been loaded)

Click [PKCS#11 Modules and Tokens] > [AXELL PKCS#11 library], and from the list of token
labels, select the device label of SHALO AUTH you use, and click [Login].

_} Digital ID and Trusted Certificate Settings x
w Digital IDs Change Password = Login e Refresh
Roaming ID Accounts Token Label Status
Foo's Token Logged out
Digital ID Files

Windows Digital IDs

~ PKCS211 Modules and Tokens

Trusted Certificates Token Label: Foo's Token
Module Manufacturer ID: AXELL CORPORATION
Model: SHALO AUTH
Serial Number:

In the following window, enter the user PIN.

Token Label: Foo's Token

Password:

Click the child element of [AXELL PKCS#11 library] and check if the key information has been
loaded properly.
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1.4 Giving the certificate of the digital ID to other people

If you want to provide the digital ID's certificate to other people, you must output the certificate

113

in Acrobat®-specific file format, not as an X.509 certificate.
To do this, connect SHALO AUTH to the PC and use the following procedure in Acrobat®:

1. Windows: In the menu, click [Edit] > [Preferences...].
macOS: In the menu, click [Acrobat Reader] > [Preferences...] or [Acrobat Pro DC]
> [Preferences...].

2. Click [Signatures], and in the [ldentities & Trusted Certificates] section, click
[More...].
Expand [PKCS#11 Modules and Tokens] and select the relevant SHALO AUTH device.
Select the certificate and click [Export].

Specify an export option and export the certificate.

The following explains the procedure together with screenshots.

Take care not to provide an ECDSA key certificate.
Users cannot view any PDF files encrypted by an ECDSA key through SHALO

AUTH.
Steps 1to 2
In Windows: In the menu, click [Edit] > [Preferences...].
In macOS: In the menu, click [Acrobat Reader] > [Preferences...] or [Acrobat Pro

DC] > [Preferences...].

The details of the first menu items depend on the application types.

In the Preferences window that appears, under Categories, click [Signatures], and in the

[Identities & Trusted Certificates] section, click [More...] as shown in the following figure.

AH52126-UMO1E_04 SHALO AUTH User's Manual



Using SHALO AUTH in PDF files 114

Preferences x

Categorics:

Digital Signatures
Documents -

Full Screen Creation & Appearance
General
« Control options for signature creation

- Set the appearance of signatures within a document

Page Display More...
Accessibility
Action Wizard Verification
Adobe Online Services
Catalog

Color Management
Content Editing
Convert From PDF Identities & Trusted Certificates
Convert To PDF
Email Accounts

= Control how and when signatures are verified More...

- Create and manage identities for signing
- Manage credentials used to trust documents

More...
Forms
Identity
Internet Document Timestamping
JavaScript
Language » Configure timestamp server settings
Measuring (2D}
Measuring (3D}
Measuring (Gec)
Multimedia & 3D
Multimedia (legacy)

More...

Multimedia Trust (legacy)
Reading

Reviewing

Search

Security

Security (Enhanced)
ETT

Steps 3and 4

In the window shown in the figure below, expand [PKCS#11 Modules and Tokens] and select
the device label of the relevant SHALO AUTH device. Select the certificate and click [Export].

[a Digital ID and Trusted Certificate Settings had
«  Digital IDs Ly - ¥ /> Export | [ Refresh @ Remove ID
Roaming ID Accounts Name Issuer Expires
- X ECD5A sample key ECD5A sample key 2025.09.27 15:19:00 £
Digital ID Files . - . - P, -
Refrsampiewey Rifrsampiewey 202500:01=12:00:002
Windows Digital IDs Foo Bar Foo Bar 2031.02.20 12:13:00 2 I

. PKC5#11 Modules and Tokens
~ AXELL PKCS211 library

Foo's Token Foo Bar ~
Foo Co., Ltd.
Issued by: Foo Bar
Foo Co.. Ltd.
Valid from: 2021/02/22 21:13:00 +09'00"
Valid to: 2031/02/20 21:13:00 +09'00" N

Trusted Certificates

You can also click [Digital IDs] and select a certificate from there.
When multiple SHALO AUTH devices are connected, you can find a certificate

easily by selecting it from the device labels.
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Step 5

In the window shown in the figure below, select an export option and click [Next]. Then,

proceed as instructed in each window.

Data Exchange File - Export Options X

You have chosen to export the following data:
My Certificate(s)

Certificates are exported to allow the recipients to validate signatures created
by you and te encrypt documents for you, Exporting your certificate does not
export your private key.

Export Options
Select whether you want to save the data to a file or share it via email:

(O Email the data te someone

(®) Save the data to a file

Mext Cancel
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1.5 Encrypting a PDF file with a digital ID

This section explains how to encrypt a PDF file through certificate protection. The digital ID's
certificate is needed for encrypting PDF files. You can specify more than one viewer for

encrypted PDF files, and can do this in the following two ways:

® Specify the viewers with the digital ID (SHALO AUTH digital ID) they own.
® Specify the viewers with the digital ID's certificate file.

The user PIN does not have to be entered even when the SHALO AUTH's digital
ID is specified.

Users cannot use SHALO AUTH to view any PDF files encrypted by an ECDSA
key.

Adobe® Acrobat® is needed in order to encrypt PDF files.

g Take care not to encrypt PDF files with an ECDSA key certificate.

Adobe® Acrobat® Reader® does not have the ability to encrypt PDF files.

To encrypt a PDF file, use the following procedure in Adobe® Acrobat®:

1. Open a PDF file.
In the menu, click [File] > [Properties...].
In the Document Properties window, open the [Security] tab, and from Security
Method, select [Certificate Security].

4. Select document components to encrypt and an encryption algorithm, and click [Next].
To enable the PDF file to be viewed through SHALO AUTH connected to the PC, select
a digital ID and click [OK]. Otherwise, click [Cancel] and click [Continue anyway].

6. When specifying viewers who have a digital ID certificate, click [Browse...] and select
the certificate file for the digital ID.
Click the viewer's digital ID and then click [Permissions...].
Configure the settings appropriately according to your operating policy, and click [OK].
Click [Next] and click [Finish].

10. Close Document Properties and save the PDF file.

You must grant appropriate permissions to viewers to encrypt PDF files.
A If inappropriate permissions are granted, they can generate PDF files that can

evade viewing restrictions.

The following explains the procedure together with screenshots.
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Steps 1to 2

Open the PDF file you want to encrypt, and in the menu, click [File] > [Properties...].

Step 3

In the Document Properties window, open the [Security] tab, and from Security Method, select

[Certificate Security] as shown in the following figure.

Document Properties X
Description Security Fonts  Initial View Custorn Advanced
Document Security

The document's Security Method restricts what can be done to the document. To remove
security restrictions, set the Security Method to No Security.

Security Method: | No Security Change Settings...

Can be Opened by: s

3 Show Details...
Certificate Security

|FOUBE B e WianEgEr DUCHENt Security

Document Restrictions Summary
Printing:  Allowed
Changing the Document:  Allowed
Document Assembly:  Allowed
Content Copying:  Allowed
Content Copying for Accessibility:  Allowed
Page Extraction:  Allowed
Commenting: Allowed
Filling of form fields:  Allowed
Signing:  Allowed

Creation of Template Pages:  Allowed

Step 4

Select document components to encrypt and an encryption algorithm, and click [Next].

Certificate Security Settings X

Steps

Enter general information for this Certificate Security policy. You must enter at least the

% General settings name to continue.

Select recipients
Summary (O Save these settings as a policy
(@ Discard these settings after applying

Policy name: max. 50 Characters

Description: max, 250 Characters

Select Document Components to Encrypt
@ Encrypt all document contents.
O Encrypt all document contents except metadata (Acrobat 6 and later compatible)
O Encrypt only file attachments (Acrobat 7 and later compatible)

& All contents of the document will be encrypted, and search engines
" will not be able to access the document's metadata,

Askfor recipients when applying this policy

Encryption Algorithm: | 256-bit AES (Compatible with Acrobat 9.0 and later) v
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Available digital IDs are displayed in the [My Digital IDs] section. To enable viewing of the

PDF file through SHALO AUTH connected to the PC, select a digital ID and click [OK].

Document Security - Digital ID Selection

been saved.

My Digital IDs

Issuer

Please select one of your digital IDs to encrypt the document. If you do not select your digital ID in this step, you will not be able to apen the document once it has

Sterage Mechanism
localhost
RSA sample key

Expires
Windows Certificate Store 2021.07.07 07:20:43 7
RSA sample key PKC5#11 Cryptegraphic Token 2025.08.01 12:00:00 2
Foo Bar Foo Bar PKC5#11 Cryptographic Token 2031.02.20 12:13:00 Z
ECDSA sample key ECDSA sample key PKCS#11 Cryptographic Token 2025.00.27 15:19:00Z
Add Digital ID Refresh
Digital ID Selection Persistence
(®) Ask me which digital ID to use next time
() Use this digital ID until | close the application
() Always use this digital ID

X

Otherwise, click [Cancel] and in the following window, click [Continue anyway].

Certificate Security Warning X

You are encrypting this document for a group of people using certificates. If you do

£ | % notselect one of your digital IDs, you may not be able to open the encrypted
document.

Select digital ID Continue anyway

Step 6

certificate file for the digital ID.

When specifying viewers who have a digital ID certificate, click [Browse...] and select the

Certificate Security Settings

Steps

General settings

Update the list of intended recipients for doc using this policy. You can.
restrictions for a recipient by selecting the recipient and clicking *Permissions".
% Select recipients
Summary Name Email
Foo Bar

Browse..

Remove

Details ..

Permissions

Select a recipient to review permission settings.

Cancel

Search ..

Permissions ...

< Back
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Step 7

Click the viewer's digital ID and then click [Permissions...].

Step 8

The window below will appear. Configure the settings appropriately according to your

operating policy, and click [OK].

Permission Settings X

Restrict printing and editing of the document and its security settings

Permissions
Printing Allowed: | None ~
Changes Allowed: | None ~

[[] Enable copying of text, images, and other content

Enable text access for screen reader devices for the visually impaired

e

Inappropriate permissions can lead to generation of data that evades viewing
restrictions.
For example, if printing is permitted, a user can create data that is not encrypted

by printing data to a virtual printer.

Step 9

Click [Next] to display the window below. Click [Finish].

Certificate Security Settings X

Steps

EadeT Please review this summary of the information entered for this policy. You must click Finish to save this information.

Select recipients
Policy Details
Summary
Name: <not available>
Description:  <not available>
Encrypted Components: ~ All document content

Type: User

Modification Date:  2022.02.01 15:52:58 <0900

Step 10

Close Document Properties and save the PDF file.
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1.6 Viewing an encrypted PDF file

You can view an encrypted PDF file by connecting SHALO AUTH to the PC and opening the

file in Acrobat®.

must let it stop using SHALO AUTH.
It can employ the FIDO2 security key functionality even when using SHALO

0 If other software is using SHALO AUTH's general security key functionality, you

AUTH's general security key functionality.

When Acrobat® is using SHALO AUTH, other software cannot use the device until
you exit Acrobat®. Before other software can use SHALO AUTH's general security

key functionality, you need to exit Acrobat®.

In general, either of the widows below will appear when you open an encrypted file. You will

see the PDF file's content once you have entered the user PIN in Acrobat®.

Digital ID Authentication >

Access to your digital ID is required to open an encrypted decument,

Digital ID: |. I=Chiyoda-ku, o=Foo Co,, Ltd,, cn=Foo Bar Show Certificate Details...

Passwaord: I

Ca n CEI

Figure 56 When a digital ID necessary for viewing is registered with Acrobat®

Acrobat Security

. Adigital ID was used to encrypt this document but no digital ID is present to
J_Iés decrypt it. Make sure your digital [D is properly installed or contact the document
author,

Figure 57 When a digital ID necessary for viewing is not registered with Acrobat®

In Figure 56, input the user PIN for SHALO AUTH in the password field, and click [OK]. If the

PIN authentication is successful and the file is decrypted properly, you can view the PDF file.

In Figure 57, Acrobat® does not have the digital ID needed for viewing the PDF file. See
Sections 7.2 and 7.3 to import the digital ID from SHALO AUTH into Acrobat®. Then open the
PDF file again.
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1.7 Signing a PDF file electronically with a digital ID

To sign a PDF file electronically through SHALO AUTH, use the procedure below.
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1. Open a PDF file in Acrobat®.

2. Select [Tools] and click [Certificates].

3. Click [Digitally Sign].

4. Specify the area for displaying the electronic signature in the PDF file by dragging it

with the mouse.

o1

Select a digital ID to use for signing the file.
Input the user PIN for SHALO AUTH (if you are prompted to do so). Then click [Sign].
Specify a file where the PDF file will be stored.

If other software is using SHALO AUTH's general security key functionality, you

0 must let it stop using SHALO AUTH.
It can employ the FIDO2 security key functionality even when using SHALO

AUTH's general security key functionality.

When Acrobat® is using SHALO AUTH, other software cannot use the device until
you exit Acrobat®. Before other software can use SHALO AUTH's general security

key functionality, you need to exit Acrobat®.

The following explains the procedure together with screenshots.

Step 2

As shown in the following figure, select [Tools] and click [Certificates].

Test.pdf - Adobe Acrobat Reader DC (64-bit) — [m} e
File Edit View Sign Window Help

Home | Tools Test.pdf x Try Acrobat Pro DC @ Sign In

Q Search tools
e bl T bl T bl ~

%

Certificates

(Gpen [
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Step 3
When Certificates appears instead of Tools as shown in the following figure, click [Digitally
Sign].
Test.pdf - Adobe Acrobat Reader DC (64-bit) — O x
File Edit View Sign Window Help
Home  Tools Test.pdf x @ Sign In
woe B Q T/ 0% v ees & EH O
Certificates éﬁDigitally Sign Time Stamp
A~
Step 4

Specify the area for displaying the electronic signature in the PDF file by dragging it with the
mouse.

Step 5

As shown in the figure below, the certificates stored in SHALO AUTH are listed. From the list,
select the digital ID to use for the signature and click [Continue].

Sign with a Digital ID X
Choose the Digital ID that you want to use for signing:
O @ ECDSA sample key (PKCS#11 device) View Details

® Issued by: ECDSA sample key, Expires: 2025.09.27

o @ Foo Bar (PKCS#11 device) View Details
ssues Y. FOO Dar, Cxpires: e,
® | d by: Foo Bar, Expi 2031.02.20

O @ RSA sample key (PKCS#11 device) View Details
R Issued by: RSA sample key, Expires: 2025.08.01

@ ( Configure New Digital ID ) ( Cancel )
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Step 6

If you are prompted to enter the PIN as shown in the figure below, enter the user PIN for
SHALO AUTH. Then click [Sign].

Sign as "Foo Bar" X

Appearance | Standard Text v
Digitally signed
by Foo Bar

FOO BarDate: 2022.02.01
17:05:17 +09'00'

0 Lock document after signing View Certificate Details

Review document content that may affect signing

Step 7

In the dialog box for saving the file that appears, specify a file where the electronically signed
PDF file is stored.
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Chapter 8

Using SHALO AUTH for SSH

authentication

An SSH client that supports PKCS #11 can authenticate users through SHALO AUTH. In
addition, even if software does not support PKCS #11, it can use SHALO AUTH to work with
an authentication agent that does support PKCS #11.

This chapter explains how to authenticate users through SHALO AUTH in OpenSSH and PuTTY,
which are typical examples of SSH software. It also explains how to use authentication agents
provided by such software.

Topics in this chapter

What is SSH?

Preparing SSH keys for use

Preparing the authentication agent for use (Windows — OpenSSH)
Preparing the authentication agent for use (Windows — PuTTY-CAC)
(mac0S)

Preparing the authentication agent for use (Linux)

Using SSH clients

Preparing the authentication agent for use

S Al A
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8.1 What is SSH?

Secure Shell (SSH) is a communication protocol for communicating securely with remote hosts.

Its two main uses are as follows:

® Tologinto remote hosts

® To transfer files

You can use SSH when an SSH server is running on the remote host. Run an SSH client on

the local PC, which connects to the SSH server on the remote host.

8.1.1 SSH clients

The following SSH applications are widely used:

® OpenSSH An SSH server and client typically used in major OSs
® PuTTY-CAC An SSH client for Windows that supports cryptographic tokens
® TeraTerm A terminal software program for Windows that supports various

control terminals

® WinSCP A file transfer software program for Windows that uses SSH

These software programs provide password-less user authentication through SHALO AUTH.
OpenSSH and PuTTY-CAC use SHALO AUTH via the PKCS #11 module. Tera Term and
WinSCP use SHALO AUTH indirectly with the help of the mechanism called an authentication
agent provided by other software.

Of the above four programs, OpenSSH and PuTTY-CAC provide an authentication agent. Tera
Term and WinSCP use PuTTY-CAC's authentication agent. This chapter explains these four
software programs.

Notes on OpenSSH

To use the ECDSA, use OpenSSH 8.0p1 or later.

To see the version, run ssh -V on the terminal.

For restrictions on OpenSSH in each environment, see Section 11.4.

4 2

Note on PuTTY-CAC

A Use PuTTY-CAC Release 0.70 Update 7 or later.
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Authentication agent

An authentication agent is a resident program with secret keys and cryptographic tokens that
is fully responsible for the authentication process. The following figure shows the relation

between the authentication agent and applications.

Resident program

App \ —
uthentication H PKCS #11

agent module
Figure 58 Use of SHALO AUTH via the authentication agent

App

The applications delegate the process to the authentication agent based on the secret keys or
cryptographic tokens. When the authentication agent is used, individual applications do not

have to have the secret keys or cryptographic tokens configured for them.

The authentication agent is also useful for cryptographic tokens. Because the
authentication agent keeps running, users do not have to reenter their user PIN

after entering it once.

Procedure for using the authentication agent
To enable the authentication agent to use SHALO AUTH, use the following procedure:

1. If the authentication agent is not running, start it.
2. Connect SHALO AUTH to the PC.
3. Load the PKCS #11 module into the authentication agent.

Any SSH clients that are run after the procedure above is done will authenticate users via the
resident authentication agent.

Before you disconnect SHALO AUTH from the PC, or if you want to use SHALO AUTH directly

in other applications, unload the PKCS #11 module from the authentication agent.

If you want the authentication agent to use SHALO AUTH again, reload the PKCS #11 module
into the agent.
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8.2 Preparing SSH keys for use

Users can be authenticated through SSH by having SSH keys at hand and:

® Registering the SSH private key with SHALO AUTH
® Registering the SSH public key with the remote host

8.2.1 Registering an SSH key with SHALO AUTH
Using SHALO Keyring, register the SSH key with SHALO AUTH. The following cryptography is
available for the SSH key:

® RSA: Key length 2,048 to 4,096 bits
® [ECDSA: P-256, P-384, and P-521

For how to generate the key with SHALO Keyring, see Section 4.3, and for how to register an
existing key with SHALO AUTH, see Section 4.4.

8.2.2 Registering the SSH public key with the remote host

Add the SSH public key in the ~/.ssh/authorized_keys file of the remote host. If the SSH public

key is stored in the key.pub file under the home directory, run the following command:

$ cat ~/key.pub >> ~/.ssh/authorized_keysd

You can get the SSH public key from SHALO AUTH.
For how to do this with SHALO Keyring, see Section 4.6. For how to do this

without SHALO Keyring, see Section 11.1.
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Preparing the authentication agent for use (Windows —

OpenSSH)

In Windows, OpenSSH's authentication agent, ssh-agent, is available in Git for Windows and
Cygwin. However, the Windows 10-standard OpenSSH authentication agent cannot use
SHALO AUTH.

Making the agent start automatically

Add the following statements to ~/.bashrc in individual environments so that ssh-agent will

start automatically when Git Bash or Cygwin is run.

Data added to ~/.bashrc

1 export SLPKCS11FILE=pkcslifile

2 ssh-add -1 > /dev/null 2>&1

3 if [ "$?" == 2 ] ; then

4 SSH_AGENT_FILE=~/.ssh-agent

5 test -f $SSH_AGENT_FILE && source $SSH_AGENT_FILE > /dev/null

6 ssh-add -1 > /dev/null 2>&1

7 if [ "$?" == 2 ] ; then

8 (umask 066; ssh-agent -P "/usr/lib/*,/usr/local/lib/*,$SLPKCS11FI
LE" > $SSH_AGENT_FILE)

9 source $SSH_AGENT_FILE > /dev/null

10 setx SSH_AUTH_SOCK "$SSH_AUTH_SOCK" > /dev/null

11 setx SSH_AGENT_PID "$SSH_AGENT_PID" > /dev/null

12 fi

13 fi

14

15 alias shalo-add='ssh-add -s $SLPKCS11FILE'

16 alias shalo-remove='ssh-add -e $SLPKCS11FILE'

pkcsliifile in the first line must have one of the paths to the PKCS #11 module listed in the

following table.

Environment File path to the PKCS #11 module

Git for Windows 64 bit = /c/Users/user-name/shalo_pkcs11/x64/slpkcs11-mingw64.dll
Git for Windows 32 bit | /c/Users/user-name/shalo_pkcs11/x86/slpkcs11-mingw32.dlI
Cygwin 64 bit /cygdrive/c/Users/user-name/shalo_pkcs11/x64/slpkcs11-mingw64.dll

Cygwin 32 bit /cygdrive/c/Users/user-name/shalo_pkcs11/x86/slpkcs11-mingw32.dll

The following table lists the paths to ~/.bashrc in Windows:

Environment File path in Windows

Git for Windows C:\Users\user-name\.bashrc

Cygwin Cyewin-installation-directorn\home\ user-name\.bashrc
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Registering or deregistering SHALO AUTH

The configuration in the previous subsection makes the following aliases available in Git Bash

or Cygwin:

shalo-add Loads the PKCS #11 module into ssh-agent.

shalo-remove Unloads the PKCS #11 module from ssh-agent.

Registering SHALO AUTH with the authentication agent

Connect SHALO AUTH to the PC and then run shalo-add:

$ shalo-add-
Enter passphrase for PKCS#11: Input the user PIN.4
Card added: /c/Users/user-name/shalo_pkcsll/x64/slpkcsll-mingw64.dll

Stopping the authentication agent from using SHALO AUTH

Run shalo-remove. This also applies to when you disconnect SHALO AUTH.

$ shalo-removed
Card removed: /c/Users/user-name/shalo_pkcs11/x64/slpkcsll-mingw64.d1l1
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Preparing the authentication agent for use (Windows — PuTTY-

CAC)

PuTTY-CAC's authentication agent, Pageant, is available in Windows.

8.4.1 How to start and stop

To start Pageant, run pageant.exe, one of the PuTTY-CAC files. You will not see any window
even when running pageant.exe. Instead, a tray icon is added to the notification area, as shown

in Figure 59.

A @

B

1:28 PM
]

AR o0

Figure 59 Tray icon for Pageant

Clicking the tray icon shows the context menu for Pageant.

MNew Session

Saved Sessions

View Keys & Certs
Add PuTTY Key
Add CAPI Cert
Add PKCS Cert

Autoload Certs
Remember Certs
Force PIN Caching
Cert Auth Prompting

Filter: Srnart Card Logon Certs
Filter: Mo Expired Certs

About

Exit

1:29 PM
]

AED 0 m

Figure 60 Context menu for Pageant

To exit Pageant, click [Exit] in this context menu.
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Registering keys

To register SHALO AUTH with Pageant, you need to register SSH keys held by SHALO AUTH
one by one. There is no way to register all the keys in SHALO AUTH at once.

To register a single SSH key, use the following procedure:

1. In the Pageant context menu, select [Add PKCS Cert].

2. In the file selection dialog box, select the PKCS #11 module of SHALO AUTH.
From the list of all the certificates held by SHALO AUTH, select one certificate you
want to register with Pageant.

In step 2, select a different PKCS #11 module depending on the 32-bit or 64-bit version of

PuTTY-CAC, as shown in the table below. Select a file to suit your environment.

Software File path to the PKCS #11 module
PuTTY-CAC 32-bit version C:\Users\user-name\shalo_pkcs11\x86\slpkcsil-vc.dll
PuTTY-CAC 64-bit version C:\Users\user-name\shalo_pkcs11\x64\slpkcsil-vc.dll

In step 3, you will see the certificate selection dialog box shown in the figure below (left).
Clicking [More choices] shows all the available key certificates, as shown below (right). Select

one key certificate from the list that you want to use for SSH authentication, and click [OK].

Windows Security X Windows Security X
PuTTY: Select Certificate for Authentication PuTTY: Select Certificate for Authentication
Please selact the certificate that you would like to use for Please select the certificate that you would like to use for
authentication to the remote system. authentication to the remote system.

= ECDSA sample key = ECDSA sample key
= o=

Issuer: ECDSA sample key Issuer: ECDSA sample key
Valid From: 9/28/2020 to 9/28/2025 Valid From: 9/28/2020 to 9/28/2025
Click here to view certificate properties Click here to view certificate properties
More choices More choices
ECDSA sample key
Ok Cancel Issuer: ECDSA sample key

Valid From: 9/28/2020 to 9/28/2025

RSA sample key
Issuer: RSA sample key

Valid From: 8/1/2020 to 8/1/2025

OK Cancel

Figure 61 Selecting a key in the certificate selection dialog box
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8.4.3 Viewing or removing registered keys

You can view the list of registered keys in the Pageant Key List window. To open the window,

click [View Keys & Certs] in the Pageant context menu.

Pageant Key List x
Od:61 74048 9:0de T 76 e Dmae Bbo 030 PECS Ch=R5 A sample key
VRGP T 3EE et el e Bichi T oo ied PECS Ch=ECDCS A sample key
< >
Add PuTT v Key Add CAF Cert Add PECS Cert Remowe
Copy To Clipboard

Figure 62 List of keys registered with Pageant

Removing a registered key

To remove a registered key, in the window above, select the key and click [Remove].

8.44 Enabling the agent to load keys automatically

You can allow Pageant to automatically load the PKCS #11 module and SSH keys registered
with Pageant at agent startup.

To enable this feature, in the Pageant context menu, select [Remember Certs] to add a check

mark to this item.
When using SHALO AUTH, it is convenient to enable this feature and use it as follows:

® Start Pageant after connecting SHALO AUTH to the PC.
® [Exit Pageant before disconnecting SHALO AUTH.

‘. If SHALO AUTH is not connected when you start Pageant, the keys that are
registered will be deregistered. In this case, reregister them.
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Preparing the authentication agent for use (macOS)

The OpenSSH authentication agent, ssh-agent, is available for macQOS.

The macOS-standard OpenSSH agent is configured to start ssh-agent
automatically when the ssh-add command is run.

A socket for ssh-agent is set up in the SSH_AUTH_SOCK environment variable by
launchd. We do not recommend that you stop the macOS-standard ssh-agent
service.

Adding aliases

Add definitions to the shell configuration file. The target configuration files are listed in the
following table.

Shell type ‘ Configuration file name

Bash (default shell in macOS 10.14 Mojave or eatlier) ~/.bashrc
Zsh (default shell in macOS 10.15 Catalina or later) ~/.zshrc

What is added to the configuration file

export SLPKCS11FILE=/usr/local/lib/libslpkcsll.dylib

1

2

3 alias shalo-add='ssh-add -s $SLPKCS11FILE'

4 | alias shalo-remove='ssh-add -e $SLPKCS11FILE'

This addition will make the following aliases available in the terminal:

shalo-add Loads the PKCS #11 module into ssh-agent.

shalo-remove Unloads the PKCS #11 module from ssh-agent.

Registering SHALO AUTH with the authentication agent

Connect SHALO AUTH to the Mac and then run shalo-add once:

$ shalo-add-
Enter passphrase for PKCS#11: Input the user PIN.a
Card added: /usr/local/lib/libslpkcsll.dylib

Stopping the authentication agent from using SHALO AUTH

Run shalo-remove. This also applies to when you disconnect SHALO AUTH.

$ shalo-removed
Card removed: /usr/local/lib/libslpkcs11.dylib
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8.6.1

8.6.2

Preparing the authentication agent for use (Linux)

The OpenSSH authentication agent, ssh-agent, is available for Linux.

Making the agent start automatically

Add the following statements to ~/.bashrc so that ssh-agent will start automatically and
properly when you log in to Linux.
Data added to ~/.bashrc
export SLPKCS11FILE=/usr/lib/libslpkcsll.so

1

2

3 ssh-add -1 > /dev/null 2>&1

4 if [ "$?" == 2 ] ; then

5 SSH_AGENT_FILE=~/.ssh-agent

6 test -f $SSH_AGENT_FILE && source $SSH_AGENT_FILE > /dev/null
7
8

ssh-add -1 > /dev/null 2>&1

9 if [ "$?" == 2 ] ; then

10 (umask 066; ssh-agent > $SSH_AGENT_FILE)
11 source $SSH_AGENT_FILE > /dev/null

12 fi

13 fi

14

15 alias shalo-add="ssh-add -s $SLPKCS11FILE'
16 alias shalo-remove='ssh-add -e $SLPKCS11FILE'

Registering or deregistering SHALO AUTH

The configuration in the previous subsection makes the following aliases available:

shalo-add Loads the PKCS #11 module into ssh-agent.

shalo-remove Unloads the PKCS #11 module from ssh-agent.

Registering SHALO AUTH with the authentication agent

Connect SHALO AUTH to the PC and then run shalo-add:

$ shalo-add<
Enter passphrase for PKCS#11: Input the user PIN.4
Card added: /usr/lib/libslpkcsll.so

Stopping the authentication agent from using SHALO AUTH

Run shalo-remove. This also applies to when you disconnect SHALO AUTH.

$ shalo-removed
Card removed: /usr/lib/libslpkcsll.so
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8.7 Using SSH clients

This section assumes that you have completed the following tasks described in Section 8.2:

® Register the SSH private key with SHALO AUTH.
® Register the SSH public key with the remote host.

8.7.1 Using ssh

ssh is a client program of OpenSSH. When ssh-agent is running, ssh automatically uses ssh-

agent to authenticate users. For how to use SHALO AUTH without ssh-agent, see Section 10.1.

To use ssh, run the following:

ssh user-name@host-name

The following shows an example of connecting to a remote host with the host name “hostname’

as a user which has the user name “username”:

$ ssh username@hostname
Welcome to Ubuntu 20.04.1 LTS (GNU/Linux 5.4.0-58-generic x86_64)

- omitted -
username@ubuntu:~$

Neither the user PIN nor password is necessary.
A prompt to enter the password implies that SHALO AUTH has not been registered
properly with ssh-agent, or that the SSH public key has not been registered

correctly with the remote host.

Warning upon the first connection

When you connect from the local PC to a remote host through ssh for the first time, ssh
displays the message below. The purpose of this is to warn about connections to unknown
remote hosts or spoofed host names, based on the public keys recorded by ssh, of remote

hosts the tool previously connected to.

The authenticity of host 'hostname (IP-address)' can't be established.
ECDSA key fingerprint is SHA256:remote-host-fingerprint.
Are you sure you want to continue connecting (yes/no/[fingerprint])?

If the fingerprint of the remote host is known, check if it is the same as the displayed one. If
you can be sure that the destination is authentic, type yes and press the Enter key. Then, ssh
will store this remote host and its fingerprint in the ~/.ssh/known_hosts file and start the user

authentication process.
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Using plink
plink is a command-line-based connectivity tool for PuTTY. When Pageant is running, plink
automatically uses Pageant to authenticate users.

To run plink, add the PuTTY-CAC directory to the PATH environment variable, or run the
following command in the PuTTY-CAC directory:

plink user-name@host-name

The following shows an example of connecting to a remote host with the host name “hostname’

as a user which has the user name “username” by employing plink in PowerShell:

PS C:\PuTTY-CAC>plink username@hostname
Using username "username".

If you have not entered the user PIN in Pageant, an authentication window for PuTTY will
appear as shown in the figure below. In [Password], enter the user PIN for SHALO AUTH and
click [OK].

PuTTY Authentication ? X

i

Flease Enter Your Smart Card Credentials

User name: «Using Smart Card

Password: ||

Corcel

Figure 63 PuTTY authentication window

When the authentication is successful, the message below will appear. Pressing the Enter key

establishes a connection with the remote host.

Access granted. Press Return to begin session. &
Welcome to Ubuntu 20.04.1 LTS (GNU/Linux 5.4.0-58-generic x86_64)

- omitted -
username@ubuntu:~$
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Warning upon the first connection

When you connect from the local PC to a remote host through PUTTY for the first time, plink
displays the message below. The purpose of this is to warn about connections to unknown
remote hosts or spoofed host names, based on the public keys recorded by PuTTY, of remote

hosts the tool previously connected to.

WARNING - POTENTIAL SECURITY BREACH!

The server's host key does not match the one PuTTY has
cached in the registry. This means that either the
server administrator has changed the host key, or you
have actually connected to another computer pretending
to be the server.

The new ssh-ed25519 key fingerprint is:

ssh-ed25519 255 remote-host-specific-data

If you were expecting this change and trust the new key,
enter "y" to update PuTTY's cache and continue connecting.
If you want to carry on connecting but without updating
the cache, enter "n".

If you want to abandon the connection completely, press
Return to cancel. Pressing Return is the ONLY guaranteed
safe choice.

Update cached key? (y/n, Return cancels connection)

If the fingerprint of the remote host is known, check if it is the same as the displayed one. If
you can be sure that the destination is authentic, type y and press the Enter key. Then, plink
will store this remote host and its fingerprint in the registry and start the user authentication

process.
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8.7.3 Using putty

putty is a GUl-based connectivity tool for PuTTY. When Pageant is running, putty
automatically uses Pageant to authenticate users. This subsection explains how to use putty

to make an SSH connection in three steps. The description is based on PuTTY Release 0.74.

First, in the window below that appears when putty starts, type the name of the host to
connect to in [Host Name], and click [Open]. As an example here, a connection is established

to a remote host with the host name “hostname” as a user which has the user name “username.”

%, PuTTY Configuration

Category
[=]-- Se=sion Bazic options for your PUTTY session
L.Dgging Specify the destination you want to connect to

=-Te rrznal 4 Host Mame (or IP address) Part
EI: ;‘;huar | hostname| | o0 |
_Features Connection type:

. Window (L Raw () Telnet (JRlogin @ S5H () Serial
. Appe aran ce Load, zave or delete o stored session
?_Eha:mtf'lr Saved Sessions
... Translation

[+]- Felection | |

... Cholours Cefault Settings Load

=- Connection
... Data Sawve
:rll:'}q'rt Crele te
.. Telne
... Rlogin

[+ F5H
L Serial Close window on ext:
() Always () Mavear () Only on clean ext

Figure 64 Entering the destination host in the PuTTY configuration window

A PuTTY terminal window will then appear, prompting you to enter the name of the login user

as shown in the figure below. At this time, input the user name and press the Enter key.

A prompt to enter the password in the terminal window implies that the key in
SHALO AUTH has not been registered properly with Pageant, or that the SSH
public key has not been registered correctly with the remote host.
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Finally, if you have not entered the user PIN in Pageant, an authentication window for PuTTY
will appear as shown in the figure below. In [Password], enter the user PIN for SHALO AUTH
and click [OK]. When successfully authenticated by the remote host, you will see a message
from the host in the PUuTTY terminal window.

PuTTY Authentication ? *
A A
Please Enter Your Smart Card Credentials
User name: <IJsing Smart Card = .
Password: | |
Cancel

Warning upon the first connection

When you connect from the local PC to a remote host through PuTTY for the first time, PuTTY
displays the message below. The purpose of this is to warn about connections to unknown
remote hosts or spoofed host names, based on the public keys recorded by PuTTY, of remote
hosts the tool previously connected to.

PuTTY Security Alert X

The server's host key is not cached in the registry. You
| have no guarantee that the server is the computer you
" think it s,

The server's ssh-ed2551% key fingerprint is:

5sh-ed25519 255

62:ad:bf:06:ed:0e:dT:a7: 3000 ¢ 2: d B T dd: 75

If you trust this host, hit Yes to add the key to

PuTTY's cache and carry on connecting.

If you want to carry on connecting just once, without

adding the key to the cache, hit Mo,

If you do not trust this host, hit Cancel to abandon the

connection.

Figure 65 Warning about the server you connected to through PuTTY for the first time

If the fingerprint of the remote host is known, check if it is the same as the displayed one. If
you can be sure that the destination is authentic, click [Yes]. Then, putty will store this remote

host and its fingerprint in the registry and start the user authentication process.
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Using Tera Term

With Pageant, Tera Term can authenticate users through SHALO AUTH. This subsection

explains how to use Tera Term to make an SSH connection in three steps. The description is

based on Tera Term version 4.105.

First, in the window shown in the figure below that appears when Tera Term starts, type the

name of the host to connect to in [Host], and click [OK]. As an example here, a connection is

established to a host with the host name “hostname” as a user which has the user name

“username.”

Tera Term: Mew connection

x

- |

@ TCP/IP Host: | hostname
[~] History
Service: () Telnet
(®) 55H
() Other
Serial

TCP port#:

S5H version: |§5H2

IP version: | AUTD

Help

Figure 66 Entering the destination in Tera Term

Next, in the SSH Authentication window in the figure below, select [Use Pageant to log in],

type the name of the login user in [User name], and click [OK].

S5H Authentication

Logging in to hostname

Authentication reguired.

User name: username

Remember password in memory
[ ]Forward agent
Authentication methods
(O Use plain password to log in
(") Use RSA/DSA/ECDSA/ED25519 key to login

Use rhosts to log in (SSH1)

(") Use keyboard-nteractive to log in

(®) Use Pageant to log in

Disconnect

Figure 67 SSH settings in Tera Term
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Finally, if you have not entered the user PIN in Pageant, an authentication window for PuTTY
will appear as shown in the figure below. In [Password], enter the user PIN for SHALO AUTH
and click [OK]. When successfully authenticated by the remote host, you will see a message

from the host in the Tera Term terminal window.

PuTTY Authentication ? *
r
o=
Please Enter Your Smart Card Credentials
User name: <IJsing Smart Card = b
Password: | |
Cancel

Warning upon the first connection

When you connect from the local PC to a remote host through Tera Term for the first time,
Tera Term will display the message below. The purpose of this is to warn about connections
to unknown remote hosts or spoofed host names, based on the public keys recorded by Tera

Term, of remote hosts the tool previously connected to.

SECURITY WARNIMG x

There is no entry for the server "hostname™ in your list of known hosts.
The machine you have contacted may be a hostile machine pretending
to be the server,

If you choose to add this machine to the known hosts list and continue,
then you will not receive this warning again.

The server's host key fingerprint is:
Fingerprint hash algorithm: (()MDS () SHA256

SHAZ56:kI¥r4qZy HjyausR Snk INKKIgdKCY fégy K Seay 2w

+——[ECDSA 256] —+ ]
| - |
| =18 |
| . oo |
le.=.0 .. |
| .Bo*oo. .S |
|..B.Oo.0o- . |
lo.o=t+=.. |
| .=oocoEo |
| .oB*oo |
+-———-[5HA356] ————— + 4

Add this machine and its key to the known hosts list

Figure 68 Warning about the server you connected to through Tera Term for the first time
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If the fingerprint of the remote host is known, check if it is the same as the displayed one. If
you can be sure that the destination is authentic, click [Continue]. Then, Tera Term will store

this remote host and its fingerprint in a file and start the user authentication process.

8.7.5 Using WinSCP

WinSCP is a file transfer software program over SCP/SFTP and uses SSH. With Pageant,
WinSCP can authenticate users through SHALO AUTH. The description is based on WinSCP
version 5.15.10.

WinSCP is configured to use Pageant by default. In the window below, type names only in
[Host name] and [User name], and click [Login]. As an example here, a connection is
established to a host with the host name “hostname” as a user which has the user name

“username.”
B Login - x
Ii" Mew Site Session
File protocol:
SFTP ~
Host name: Part number:
|hu:|s1:name | | 22 = |
User name: Password:
|username| | | |
Sawve |V Advanced... |V
Tools hd Manage ¥ Login |v Close Help

Figure 69 Entering the destination in WinSCP

If the PuTTY Authentication window appears, input the user PIN for SHALO AUTH in
[Password] and click [OK]. When successfully authenticated by the remote host, you will see

the home directory of the remote host in the WinSCP window.
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PuTTY Authentication ? *
2
D
Please Enter Your Smart Card Credentials
User name: <IJsing Smart Card = b
Password: | |
Cancel

Warning upon the first connection

When you connect from the local PC to a remote host through WinSCP for the first time,
WinSCP displays the message below. The purpose of this is to warn about connections to
unknown remote hosts or spoofed host names, based on the public keys recorded by WinSCP,

of remote hosts the tool previously connected to.

Warning ? W
/|\ Continue connecting to an unknown server and add its
“ " host key to a cache?

The server's host key was not found in the cache, You have no guarantee that
the server is the computer you think it is.

The server's Ed25519 key details are:
Algorithrm: ssh-ed25519 255
SHA-256:  joESSG0KtSEK QY i TzgkWIgF 1Y CLUtHTMNBFVEC CeTCOle=
MD5: 62:ad:bf:06:ed:0e:47:a7:30:04: c2:dB:c® T dd: T3

If you trust this host, press Yes, To connect without adding host key to the
cache, press Mo, To abandon the connection press Cancel,

Copy key fingerprints to dipboard

Yes |v MNo Cancel Help

Figure 70 Warning about the server you connected to through WinSCP for the first time
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Chapter 9

Using SHALO AUTH for SSH

authentication in Git

Gitis a distributed version control system that keeps track of, and manages, records of changes

to source code of programs. It uses the SSH protocol to communicate securely.

This chapter addresses GitHub as a Git platform and explains how to use SHALO AUTH for

SSH authentication to access GitHub from a Git client.
Topics in this chapter

Git and SSH authentication
Registering the SSH public key with GitHub
Testing SSH connections

Compatibility information of Git clients

ok b=

Configuring Git clients
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9.1 Git and SSH authentication

Git mainly uses the following two types of protocols for data transfer:

145

HTTP protocol Uses a user name and password for authentication.

SSH protocol Performs authentication with SSH keys.

In the HTTP (HTTPS) protocol, a repository is specified with https:// as follows:

https://server/user/project.git

In the SSH protocol, a repository is specified with ssh:// as follows:

ssh://user@server/project.git

Additionally in the SSH protocol, a repository can be specified in an abbreviated form like an

SCP command:

user@server:project.git

To use the SSH protocol

Specify a repository in the form of the SSH protocol when cloning a remote repository. SSH
authentication will always be used to transfer data between the cloned repository and the

remote repository.
Changing the HTTP protocol used for a repository to the SSH protocol

Using the feature of changing the remote URL of a repository, you can change the HTTP

protocol used for a repository to the SSH protocol.

To view the current remote URL, go to the repository in the terminal and run git remote -v.

In GitHub, you will see the following:

$ git remote -vd
origin https://github.com/user-name/repository.git (fetch)
origin https://github.com/user-name/repository.git (push)

To change the remote URL, use git remote set-url to specify a URL in the SSH protocol

format for origin:

git remote set-url origin git@github.com:user-name/repository.git

Note that in hosting servers other than GitHub, the path structure in the URL
differs from the one above.

AH52126-UMO1E_04 SHALO AUTH User's Manual



146

Using SHALO AUTH for SSH authentication in Git

9.2 Registering the SSH public key with GitHub

SHALO AUTH can use RSA, or P-256, P-384, or P-521 of ECDSA as SSH keys. Unlike the
regular way to register SSH public keys with SSH remote hosts, register the keys with GitHub

in a Web browser.

To do so, use the following procedure:

o kR W =

SSH keyl].

Open https://www.github.com in a Web browser and log in.

Click the profile image in the upper-right corner, and then click [Settings].
In the side bar on the left, click [SSH and GPG keys].

Click [New SSH Key].
Type the name of the key in [Title], enter the SSH key in [Key], and then click [Add

The following explains the procedure together with screenshots.

Steps 1to 2

Log in to GitHub. Then, click the profile image in the upper-right corner and select [Settings].

Explor
openssh
Portable

9c 3

nats-io/
JWT tok
Ed2551¢

®Go

lumen/1
An alter
designe

® Rust

Explore

Signed in as

@ Set status

Your profile

Your repositories
Your organizations
Your projects
Your stars

Your gists

Feature preview
Help
Settings

Sign out
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Step 3
In the side bar on the left, click [SSH and GPG keys].

‘ ’ Search or jump to...

Personal settings
Profile
Account
Account security
Billing & plans
Security log
Security & analysis
Emails
Notifications

Scheduled reminders

S5H and GPG keys

Repositories

Step 4
Click [New SSH Key].

SSH keys

There are no 55H keys associated with your account.

Check out cur guide to generating S5H keys or troubleshoot common 55H Problems.

Step 5

Type the name of the key in [Title], and enter the SSH public key in [Key]. Finally, click [Add
SSH key]. For details about SSH public keys, see Section 4.6.

SSH keys / Add new

Title
Type the name of the key
Key
Begins with 'ssh-rsa’, 'ssh-ed25519", 'ecdsa-sha2-nistp256’, ‘ecdsa-sha2-nistp384’, or ‘ecdsa-sha2-nistp521'

Enter the SSH public key

Add SSH key
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Testing SSH connections

You can test an SSH connection with GitHub by connecting to it with the following settings:

Host name github.com
User name git

Make sure that you perform an SSH connection test with GitHub described in
this section. Otherwise, your Git client will receive the warning when it connects
to the SSH server for the first time, and will not work correctly.

When ssh-agent is used as the authentication agent

Register SHALO AUTH with ssh-agent and then run the following command:

ssh -T git@github.com

When the client connects to GitHub for the first time with the ssh command, the following

messages are displayed:

The authenticity of host 'github.com (IP ADDRESS)' can't be established.
RSA key fingerprint is SHA256:nThbg6kXUpJWG17E1IGOCspRomTxdCARLViKW6E5SYS8.
Are you sure you want to continue connecting (yes/no/[fingerprint])?

This message asks you to verify the public key of the destination server in order to prevent
server spoofing. Check that the key matches the public key of GitHub, type yes, and then press
the Enter key.

https://docs.github.com/en/authentication/keeping-your-account-and-data-

0 GitHub's public keys are exposed at the following URL:

secure/githubs-ssh-key-fingerprints

Once you have been successfully authenticated, wser-name in the following message is

replaced with your GitHub account name, and the SSH connection is now established.

Hi user-name! You've successfully authenticated, but GitHub does not
provide shell access.

If SSH authentication fails, you will see the following message:

git@github.com: Permission denied (publickey).

In this case, see Section 11.5.9 as a reference and check the SSH public key registered with
GitHub and your SHALO AUTH environment.
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When Pageant is used as the authentication agent

Register SHALO AUTH with Pageant and then run the following command:

plink -T git@github.com

‘. You will not be able to see the messages below in putty, the GUI-based
connectivity tool, which closes the window quickly.

When the client connects to GitHub for the first time through plink, the following messages are

displayed:

The server's host key is not cached in the registry. You
have no guarantee that the server is the computer you
think it is.

The server's rsa2 key fingerprint is:

ssh-rsa 2048 16:27:ac:a5:76:28:2d:36:63:1b:56:4d:eb:df:a6:48
If you trust this host, enter "y" to add the key to
PuTTY's cache and carry on connecting.

If you want to carry on connecting just once, without
adding the key to the cache, enter "n".

If you do not trust this host, press Return to abandon the
connection.

Store key in cache? (y/n)

This message asks you to verify the public key of the destination server in order to prevent

server spoofing. In response, type y and press the Enter key.
plink does not present the public key of the server in SHA 256, so you will not be

GitHub URL:

u able to check that the key matches one of the public keys exposed in the following
https://docs.github.com/en/authentication/keeping-your-account-and-data-

secure/githubs-ssh-key-fingerprints

Once you have been successfully authenticated, wser-name in the following message is

replaced with your GitHub account name, and the SSH connection is now established.

Hi user-name! You've successfully authenticated, but GitHub does not
provide shell access.

If SSH authentication fails, you will see the following message:

FATAL ERROR: No supported authentication methods available (server sent:
publickey)

In this case, check the SSH public key registered with GitHub and your SHALO AUTH

environment.
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Compatibility information of Git clients

This section provides a matrix to show whether SHALO AUTH will work with major software
programs that have Git client functionality, in environments comprising a combination of

certain OSs and authentication agents.

The explanations in this subsection are based on the information correct at the

0 time of writing this manual.
It does not necessarily guarantee that these software programs will operate with

SHALO AUTH.

In these operating environments, the authentication agents described in Chapter 8 use SHALO
AUTH. In the following matrix, OpenSSH of Git for Windows is used in the Windows (ssh-agent)

column.

Software Windows Windows macOS Linux
(ssh-agent) (GEVCET) (ssh-agent) (ssh-agent)
git command 2.30.1 v v *l v v
GitHub Desktop 2.6.0 v v ¥l v —
GitKraken 7.4.1 N/A v 2 v 2 v 2
Sourcetree 3.3.9 N/A v *3 v —
TortoiseGit 2.11.0.0 v v — —
Visual Studio 2017 N/A N/A — —
Visual Studio 2019 v vl — —
Visual Studio 2019 for Mac — — v —
Visual Studio Code v vl v v
Xcode 12 — — N/A —
« Available

N/A Not available

—  Software does not support the OS

*1  Add the absolute path to plink.exe of PuTTY to the GIT_SSH environment variable (Subsection
9.5.1).

*2  In GitKraken, select [Preferences] > [SSH] and select the [Use local SSH agent] check box
(Subsection 9.5.2).

*3  In Sourcetree, select [Options] > [General] and clear the [Automatically start SSH agent
when Sourcetree opens] check box (Subsection 9.5.3).

When you use Pageant as the authentication agent, test the SSH connection with
GitHub using plink. When you use ssh-agent, test the SSH connection using ssh.
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9.5 Configuring Git clients

This section explains how to configure the software programs marked with *1 to *3 in Section

9.4. The Git clients with no asterisks do not require the configuration here.

9.5.1 GIT_SSH environment variable (only when Pageant is used in Windows)

The git command starts ssh internally. If the GIT_SSH environment variable is specified, the
command starts and uses the program designated there, instead of ssh. Therefore, if you
specify plink.exe in the GIT_SSH environment variable, you can use Pageant of PuTTY-CAC

for authentication in Git.
This subsection explains how to specify the GIT_SSH environment variable in three steps.

First, type “edit environment variables” in the Windows search box as shown in the following

figure, and click [Edit environment variables for your account].

All Apps Documents Web More = & X
Best match

B Edit environment variables for h
- your account _—

Control panel A
T Edit environment variables for your account
Control panel
L edit envi - See web results >
2 edit environment variables for your
> = Open
account P

£ edit environment variables >
L edit environment path >
£ edit environment for your account >
L edit envio >
L edit environments >
L edit environnement variable >

== /O editenvih:nnentvanablesfo*y:uraccou-‘t O ={} e :-| a ﬁ

Figure 71 Searching for "edit environment variables" via the search box
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Next, in the Environment Variables window, click [New...] under “User variables for your
account name.”

Environment Variables X

User variables for username

Variable Value
OneDrive ChUsers\usernamelOneDrive
Path Ch\Users\username\AppDataiLocal\Microsoft\WindowsApps;
TEMP CAUsers\usernametAppDataiLocal Temp
TMP ChUsers\usernametAppData\Local\Ternp
Mew.. Edit... Delete

Systern variables

Variable Value &

ComSpec CAWindows\system32\cmd.exe

DriverData CAWindowshSystem32\Drivers\DriverData

MUMBER_OF PROCESSORS 2

Qs Windows_NT

Path CAWindows\system32; CAWindows; C\Windows\System32\Whbem;...

PATHEXT .COM;.EXE; BAT..CMD:.WBS; VBE; J5;.J5E, \WSF: W5H; MS5C

PROCESSOR ARCHITECTURE  AMDE4 e
MNew... Edit... Delete

Figure 72 Adding an environment variable

Finally, type GIT_SSH in [Variable name], click [Browse File...], and select PuTTY-CAC's
plink.exe. Then click [OK].

Mew User Variable X
Variable name: | GIT_SSH |
Variable value: | Chputtycachplink.exe Absolute path to |

Browse Directory... Browse File... Cancel

Figure 73 Creating the GIT_SSH environment variable
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GitKraken

This subsection is based on GitKraken 7.4.1. Screen layouts and behavior may
0 vary in other versions of the program.

GitKraken can use Pageant in the Windows version, and can use ssh-agent in the macOS and

Linux versions. However, these authentication agents are disabled by default.
To allow GitKraken to use them, carry out the following procedure:

1. In the GitKraken menu, click [File] > [Preferences...].
2. In the window shown in the figure below, select [Preferences] > [SSH].
3. Select the [Use local SSH agent] check box.

The following figure shows where you configure the setting in the GitKraken window.

@ Gitkraken - [m] x
File Edit View Help
[ New Tab +
€) Exit Preferences
Current Profile
Use local SSH agent

Default Profile
SSH Private Key
General SSH Public Key
Profiles Generate new

Private/Public key
SSH

Integrations

Ul Customization

GPG

Editor

Figure 74 SSH setting in GitKraken
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Sourcetree (Windows only)

This subsection is based on Sourcetree 3.9.1. Screen layouts and behavior may
0 vary in other versions of the program.

Sourcetree for Windows provides PuTTY, which does not support PKCS #11, and starts
Pageant for that PuTTY version at startup. You need to prevent this built-in Pageant from

starting in Sourcetree for Windows.
To prevent Pageant from starting at startup of Sourcetree, use the following procedure:

1. In the Sourcetree menu, click [Tools] > [Options].
2. In the Options window in the figure below, select the [General] tab.
3. Clear the [Automatically start SSH agent when Sourcetree opens] check box.

The following figure shows where you configure the setting in Sourcetree.

9 Options
B | © ® | 9 [ ® ©
General Updates Diff Git Mercurial | Custom Actions | Authentication MNetwork

Allow Sourcetree to modify your global Git and Mercurial config files
Open links on Bitbucket.org with Sourcetree

Offer to create bookmarks in future

[] Enable 'Open in Sourcetree' context menu in Explorer

Theme: | Light e
Default user information

Full Mame: | Masayuki Tanemura

Email address: |tanemura@axell.co.jp

S5H Client Configuration

S5H Key:

S5H Client: | PuTTY / Plink_~ | (Git anly_Mercurial alwaus uses DM@WJ

[ Automatically start 55H agent when Sourcetree opens

Repo Settings
Project folder:

Language: | Automatic ~ | (Requires restart) Help translate Sourcetree!

Default text encoding: | utf-8 ~

Keep backups on destructive operations

Refresh autornatically when files change »

0K

Figure 75 SSH setting in Sourcetree
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Chapter 10

Tips for better use

This chapter gives information for making better use of SHALO AUTH.
Topics in this chapter

1. Using SHALO AUTH from OpenSSH without an authentication agent
2. Using SHALO AUTH in remote hosts accessed via SSH
3. Using SHALO AUTH in remote hosts accessed through Remote Desktop
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Using SHALO AUTH from OpenSSH without an authentication

agent

This section explains how to use SHALO AUTH in OpenSSH without any authentication agent.
Although this approach has a limitation that multiple ssh instances cannot use SHALO AUTH

at one time, it is useful in restricted environments where no authentication agent is allowed.
There are two ways to do this:

® Use the -I option of ssh.
® Register SHALO AUTH in the ssh configuration file (~/.ssh/config).

-I option of ssh

You can specify the PKCS #11 module with the -I option in the ssh command. The format for

this is as follows:

ssh -I pkcsiifile user-name@host-name

When you run the command, you will see the “Enter PIN for '/abe/-of-SHALO-AUTH"” message.
Then, input the SHALO AUTH user PIN and press the Enter key.

The example below shows the result of command execution. In this example, the SHALO AUTH
label is “Foo’s Token,” and a connection is established with the remote host with the host

name “hostname” as a user which has the user name “username.”

$ ssh -I pkcsliifile username@hostnamed
Enter PIN for 'Foo's Token': Input the user PIN4

Welcome to Ubuntu 20.04.1 LTS (GNU/Linux 5.4.0-52-generic x86_64)
- omitted -

From the following table, select and specify the path to the file to suit your environment for

pkesllfile.
Environment File path to the PKCS #11 module
Windows Gir for Windows 32 bit /c/Users/user-name/shalo_pkcs11/x86/slpkcsil
-mingw32.d11
Gir for Windows 64 bit /c/Users/user-name/shalo_pkcs11/x64/slpkcsil
-mingw64.d11l
Cygwin 32 bit /cygdrive/c/Users/user-name/shalo_pkcs11/x86
/slpkcsll-mingw32.d11
Cygwin 64 bit /cygdrive/c/Users/user-name/shalo_pkcs11l/x64
/slpkcsll-mingw64.d11
macOS /usr/local/lib/1libslpkcsil.dylib
Linux /usr/1ib/1ibslpkcsll.so

When SLPKCS11FILE is added to the shell configuration file as described in
Sections 8.3, 8.5, or 8.6, you can specify $SLPKCS11FILE for pkcsllifile.
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~/.ssh/config

~/.ssh/config is the configuration file for ssh. By specifying the -I option equivalent of ssh in
the configuration file, you can omit this option in the ssh command. However, you still have to

provide the user PIN when ssh is run

This approach allows you to use SHALO AUTH from the git command even when
no authentication agent is used. However, a repository that uses Git LFS is not
available. This also applies to GUI-based Git clients for which you cannot provide

the user PIN.

In ~/.ssh/config, configure the settings for each remote host the client connects to. The
minimum configuration for enabling the tool to use the PKCS #11 module is shown below.

Change the italicized strings according to your environment.

Host name
Hostname IP-address-or-remote-host-address
PKCS11Provider absolute-path-to-PKCS#11-module

From the following table, select and specify the absolute path to the PKCS#11 module to suit

your environment.

Environment File path to the PKCS #11 module
Windows Gir for Windows 32 bit /c/Users/user-name/shalo_pkcs11/x86/slpkcsil
-mingw32.d11
Gir for Windows 64 bit /c/Users/user-name/shalo_pkcs11/x64/slpkcsil
-mingw64.d11
Cygwin 32 bit /cygdrive/c/Users/user-name/shalo_pkcs11/x86
/slpkcsll-mingw32.d11
Cygwin 64 bit /cygdrive/c/Users/user-name/shalo_pkcsl11l/x64
/slpkcsll-mingw64.d11

macOS /usr/local/lib/libslpkcsil.dylib
Linux /usr/1ib/1ibslpkcsll.so
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10.2 Using SHALO AUTH in remote hosts accessed via SSH

When an SSH connection with a remote host is established through an authentication agent,
you can allow the remote host to use the authentication agent connected to the local PC. This

is called ssh agent forwarding.

118

Figure 76 Bringing the authentication agent on the local PC into the remote host

For this purpose, the remote host must be configured to allow ssh agent forwarding. SSH

clients ssh, plink, and putty all support this feature.

The local PC can still use SHALO AUTH while the remote host is still connected.

‘. The remote host accessed via SSH can only use the functionality provided by the

authentication agent. It cannot use the FIDO2 security key functionality.

Configuring the SSH server on the remote host

Modify the configuration file for the SSH server on the remote host. In the sshd_config

configuration file, enable AllowAgentForwarding as follows:

sshd_config

AllowAgentForwarding yes

Establishing a connection with ssh

To enable ssh agent forwarding in the ssh command, add the -A option:

ssh -A user-name@host-name

The following command shows an example of testing an SSH connection with a GitHub account

that uses a different SSH key to that of the remote host after the client connects to the host:
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$ ssh -A username@hostname
Welcome to Ubuntu 20.04.1 LTS (GNU/Linux 5.8.0-43-generic x86_64)

* Documentation: https://help.ubuntu.com
* Management: https://landscape.canonical.com
* Support: https://ubuntu.com/advantage

0@ updates can be installed immediately.
@ of these updates are security updates.

Your Hardware Enablement Stack (HWE) is supported until April 2025.

Last login: Mon Feb 22 19:06:07 2021 from 192.168.1.1

username@hostname:~$ ssh -T git@github.comd

Hi username! You've successfully authenticated, but GitHub does not provide
shell access.

Establishing a connection with plink

Similar to the ssh command, plink's -A option enables ssh agent forwarding.

plink -A user-name@host-name

Establishing a connection with putty

In putty, click [Connection] > [SSH] > [Auth] and select the [Allow agent forwarding] check

box, and then make a connection with the remote host.

#2 PuTTY Configuration ot
Category
.. Seszion Options controling 55H authentication
: (... Loeging
+ Terminal || Dizplay pre—authentication banner (SSH-2 only)
. Window L Bypazs suthentication entirely (SSH-2 only)
= Bonnection Authentication methods
... Data
Prosy L] Attempt authentication uzing Fageant
.mnmu || Attermpt TIS or CryptaCard auth (SSH-1)
. Rloein L] Attempt ~keybosrd—interactive” auth (S5H-2)
—-55H Authentication parameters
EE xt " L] Allow spent forwarding
... Hos
Cipher b LI Allow attempted changes ofusername in SSH-2
 Cartificate Priwate key file for authentication:
. Auth | Browse ..

L TTY

Al

.. Tunnels

...BuEs

... More bugs

... Serial

Figure 77 Enabling ssh agent forwarding in PuTTY
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Using SHALO AUTH passkeys on remote hosts accessed by

Remote Desktop

With Windows Remote Desktop, a remote PC accessed through Remote Desktop can use

passkeys of a FIDO2 security key that is connected to the local PC.

0 Passkeys and PKCS#11 features of SHALO AUTH can be used on the local PC

even while connecting to the remote PC.

This cannot be enabled at the same time as the method using PKCS#11 on a
remote PC access via Remote Desktop described in Section 10.4.

To do so, take the following steps when connecting.

1. Connect SHALO AUTH to the PC.

2. Launch the Remote Desktop app.

3. Click [Show Options].

4. Click the [Local Resources] tab, and then click [More...] under [Local devices and
resources].

5. Select the [WebAuthn (Windows Hello or security keys)] check box. If the [Other
supported RemoteFX USB devices] is listed, clear the [SHALO AUTH] check box.
Then click [OK].

6. Connect to a remote PC.
The following explains the procedure together with screenshots.
Steps 1to 3

In the Remote Desktop app window, click [Show Options].

B Remote Desktop Connecticn = >

Remote Desktop
~»¢) Connection

Computer: | Example: computer fabrikam.com e

Username: Mone specified

The computer name field iz blank . Enter a full remote computer
name.

l:, Show Options Help

Step 4

As shown the following figure, click the [Local Resources] tab, and then click [More...] under
[Local devices and resources].
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& Remote Desktop Connection

| Remote Desktop
“><) Connection

Remote audio

Keyboard
T

Example: ALT=TAB

Local devices and resources

#=0yj| yourremote session.

B Prirters

More...

[~ Hide Options

General Display Local Resources  Experence  Advanced

B Corfigure remote audio settings.

Apply Windows key combinations:

Only when using the full screen

/  Choose the devices and resources that you want to use in

Help

Step 5

Select the [WebAuthn (Windows Hello or security keys)] check box. If the [Other supported
RemoteFX USB devices] is listed, clear the [SHALO AUTH] check box. Then click [OK].

& Remote Desktop Connection

Local devices and resources

use in your remote session.

| Remote Desktop
“><) Connection

et

Choose the devices and resources on this computer that you want to

|_|Ports
[ Location
[C) Drives
[CVideo capture devices

M Smart cards ar Windaws Hella for Business

B WebAuthn (Windows Hello or security keys)

[CJCther supported Plug and Play (PnP) devices

Step 6

Connect to a remote PC.

Cancel
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Using SHALO AUTH PKCS#11 on remote hosts accessed by

Remote Desktop

With Windows Remote Desktop, a remote PC accessed through Remote Desktop can use an
USB device itself that is connected to the local accessing PC. This can be achieved using a

feature called RemoteFX USB redirection.

When SHALO AUTH is redirected to the remote PC accessed through Remote Desktop, the PC
can work with SHALO AUTH in the same way as a device disconnected from the local PC and
connected directly to the remote PC. The SHALO AUTH dedicated software and the PKCS #11

module must be installed in the remotely accessed PC.

N

Figure 78 Disconnecting SHALO AUTH from the local PC and connecting it to the remote PC

The local PC cannot use a SHALO AUTH device that has been redirected to the

remote PC accessed through Remote Desktop.

general security key functionality (PKCS #11) only. It cannot use the FIDO2

n In this method, the remote PC accessed through Remote Desktop can use the

security key functionality.

The requirements for using RemoteFX USB redirection are as follows:

Remote PC Windows 10 Pro or Windows 10 Enterprise
Local PC Windows 10 Pro or Windows 10 Enterprise

A The feature is not available in Windows 10 Home edition or macOS.

The rest of this section explains the environmental settings for local accessing and remotely
accessed PCs, followed by how to redirect SHALO AUTH.
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Configuring the remotely accessed PC

1.
2.

On the remotely accessed PC, use the following procedure:
Start the Local Group Policy Editor.

In the left pane, click and expand the following items:

[Computer Configuration] > [Administrative Templates] > [Windows Components]

> [Remote Desktop Services] > [Remote Desktop Session Host] > [Device and
Resource Redirection]

Double-click [Do not allow supported Plug and Play device redirection].
4,

Select the [Disabled] radio button and click [OK].
The following explains the procedure together with screenshots.

Step 1

Right-click the Start button (or press the Windows key+ X) and select [Run]. In the following
window, type gpedit.msc and click [OK].

=j

Type the name of a program, folder, document, or Internet
reseurce, and Windews will open it for you,

Open: | gpedit.msc|

Cancel Browse...

Step 2

The Local Group Policy Editor appears as shown in the figure below. In the left pane of the

window, click and expand the following items: [Computer Configuration] > [Administrative

Templates] > [Windows Components] > [Remote Desktop Services] > [Remote Desktop
Session Host] > [Device and Resource Redirection]

=/ Local Group Policy Editor

File Action View Help

- o x
&= |FHEE= HE

= Local Computer Policy
~ & Computer Configuration . . .

9 Software Settings Select an item to view its description,
| Windows Settings

=/ Local Computer Palicy

Name
| Administrative Templates

i Computer Configuration
~ %, User Configuration

i User Configuration
| Software Settings

| Windows Settings

| Administrative Templates

\ Extended /(Standard/

AH52126-UMO1E_04 SHALO AUTH User's Manual




Tips for better use 164

Step 3

In the window shown in the following figure, double-click [Do not allow supported Plug and
Play device redirection].

= Local Group Policy Editor — ] x
File Action View Help
e | @ = BE T

v || Remote Desktop Session Host || Setting "

Connections

- . I || Do not allow drive redirection
| Device and Resource Redirection

Do not allow LPT port redirection

Licensing

Do not allow supperted Plug and Play device redirection

Printer Redirection

Do not allow smart card device redirection

| Profiles = Allow i directi
| RD Connection Broker =] Allow time zone redirection v
| Remote Session Environment vl € >

< > Extended j, Standard /

11 setting(s)

Step 4

The window below will appear. Select the [Disabled] radio button and click [OK] here.

A Do not allow supported Plug and Play device redirection O bt

E‘ Do not allow supported Plug and Play device redirection Erims G Nexct Setting

(O Not Configured Comment:
() Enabled
@) Disabled
Supported on: [ at |east Windows Vista
Opticns: Help:

This palicy setting lets you control the redirection of supported | &
Plug and Play and RemoteFX USE devices, such as Windows
Pertable Devices, to the remote computer in a Remote Desktop
Services session,

By default, Remote Desktop Services does not allow redirection
of supported Plug and Play and RemoteFX USE devices,

If you disable this policy setting, users can redirect their
supported Plug and Play devices to the remote computer, Users
can use the More option on the Local Resources tab of Remote
Desktep Connection te choose the supported Plug and Play
devices to redirect to the remote computer.

If you enable this policy setting, users cannot redirect their
supported Plug and Play devices to the remote computer.|f you
do not configure this policy setting, users can redirect their
supported Plug and Play devices to the remote computer enly if
it is running Windows Server 2012 R2 and earlier versions.

Mote: You can disable redirection of specific types of supported

oK Cancel
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10.4.2  Configuring the local accessing PC
In the local accessing PC, use the following procedure:
1. Start the Local Group Policy Editor.
2. In the left pane, click and expand the following items:
[Computer Configuration] > [Administrative Templates] > [Windows Components]
> [Remote Desktop Services] > [Remote Desktop Connection Client] > [RemoteFX
USB Device Redirection]
3. Double-click [Allow RDP redirection of other supported RemoteFX USB devices
from this computer].
4. Select the [Enabled] radio button, select [Administrators and Users] under
RemoteFX USB Redirection Access Rights, and click [OK].
5. Restart Windows.
The following explains the procedure together with screenshots.
Step 1
Right-click the Start button (or press the Windows key + X) and select [Run]. In the following
window, type gpedit.msc and click [OK].
Run p4
=7 Typethe name of a program, folder, document, or Internet
= reseurce, and Windows will open it fer you.
Open: |gpedit.m5c| v
Cancel Browse...
Step 2

In the left pane of the window, click and expand the following items: [Computer
Configuration] > [Administrative Templates] > [Windows Components] > [Remote

Desktop Services] > [Remote Desktop Connection Client] > [RemoteFX USB Device
Redirection]

= Local Group Policy Editor
File Action View Help

= |FEE= HE

= Local Computer Policy

~ & Cemputer Configuration . . .
7 Software Settings Select an item to view its description.
| Windows Settings

| Local Computer Policy

Mame

i Computer Configuration
| Administrative Templates

i User Configuration
v ¢, User Configuration

| Software Settings
| Windows Settings

| Administrative Templates

\ Extended /(Standard/
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Step 3

The window will appear as shown in the figure below. Double-click [Allow RDP redirection of

other supported RemoteFX USB devices from this computer] here.

=[ Local Group Policy Editor — O X

File Action View Help
e n@ = BE T

w [ | Remote Desktop Connection Client  » Setting
| RemoteFX USB Device Redirection
~| Remote Desktop Session Host
| RS5 Feeds
| Search
| Security Center

| Shutdown Optiens

| Smart Card vl € >
< > Extended ), Standard /
1 setting(s)

Allow RDP redirection of other supported RemoteFX USB de...

Step 4

The window below will appear. In this window, select the [Enabled] radio button, select
[Administrators and Users] under RemoteFX USB Redirection Access Rights, and click [OK].

A Allow RDP redirection of other supported RemoteFX USB devices from this computer O x

Ei Allow RDP redirection of other supported RemoteFX USB devices from this computer

) Mot Configured Comment:
(@ Enabled
() Disabled
Supported on: [ at |east Windows T with Service Pack 1 or Windows Server 2008 R2 with Service
Pack 1
Cpticns: Help:

This pelicy setting allows you to permit RDP redirection of other

supported RemoteFX USE devices from this computer.

‘ Adminstrators and Users i Redirected RemoteFX USE devices will not be available for local
usage on this computer,

| RemoteFX USE Redirection Access Rights

If you enable this policy setting, you can choose to give the
ability to redirect other supported RemoteFX USE devices over
RDP te all users or enly to users who are in the Administrators
group on the computer,

If you disable or do not configure this policy setting, other
supported RemoteFX USE devices are not available for RDP

redirection by using any user account.

For this change to take effect, you must restart Windows.

e || oy

Step 5

Restart Windows.
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10.4.3  Configuring the connection

To connect a remote PC, use the following procedure:

1. Connect SHALO AUTH to the PC.

2. Launch the Remote Desktop app.

3. Click [Show Options].

4. Click the [Local Resources] tab, and then click [More...] under [Local devices and
resources].

5. Select the [SHALO AUTH] check box under [Other supported RemoteFX USB
devices], and then click [OK].

6. Connect to a remote PC.
The following explains the procedure together with screenshots.
Steps 1to 3

In the Remote Desktop app window, click [Show Options].

B Remote Desktop Connection — X

| Remote Desktop
"¢ Connection

Computer: | Example: computer fabrikam .com w

Username: Mone specified

The computer name field is blank . Enter a full remote computer
name.

(= Show Options Help

Step 4

As shown the following figure, click the [Local Resources] tab, and then click [More...] under
[Local devices and resources].
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| & Remote Desktop Connection - bt

| Remote Desktop
- ¢ Connection

General Display Local Resources  Experence  Advanced

Remote audio
B Corfigure remote audio settings.

..Settngs..

Keyboard
Apply Windows key combinations:

; Only when using the full screen w
Example: ALT=TAB
Local devices and resources

./ Choose the devices and resources that you want to use in
#=0yj| yourremote session.

B Prirters B Clipboard

More...

[~ Hide Options Help

Step 5

Select the [SHALO AUTH] check box under [Other supported RemoteFX USB devices], and
then click [OK].

& Remote Desktop Connection X

| Remote Desktop
“><) Connection

Local devices and resources

Choose the devices and resources on this computer that you want to
use in your remote session.

8 5mart cards or Windows Hello for Business
B WebAuthn (Windows Hello or security keys)
[JPorts
[ Location
[C) Drives
[CVideo capture devices
[CJCther supported Plug and Play (PnP) devices
= B Cther supported RemateFX USE devices
B SHALO AUTH

Cancel

Step 6

Connect to a remote PC.
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Chapter 11

Frequently asked questions

This chapter contains frequently asked questions and solutions to them related to the use of
SHALO AUTH.

Topics in this chapter

How can | load an SSH public key without using SHALO Keyring?

How can | create a key without using SHALO Keyring?

How can | import a key in .pfx, .p12, or DER format?

Which versions of OpenSSH have restrictions in terms of using SHALO AUTH?

o s LD

Troubleshooting by symptom
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11.1 How can | load an SSH public key without SHALO Keyring?

You can use OpenSSH to load an SSH public key from SHALO AUTH. This can be done in two

ways:

® Use the PKCS #11 module.

® Use an authentication agent.

When using the PKCS #11 module

Use the -D option in ssh-keygen to specify the file path to the PKCS #11 module:

ssh-keygen -D pkcslifile

The name of the PKCS #11 module depends on the environment. For the file name of the

module, see Chapter 3.

0 If the PKCS #11 module is used by a different application or registered with an
authentication agent, the ssh-keygen command fails.

In the following example, all the public keys in SHALO AUTH are printed, and then only the
public key for testkey?2 is stored in the key.pub file.

$ ssh-keygen -D $SLPKCS11FILE-

ecdsa-sha2-nistp256 AAAAE2VjZHNhLXNoYTItbmlzdHAyNTYAAAAIbmlzdHAYNTYAAABBBA
3/YCyF+KOni2K@nLT625u5teJ8hAubFhr+2LYkBGbADxcNQm4fgpHi+U4nqIddJ10V1+asi5u

I0BZAK6Ng+qI= testkeyl

ecdsa-sha2-nistp256 AAAAE2VjZHNhLXNoYTItbmlzdHAyNTYAAAAIbmlzdHAYNTYAAABBBF
8QnCuzFzd21yn3AEmfLbLjnIZLxd1Ndw9OF3GZyEK9XROEUL /m6FAY1WAWPNDbWVnOtoBj3DEE

zb1774UHuUBEg= testkey2

$ ssh-keygen -D $SLPKCS11FILE | grep testkey2 > key.pubd

When using an authentication agent

When SHALO AUTH is registered with an OpenSSH authentication agent using shalo-add, the
SSH public key managed by the authentication agent can be loaded through the ssh-add
command with the -L option:

$ ssh-add -L4

ecdsa-sha2-nistp256 AAAAE2VjZHNhLXNoYTItbmlzdHAyNTYAAAAIbmlzdHAYNTYAAABBBA
3/YCyF+KOni2KOnLT625u5teJ8hAubFhr+2LYkBGbADxcNQm4fgpHi+U4nqIddJ10V1+asi5u

IOBZAK6Ng+qI= testkeyl

ecdsa-sha2-nistp256 AAAAE2VjZHNhLXNoYTItbmlzdHAyNTYAAAAIbmlzdHAYNTYAAABBBF
8QnCuzFzd21lyn3AEmfLbLjnIZLxd1NdwOF3GZyEK9XROEUL /m6FAY1WAWPNDbWVnOtoBj3DEE

zb1774UHuUBEg= testkey2
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How can | create a key without using SHALO Keyring?

11.2.1

If you want to store a private key as a file, you need to create the key without using SHALO

Keyring. This section explains how to do it by using the following three software programs:

® OpenSSH

® PuTlTyY

® OpenSSL
Using OpenSSH

OpenSSH's ssh-keygen command enables you to create a pair of SSH private and public keys
that comply with RSA or ECDSA public key cryptography.

The following table lists and describes the main options of the ssh-keygen command.

Option Description

-t key-type Specify the type of key to create. The possible values are rsa or ecdsa.

-b bit-length In RSA, the bit length represents the key length. In ECDSA, it is the
number (256, 384, or 521) that follows letters P-, the elliptical curve
name.

-C comment Is a comment string for the SSH public key.

The following table shows the commands to create keys in each cryptography.

Key to create Command Note

RSA key ssh-keygen -t rsa -b length | Specify 2048 to 4096 for Length.

ECDSA key on P-256 ssh-keygen -t ecdsa -b 256

ECDSA key on P-384 ssh-keygen -t ecdsa -b 384

ECDSA key on P-521 ssh-keygen -t ecdsa -b 521

To create a key, use the following procedure:

1. Open a terminal program (In Windows, CMD, Git Bash, Cygwin, or other programs).

2. Specify options appropriate for the key you create, and run the ssh-keygen command.

3. When you see the “Enter file in which to save the key” message, specify the name of
the file for the key, and press the Enter key.

4.  When you see the “Enter passphrase” message, type the passphrase for encrypting
and protecting the key file, and press the Enter key.

5. When you see the “Enter same passphrase again” message, type the passphrase again

and press the Enter key.
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The passphrase is used to encrypt the private key file. Make sure to remember
the passphrase because you need to enter it again when importing the private
key into SHALO AUTH.

The next example shows how to create a 4,096-bit key pair in RSA. It uses “test_comment” as

a comment.

$ ssh-keygen -t rsa -b 4096 -C test_commentd

Generating public/private rsa key pair.

Enter file in which to save the key (/home/foo/.ssh/id_rsa): shalod
Enter passphrase (empty for no passphrase): 4

Enter same passphrase again: 4

Your identification has been saved in shalo.

Your public key has been saved in shalo.pub.

The key fingerprint is:

SHA256: ss3DIOVU54cW14Hp8eOw41r0zeOsyQrCT3vrodWvhz4 test comment

The key's randomart image is:

+---[RSA 4096]----+

| ... 0000 |

| o++. |
| 40. |
| .0.0 |
| .S |
| .B .o00.+ |
| 00*0 .0..0+|
| .+00++ E +|
| O+*4=+% |
+----[SHA256]----- +

The private key is stored in the file with the name you entered (“shalo” in the above example).
The public key is stored in the file with the name that has the string you typed, followed by

“.pub” (shalo.pub in the above example).

AH52126-UMO1E_04 SHALO AUTH User's Manual



11.2.2  Using PuTTY

Frequently asked questions

173

puttygen, which comes with PuTTY, enables you to create SSH keys using GUI operations. To

create a key, use the following procedure:

1
2.
3.
4

7.

The following explains the procedure together with screenshots.

Start puttygen.

Specify the key you want to generate.

Click [Generate].

Move the mouse cursor within the [PuTTY Key Generator] window until the progress

bar reaches the right-hand end.

In [Key comment], type a comment, and in each of [Key passphrase] and [Confirm

passphrase], input the passphrase.

Click [Save private key] to save the private key as a file.

Click [Save public key] to save the public key as a file.

Steps 1to 2

When you start puttygen, the window below will appear. If you want to generate an RSA key,
select the [RSA] radio button and enter the key length in the entry field at the bottom of the

window. If you want to generate an ECDSA key, select the [ECDSA] radio button.

& PuTTY Key Generator

File Key Conversions Help

ey
Mo by,

Actions
Generate a public/private key pair
Load an exdsting private key file

Sawve the generated key

Farameters

Type ol rey to generate:
W RS A (DS A

Mumber ofbits in @ generated ke

(_)ECDS A

Sawe public ke

() Ed25514

Generate

Load

Sawe private ke

() S5HA1 (REA)

2048

Key length

When you select the [ECDSA] radio button, you can select a curve name as shown in the figure
below. Of the curve names, [nistp256] means P-256, [nistp384] means P-384, and [nistp521]
means P-521.
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& PuTTY Key Generator

File Key Conversions Help

Ky
Mo kg,

Actions
Generate a public/private ke pair
Load an existing private key file

Save the generated key Sawe public key

Parameters

Type ofkey to generate:

(RS A ID5A () ECOS A () Ed25519
Curwe touse for generating this key

Generate
Load

Save private key

() 55H-1 (REA)
nistp256 -

Click [Generate].

Step 4

174

Curve name

Move the mouse cursor within the window until the progress bar reaches the right-hand end,

as shown below.

& PuTTY Key Generator

File Key Conversions Help

Fey

Flease generate some randomness by moving the mouse ower the blank area.

Actions
Generate a publics/private key pair
Load an exdsting private key file

Save the generated key Sawe public ke

Farameters

Type ofkey to generate:
RS A D5 A ECDE A Ed25513

Curve tousze for generating this key

Generate
Load

Sawe private ley

SEH-1 (RS A)
nistp266 e
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When the keys are generated, they are displayed in the window, as shown below. In [Key

comment], type a comment, and in each of [Key passphrase] and [Confirm passphrase],

input the passphrase.

The passphrase is used to encrypt the private key file. Make sure to remember
the passphrase because you need to enter it again when importing the private

key into SHALO AUTH.

& PuTTY Key Generator

File Key Conversions Help
ey

Fublic key for pasting into OpenS5H authorized ke ys file:

ecdsg—sha?—nistp266

CAyida SHEIGPr:x

A AR WIZHME LMo T bmlzdH Ay T A8 AlbmilzdH Ay T AAABEEARTEEC W] JO 1y

+CAbG X2 ZRITARKD X0 Arnuklow ket WIGTIecmTIbe FTUSEAS 2 TL AdwBo= ecdsa—

key—2021 0223
ey fingerprint: |ecdsa—sh a?—nistp2?66 266 11:d3:00:2 00082 b bioab0: T de T4 :3:|
Key comment: |ecdsa—ke y-20210223
Key passphrase: |

Con firm passphrase: |

Actions
Generate a public/private key pair
Load an exdsting private key file

Sawve the generated key

Farameters

Type ofkey to generate:
(RS A (DS A

Curwe to use for generating this key

Sawe public ke

(W) ECDS A () Ed25514

Generate
Load

Sawe private ke

() S5HA1 (RSA)

nistp2 66

st

Step 6

Click [Save private key] to save the private key as a file.

Step 7

Click [Save public key] to save the public key as a file.

The public key is also displayed in the edit field at the top of the window. You
can copy it for use.

Public key

Comment

Passphrase
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Using OpenSSL

OpenSSL enables you to create a variety of key pairs of private and public keys in addition to

the SSH key pairs. The keys are output in PEM format.

In RSA

Create an RSA key by using the openssl genrsa command. The format is as follows:

openssl genrsa -out output-file key-bit-Llength

The following shows an example of creating a key with a key length of 4,096 bits and storing it

in the rsakey.pem file:

$ openssl genrsa -out rsakey.pem 4096
Generating RSA private key, 4096 bit long modulus (2 primes)

e is 65537 (0x010001)

In ECDSA

Create an ECDSA key by using the openssl ecparam command. The format is as follows:

openssl ecparam -genkey -name curve-name -out output-file

You can see the names of curves supported by OpenSSL by using the command below. Some

environments support only some of the curves.

openssl ecparam -1list_curves

The following curves supported by SHALO AUTH have different names in OpenSSL:

® secpl92rl (P-192) prime192vi
® secp256rl (P-256) prime256v1

The following shows an example of creating a key on secp256rl (P-256) and storing it in the

eckey.pem file:

$ openssl ecparam -genkey -name prime256vl -out eckey.pemd
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11.3 How can | import a key in .pfx, .p12, or DER format?

SHALO Keyring does not support keys in PKCS #12 format (with the extension of pfx or p12)
or in DER format. By converting them into PEM format with OpenSSL, you can import them
through SHALO Keyring.

This section explains how to convert keys into PEM format using OpenSSL.

pfx or p12 format

To store a private key in PEM format, use the command below. If you do not encrypt the PEM

file, specify the additional -nodes option.

openssl pkcsl2 -in input-file -nocerts -out output-file

To save the private key in the server.pfx file as key.pem, do the following:

$ openssl pkcs12 -in server.pfx -nocerts -out key.pemd

Enter Import Password: Type the password for the input filed

Enter PEM pass phrase: Type the password for the output filed
Verifying - Enter PEM pass phrase: Confirm the password for the output
filed

RSA private key in DER format

To convert an RSA private key from DER format into PEM format, use the following command:

openssl rsa -inform DER -in 1input-file -outform PEM -out output-file

ECDSA private key in DER format

To convert an ECDSA private key from DER format into PEM format, use the following

command:

openssl ecparam -inform DER -in 1input-file -outform PEM -out output-file
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Which versions of OpenSSH have limitations on the use of

SHALO AUTH?

You can check the configuration of OpenSSH by using the following command:

$ ssh -va
OpenSSH_8.5p1, OpenSSL 1.1.1k 25 Mar 2021

This example shows that the version of OpenSSH is 8.5p1 and the cryptography library being
used is OpenSSL 1.1.1k.

The following table lists the OpenSSH configurations in which the RSA and ECDSA keys in
SHALO AUTH are available.

OpenSSH configuration RSA key ECDSA key
OpenSSH 5.2p1 or earlier N/A N/A
OpenSSH 5.3p1-0OpenSSH 7.9p1 v N/A
OpenSSH 8.0p1 or later + OpenSSH 1.0 v N/A
OpenSSH 8.0pl or later + OpenSSH 1.1 v v
OpenSSH 8.0p1 or later + LibreSSL 2.9 or earlier v N/A
OpenSSH 8.0p1 or later + LibreSSL 3.0 or later v v

0 OpenSSH supports ECDSA keys only on P-256, P-384, and P-521.

OpenSSH version for each environment

The table below lists the standard versions of the OpenSSH package in each environment. The

ECDSA keys of SHALO AUTH are unavailable in the environments whose background is orange.

Environment Configuration (result output by ssh -V)

Git for Windows 2.21.0 or Combination of OpenSSH_7.9p1 and OpenSSL 1.1.1a or earlier

earlier

Git for Windows 2.22.0 or later | Combination of OpenSSH_8.0p1 and OpenSSL 1.1.1c or later

Git for Windows 2.31.1 OpenSSH_8.5p1, OpenSSL 1.1.1k 25 Mar 2021

Cygwin 3.2.0 OpenSSH_8.5p1, OpenSSL 1.1.1f 31 Mar 2020

macOS BigSur OpenSSH_8.1p1, LibreSSL 2.7.3

Ubuntu 18.04.5 LTS OpenSSH_7.6p1 Ubuntu-4ubuntu0.3, OpenSSL 1.0.2n 7 Dec
2017

Ubuntu 20.04.2 LTS OpenSSH_8.2p1 Ubuntu-4ubuntu0.2, OpenSSL 1.1.1f 31 Mar
2020

CentOS 7.9-2009 OpenSSH_7.4p1, OpenSSL 1.0.2k-fips 26 Jan 2017

CentOS 8.3.2011 OpenSSH_8.0p1, OpenSSL 1.1.1g FIPS 21 Apr 2020

Fedora 33-1.2 OpenSSH_8.4p1, OpenSSL 1.1.1g FIPS 21 Apr 2020

Fedora 34-1.2 OpenSSH_8.5p1, OpenSSL 1.1.1k FIPS 25 Mar 2021
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115.1

11.5.2

11.5.3

Troubleshooting by symptom

User PIN is locked

A user PIN is locked when five consecutive entry attempts fail. When this happens, use SHALO
Smith to reset the user PIN (Section 5.4).

SO PIN is locked

A SO PIN is locked when five consecutive entry attempts fail. There is no way to restore the
SO PIN only.

The keys in SHALO AUTH are not removed even if the SO PIN is locked.
You can still use the keys unless the user PIN is locked.

To restore the SO PIN, restore SHALO AUTH to the factory settings (Section 5.3) and set it up

again.

When you restore SHALO AUTH to the factory settings, all the data held by
SHALO AUTH is removed and the settings as the FIDO2 security key previously

registered are also disabled.

LED keeps flashing when SHALO AUTH is connected to PC

When SHALO AUTH detects an unrecoverable error, its LED keeps flashing one to three times
per second. Such a SHALO AUTH device is no longer available. Use the following procedure to

dispose of the authentication information:

® In Web services that use SHALO AUTH as a FIDO2 security key, deregister SHALO
AUTH.
® |fthe public key in SHALO AUTH is registered with the sever, remove it from the server.
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shaloKeyring.appimage/shaloSmith.appimage does not start in Linux (1)

Symptom

When you tried to start shaloKeyring.appimage or shaloSmith.appimage from the Linux GUI,
the following window appeared.

® Could Not Display “shaloKeyring.appimage”

There is no application installed for “AppImage application
bundle” files. Do you want to search for an application to open this
file?

Cancel Searchin Software

Cause
There is no permission to execute the .appimage file.
Solution

Grant the execute permission to the .appimage file. Right-click the .appimage file in question.
From the context menu, select [Properties], and in the following window, select the [Allow
executing file as program] check box.

shalokeyring.appimage Properties X

Permissions
Owner: Me
Access: Read and write -
Group: username v
Access: Read and write -
Others
Access: Read-only -
Execute: Allow executing file as program
Security context: unknown
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shaloKeyring.appimage/shaloSmith.appimage does not start in Linux (2)

Symptom

When you tried to start shaloKeyring.appimage or shaloSmith.appimage, the window did not

appear.
Cause

The environment does not meet the prerequisites.
Solution

shaloKeyring.appimage and shaloSmith.appimage launched from the terminal output error
messages to the terminal when errors occur. The error messages can be used to determine

the cause of the problem.

An example would be as follows:

$ ./shaloKeyring.appimaged

dlopen(): error loading libfuse.so.2

AppImages require FUSE to run.

You might still be able to extract the contents of this AppImage
if you run it with the --appimage-extract option.

See https://github.com/AppImage/AppImageKit/wiki/FUSE

for more information

In the above example, the application requires libfuse2, which is solved by installing libfuse?2,

see Section 3.5.2.

SHALO Keyring/Smith does not recognize SHALO AUTH

Symptom
Even though SHALO AUTH is connected to the PC, SHALO Keyring/Smith cannot find the

device.

Cause

SHALO Keyring/Smith tried to access SHALO AUTH, but other software was using it.
Solution

Make sure that multiple software programs are not using one SHALO AUTH device at one time.
The following software uses SHALO AUTH:

1. Authentication agent
2. SHALO Keyring/Smith
3. Adobe® Acrobat®/Adobe® Acrobat® Reader® (when it accesses SHALO AUTH)

Make sure that both SHALO Keyring and SHALO Smith are not running at the same time.
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11.5.7 ssh -I command fails with “C_GetTokenInfo ~ failed: ??”

Symptom

You tried to connect to an SSH server with the PKCS#11 module specified in ssh -I, but the

command failed as shown below:

$ ssh -I pkcslifile username@hostname <
C_GetTokenInfo for provider pkcsiifile slot © failed: 48
username@hostname: Permission denied (publickey).

Cause
The PKCS#11 module tried to access SHALO AUTH, but other software was using it.
Solution

Make sure that multiple software programs are not using one SHALO AUTH device at one time.
The following software uses SHALO AUTH:

4. Authentication agent
5. SHALO Keyring/Smith
6. Adobe® Acrobat®/Adobe® Acrobat® Reader® (when it accesses SHALO AUTH)
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ssh -I command results in “C_GetAttributeValue failed: 18” message

Symptom

You tried to connect to an SSH server with the PKCS#11 module specified in ssh -I, but the

following message was output:

$ ssh -I pkcslifile username@hostname <
C_GetAttributeValue failed: 18
username@hostname: Permission denied (publickey).

Cause

The “C_GetAttributeValue failed: 18” message is output when OpenSSH detects a key that is

not supported. It may be output even if a connection to an SSH server is successful.
Solution

If a connection to an SSH server fails with this message output, use a key supported by

OpenSSH in your environment. For the key types supported by OpenSSH, see Section 11.4.

Unable to log in to an SSH server through ssh-agent

Symptom

You registered SHALO AUTH with ssh-agent by using shalo-add, but attempts to connect to

the SSH server failed as shown below:

$ ssh username@hostname 4
username@hostname: Permission denied (publickey).

Cause

The public key registered with the SSH server is not loaded into ssh-agent. You can view the

public keys loaded into ssh-agent by using ssh-add -L.

$ ssh-add -L4

ecdsa-sha2-nistp256 AAAAE2VjZHNhLXNoYTItbmlzdHAYNTYAAAAIbmlzdHAyYNTYAAABBBA
3/YCyF+KOni2K@nLT625u5teJ8hAubFhr+2LYkBGbADXcNQm4fgpHi+U4nqIddJ10V1+asi5u
I0BZAK6Ng+qI= testkeyl

Solution

If the target key in SHALO AUTH is not loaded into ssh-agent, check the key type with SHALO
Keyring to see if OpenSSH supports it. For the key types OpenSSH supports, see Section 11.4.

When the key is loaded correctly into ssh-agent, see if the public key is registered with the
SSH server.
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Unable to register SHALO AUTH with ssh-agent

Symptom

When running shalo-add and entering the user PIN, you received the message:

Could not add card "path-to-PKCS#11-Llibrary": agent refused operation

Cause

Possible causes are:

® The PKCS #11 module has already been registered.
® A different application is using the PKCS #11 module.
® The user PIN is not correct.
® The user PIN is locked.
® SHALO AUTH does not have the key, or the key stored in SHALO AUTH is not supported.
® The path to the PKCS #11 module is not permitted by ssh-agent.
Solution

To find the cause, use the following procedure:

4.

Run shalo-remove and then run shalo-add again.

Exit the applications that are using the PKCS #11 module. If the PKCS #11 module is
registered with Acrobat®, exit Acrobat®.

Using SHALO Keyring or SHALO Smith, check the state of SHALO AUTH (Section 4.2
and Section 5.1).

Using the ssh -I option, connect to the server and view the error output (Section 10.1).

If you still cannot find the cause, follow Chapter 3 to check if the PKCS #11 module has been

installed in the correct directory.

In OpenSSH 7.9p1 or later, you can output the operating states of ssh-agent to the console to

see the error information. Two terminals are required to do this.

At one terminal, start ssh-agent in debug mode as shown below. The operations are output to

this terminal when ssh-add is executed.

$ ssh-agent -d > ~/agenttmpd

At the other terminal, register SHALO AUTH as shown below:

$ source ~/agenttmp > /dev/nulld
$ ssh-add -v -s $SLPKCS11FILEA

If the PKCS #11 module is not on the whitelist, you will receive the following:
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refusing PKCS#11 add of "file-path-to-PKCS-#11-module": provider not white
listed

If SHALO AUTH cannot be found, “returned no slots” is displayed at the end. Most of the time,
this occurs because other software is using SHALO AUTH.

debugl: provider /usr/lib/libslpkcsll.so: manufacturerID <AXELL CORPORATIO
N> cryptokiVersion 2.40 libraryDescription <AXELL PKCS#11 library> library
Version 1.3

debugl: pkcsll register_provider: provider /usr/lib/libslpkcsll.so returne
d no slots

If no keys are found in SHALO AUTH, “returned no keys” is displayed at the end.

debugl: provider /usr/lib/libslpkcsll.so: manufacturerID <AXELL CORPORATIO
N> cryptokiVersion 2.40 libraryDescription <AXELL PKCS#11 library> library
Version 1.3

debugl: provider /usr/lib/libslpkcsll.so slot @: label <device-Llabel> manu
facturerID <AXELL CORPORATION> model <SHALO AUTH> serial <> flags ©x4ed
debugl: pkcsll provider_finalize: @x55fba2elddc® refcount 1 valid 1
debugl: pkcsll_provider_unref: @x55fba2elddc® refcount 1

debugl: pkcsll_add_provider: provider /usr/lib/libslpkcsll.so returned no
keys

If the error is related to the user PIN, “C_Login failed” is displayed along the way. This is

probably due to an incorrect or locked user PIN.

debugl: provider /usr/lib/libslpkcsll.so: manufacturerID <AXELL CORPORATIO
N> cryptokiVersion 2.40 libraryDescription <AXELL PKCS#11 library> library
Version 1.3

debugl: provider /usr/lib/libslpkcsll.so slot @: label <device-Llabel> manu
facturerID <AXELL CORPORATION> model <SHALO AUTH> serial <> flags ©x504ed
C_Login failed: 164

debugl: pkcsll_provider_finalize: Ox55fba2e@fcl@ refcount 1 valid 1
debugl: pkcsll_provider_unref: 0x55fba2e0fcl® refcount 1

debugl: pkcsll_add_provider: provider /usr/lib/libslpkcsll.so returned no
keys
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Chapter 12

PKCS #11 module information

This chapter provides various specifications of the PKCS #11 module for SHALO AUTH.
Topics in this chapter

1.  Supported API functions
2. Supported key types
3.  Supported mechanisms
4. Supported attributes
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Supported API functions

Key generation, key wrapping, and object copy features are not supported. The following table

lists the supported and unsupported API functions.

Supported API functions Unsupported API functions

C_Initialize
C_Finalize
C_Getlnfo
C_GetFunctionList
C_GetSlotList
C_GetSlotInfo
C_GetTokenlInfo
C_GetMechanismList
C_GetMechanismInfo
C_InitToken
C_InitPIN

C_SetPIN
C_OpenSession
C_CloseSession
C_CloseAllSessions
C_GetSessioniInfo
C_Login

C_Logout
C_CreateObject
C_DestroyObject
C_GetAttributeValue
C_SetAttributeValue
C_FindObjectslnit
C_FindObjects

C_FindObjectsFinal
C_Encryptlnit
C_Encrypt
C_EncryptUpdate
C_EncryptFinal
C_Decryptlnit
C_Decrypt
C_DecryptUpdate
C_DecryptFinal
C_Digestlnit
C_Digest
C_DigestUpdate
C_DigestFinal
C_Signlnit
C_Sign
C_SignUpdate
C_SignFinal
C_Verifylnit
C_Verify
C_VerifyUpdate
C_VerifyFinal
C_SeedRandom

C_GenerateRandom

C_GetOperationState
C_SetOperationState
C_CopyObject
C_GetObjectSize
C_DigestKey
C_SignRecoverlnit
C_SignRecover
C_VerifyRecoverlnit
C_VerifyRecover
C_DigestEncryptUpdate
C_DecryptDigestUpdate
C_SignEncryptUpdate
C_DecryptVerifyUpdate
C_GenerateKey
C_GenerateKeyPair
C_WrapKey
C_UnwrapKey
C_DeriveKey
C_GetFunctionStatus
C_CancelFunction
C_WaitForSlotEvent
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12.2 Supported key types

Key type Algorithm What is supported
CKK_RSA RSA RSA key of 1,024 to 4,096 bits
CKK_EC ECDSA Following elliptical curves:
secp192rl1 (P-192) secpl92kl
secp224rl (P-224) secp224kl
secp256rl (P-256) secp256kl
secp384rl (P-384)
secp521rl (P-521)

12.3 Supported mechanisms

Digesting mechanisms

CKM_SHA256 Supports both single- and multiple-part operations.
CKM_SHA384 Supports both single- and multiple-part operations.
CKM_SHA512 Supports both single- and multiple-part operations.

RSA mechanisms

Mechanism Op MinKey MaxKey Encrypt Decrypt Sign Verify
CKM_RSA_X_509 Single | 1024 4096 v v v v
CKM_RSA_PKCS Single = 1024 4096 v v v v
CKM_SHA1_RSA_PKCS Both 1024 4096 v v
CKM_SHA256_RSA_PKCS Both 1024 4096 v v
CKM_SHA384_RSA_PKCS Both 1024 4096 v v
CKM_SHA512 RSA_PKCS Both 1024 4096 v v
CKM_RSA_PKCS_OAEP Single = 1024 4096 v v
CKM_RSA_PKCS_PSS Single | 1024 4096 v vi
CKM_SHA1_RSA_PKCS_PSS Both 1024 4096 v vi
CKM_SHA256_RSA_PKCS_PSS @ Both 1024 4096 v vi
CKM_SHA384 RSA_PKCS_PSS @ Both 1024 4096 v vi
CKM_SHA512 RSA_PKCS_PSS @ Both 1024 4096 v vi

Op: Single supports the single-part operations only.
Op: Both supports both single- and multiple-part operations.
1: The key object should have the CKA_VERIFY and CKA_ENCRYPT attributes set to CK_TRUE.

The mgf member of the CK_RSA_PKCS_OAEP_PARAMS and CK_RSA_PKCS_PSS_PARAMS structures
can specify CKG_MGF1_SHA1, CKG_MGF1_SHA256, CKG_MGF1_SHA384, or CKG_MGF1_SHA512. The

hashAlg member is not affected by the mgf member and can freely specify the digest mechanism.
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Mechanism (0]} MinKey MaxKey Encrypt Decrypt Sign Verify
CKM_ECDSA Both 192 521 v
CKM_ECDSA_SHA1 Both 192 521 v v
CKM_ECDSA_SHA256 Both 192 521 v v
CKM_ECDSA_SHA384 Both 192 521 v v
CKM_ECDSA_SHA12 Both 192 521 v v

Op: Both supports both single- and multiple-part operations.
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12.4 Supported attributes

Attributes held by all objects

Attribute Default value Note

CKA_TOKEN False Supported by hardware functionality.
CKA_PRIVATE False Supported by hardware functionality.
CKA_MODIFIABLE True Supported by hardware functionality.
CKA_COPYABLE True C_CopyObject() is not supported.
CKA_DESTROYABLE True Supported by hardware functionality.

Additional attributes supported by RSA private key objects

Attribute Required Note

CKA_CLASS v CKO_PRIVATE_KEY at all times
CKA_KEY_TYPE v CKK_RSA at all times
CKA_LABEL

CKA_ID

CKA_ALLOWED_MECHANISMS
CKA_SUBIJECT

CKA_EXPONENT_1
CKA_EXPONENT_2
CKA_COEFFICIENT
CKA_SENSITIVE
CKA_DECRYPT
CKA_SIGN

Protected by CKA_SENSITIVE.
Protected by CKA_SENSITIVE.
Protected by CKA_SENSITIVE.

CKA_MODULUS v
CKA_PUBLIC_EXPONENT v
CKA_PRIVATE_EXPONENT v Protected by CKA_SENSITIVE.
CKA_PRIME_1 v Protected by CKA_SENSITIVE.
CKA_PRIME_2 v Protected by CKA_SENSITIVE.
v
v
v

Additional attributes supported by RSA public key objects

Attribute Required Note

CKA_CLASS v CKO_PUBLIC_KEY at all times
CKA_KEY_TYPE v CKK_RSA at all times
CKA_LABEL

CKA_ID

CKA_ALLOWED_MECHANISMS
CKA_SUBIJECT
CKA_MODULUS
CKA_PUBLIC_EXPONENT
CKA_ENCRYPT

CKA_VERIFY
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Additional attributes supported by EC private key objects

Attribute Required Note

CKA_CLASS v CKO_PRIVATE_KEY at all times
CKA_KEY_TYPE v CKK_EC at all times
CKA_LABEL

CKA_ID

CKA_ALLOWED_MECHANISMS
CKA_SUBIJECT

CKA_EC_PARAMS v

CKA_VALUE v Protected by CKA_SENSITIVE.
CKA_SENSITIVE

CKA_SIGN

Additional attributes supported by EC public key objects

Attribute Required Note

CKA_CLASS v CKO_PRIVATE_KEY at all times
CKA_KEY_TYPE v CKK_EC at all times
CKA_LABEL

CKA_ID

CKA_ALLOWED_MECHANISMS
CKA_SUBJECT

CKA_EC_PARAMS v
CKA_EC_POINT

CKA_VERIFY

Additional attributes supported by public key objects

Attribute Required Note

CKA_CLASS v CKO_CERTIFICATE at all times
CKA_CERTIFICATE_TYPE v CKC_X_509 at all times
CKA_LABEL

CKA_ID

CKA_ALLOWED_MECHANISMS
CKA_SUBIJECT

CKA_VALUE v
CKA_ISSUER

CKA_SERIAL_NUMBER

Maximum data length of attributes of variable-length data types

If an attribute is of a data type with a variable length, such as a Byte array or string, and its
length cannot be determined, there is no limitation to the data length for the attribute that is

within 8 Kbytes as a single object.
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Cautions

- The contents of this document (i.e., this “Cautions”) and specification (i.e., this “Specification”) are current as
of March 2025.

Transfer or duplication of part or all of this Specification without permission from AXELL is prohibited.

When using the product described in this Specification (i.e., “the Product”), please use it correctly according
to the contents of this Specification.

ABSENT A WRITTEN SIGNED AGREEMENT, EXCEPT AS PROVIDED IN THE RELEVANT TERMS AND
CONDITIONS OF SALE FOR THE PRODUCT, AND TO THE MAXIMUM EXTENT ALLOWABLE BY LAW,
AXELL (1) ASSUMES NO LIABILITY WHATSOEVER, INCLUDING WITHOUT LIMITATION, INDIRECT,
CONSEQUENTIAL, SPECIAL, OR INCIDENTAL DAMAGES OR LOSS, INCLUDING WITHOUT LIMITATION,
LOSS OF PROFITS, LOSS OF OPPORTUNITIES, BUSINESS INTERRUPTION AND LOSS OF DATA, AND
(2) DISCLAIMS ANY AND ALL EXPRESS OR IMPLIED WARRANTIES AND CONDITIONS RELATED TO
SALE, USE OF THE PRODUCT, OR INFORMATION, INCLUDING WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, ACCURACY OF INFORMATION, OR
NONINFRINGEMENT.

AXELL will not be held liable for any opportunity losses, indirect damages due to irregularities or defects of
the Product, or semiconductor device damages when using the Product at a value exceeding the absolute
maximum rating.

The application examples and constants shown in this Specification are provided to explain the standard
operation and usage of the Product. During mass-production design, take external conditions into
consideration. The incorporation of the Product in the design of a customers’ equipment shall be done under
the full responsibility of the customers.

The product application examples, information, and data in this Specification are provided only as examples
and do not imply any guarantee related to intellectual property rights such as patent rights or copyrights of
third parties or any other rights. Therefore, AXELL assumes no responsibility with regard to (1) infringement
of intellectual property rights of third parties, or (2) any consequences arising from the use of the Product.

While AXELL always strives to improve the quality of the Product, the possibility of defects cannot be
eliminated entirely. To minimize risks of damage to property or injury (including death) to persons arising from
defects in the Product, customers must incorporate sufficient safety measures in their design, such as
redundancy, fire-containment, over current prevention and anti-failure features.

While AXELL endeavors to make the information contained in this Specification complete, this Specification
does not cover every possible phenomenon. If there is any risk of malfunctions due to compliance with this
Specification, customers must take appropriate measures, such as consulting AXELL in advance. Customers
should note that AXELL will not necessarily be held liable for reparation or compensation even if the contents
of this Cautions and/or Specification were complied with by the customer.

The Product is intended for use in general electronic equipment such as audio visual systems, office
automation equipment, communication equipment, home electric appliances and amusement equipment. The
product is not intended for use in equipment and/or systems (a) which may directly affect human lives
(including, without limitation, life support systems) and (b) which require extremely high reliability and whose
failure or malfunction may cause enormous damage (including, without limitation, transportation equipment
control unit, nuclear control systems, military equipment), and Customers shall not use the Product for those
equipment and/or systems. Customers shall consult AXELL sales representative in advance if they should
consider use of the Product in the said equipment and/or systems.

- The company names and the product names used in this document are generally trademarks or registered
trademarks of respective companies.



Axell Corporation

Akihabara UDX SouthWing 10F 4-14-1
Xe Sotokanda, Chiyoda-ku, Tokyo

TEL +81-3-5298-1670 FAX +81-3-5298-1671

https://www.axell.co.jp/

Copyright ©2025. AXELL CORPORATION. All rights reserved.
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